Oracle® Project Resource Management

Implementation and Administration Guide

Release 11i

September, 2002
Part No. B10049-01
## Contents

Send Us Your Comments .................................................................................................................. xv

Preface.................................................................................................................................................. xvii

1 Introduction
   Key Features.................................................................................................................................. 1-2
   Required Technology Stack ........................................................................................................ 1-3
   Implementation Planning ............................................................................................................ 1-4
   Determining the Deployment Method ...................................................................................... 1-5

2 User Process Flows and Concepts
   Defining a Project Team ............................................................................................................. 2-2
   Standard Task Flows .................................................................................................................. 2-3
   Application Process Flows ......................................................................................................... 2-5
      Creating Requirements ............................................................................................................ 2-5
      Performing a Resource Search ............................................................................................ 2-5
      Filling Requirements ............................................................................................................ 2-5
      Adding Assignments to Projects ......................................................................................... 2-6
      Creating Administrative Assignments .................................................................................. 2-6

3 Establishing Your Enterprise Structure
   Setting Up Your Business Group Model .................................................................................. 3-2
   Defining Organizations ........................................................................................................... 3-3
      Understanding the Resource Operating Unit ..................................................................... 3-3
Defining Organizational Hierarchies ................................................................. 3-4
Defining Jobs and Job Mapping........................................................................ 3-5
  Defining Job Relationships ............................................................................. 3-6
  Specifying the Job Levels for Searches.......................................................... 3-6

4 Defining Your People

Understanding Resource Pool Benefits ........................................................... 4-2
  Performing Searches on Your Resource Pool ............................................... 4-2
Defining Employees and Employee Assignments .............................................. 4-5
  Defining Employees ....................................................................................... 4-5
  Defining Employee Assignments ................................................................... 4-6
  Defining Locations ......................................................................................... 4-6

Setting Up Competencies ............................................................................... 4-7
  Defining Your Competence Structure ......................................................... 4-7
  Assigning Competencies ............................................................................... 4-9
    Assigning Job Competencies ...................................................................... 4-9
    Assigning Project Role Competencies ......................................................... 4-9
    Assigning Requirement Competencies ....................................................... 4-10
    Assigning Resource Competencies ............................................................. 4-10
    Matching Resource and Requirement Competencies ................................. 4-11
    Assigning Global and Local Competencies ............................................... 4-11

Acquiring Your Resources From Oracle HRMS ................................................ 4-13
  Qualifying Criteria for the Resource Pull ....................................................... 4-13
  Running the PRC: Maintain Project Resources Process ................................. 4-14
  Migrating Resource Data From Other Systems ............................................. 4-15
    Migrating Data for a New Instance ............................................................ 4-15
    Migrating Data for an Existing Instance ..................................................... 4-16

5 Configuring Your Organization Security

Defining Your Security Strategy .......................................................................... 5-2
Understanding Responsibility-Based Security .................................................. 5-3
  Defining Additional User Level Security ....................................................... 5-3
    Authority at the Organization Level .......................................................... 5-3
    User with View All Projects Access .......................................................... 5-3
    User with Update All Projects Access ....................................................... 5-4
User with View All Resources Access .......................................................................................... 5-4
Understanding Role-Based Security .......................................................................................... 5-5
Levels of Role-Based Security ................................................................................................. 5-5
Predefined Roles ....................................................................................................................... 5-5
  Project Manager ....................................................................................................................... 5-6
  Project Staffing Owner ............................................................................................................. 5-6
  Project Authority .................................................................................................................... 5-6
  Resource Authority .................................................................................................................. 5-6
  Utilization Authority .............................................................................................................. 5-6
  Forecast Authority .................................................................................................................. 5-6
Predefined Responsibilities ........................................................................................................ 5-6
Overview of Predefined Responsibility Function and Menu Access .......................................... 5-8
Detailed Predefined Function Access by Responsibility ............................................................. 5-10
Predefined Function Access by Menu ........................................................................................ 5-14
Defining Organizational Authority ........................................................................................... 5-21
  Defining a Primary Contact ................................................................................................. 5-21
  Assigning Organizational Authority ...................................................................................... 5-22
Demonstrating a Security Check ............................................................................................... 5-23
Setting Up Security for Viewing Financial Amounts .................................................................. 5-25

6 Defining Project Roles
  Definition of a Project Role ....................................................................................................... 6-2
  How Project Roles are Used ...................................................................................................... 6-2
  Overview of Predefined Role Controls .................................................................................... 6-3
  Defining Role Lists .................................................................................................................. 6-4
  Defining Project Roles ............................................................................................................ 6-5

7 Setting Up Staffing Capabilities
  Overview of Predefined Statuses and Status Controls ............................................................ 7-2
  Defining Requirement Statuses and Profile Options ............................................................... 7-3
    Predefined Requirement Statuses and Status Controls ......................................................... 7-3
    Requirement Status Profile Options ...................................................................................... 7-3
      PA: Starting Requirement Status ...................................................................................... 7-3
      PA: Default Filled Requirement Status ............................................................................. 7-4
      PA: Default Cancelled Requirement Status ...................................................................... 7-4
Defining Staffing Priorities for Team Roles ................................................................. 7-4
Defining the Team Role Descriptive Flexfield .......................................................... 7-4

Setting Up Candidate Processing ........................................................................... 7-5
Defining Candidate Statuses and Profile Options .................................................... 7-5
  Predefined Candidate Statuses and Status Controls .............................................. 7-5
  Candidate Status Profile Options ........................................................................ 7-6
    PA: Default Starting Candidate Status ............................................................ 7-6
    PA: Cancelled Requirement’s Candidate Status .................................................. 7-7
    PA: Invalid Resource Candidate Status ............................................................ 7-7
Understanding the Candidate Score and the Automated Nomination Process ........ 7-7
  Candidate Score Weightings ............................................................................... 7-7
  Automated Search and Nomination Process ........................................................ 7-8
  Submitting the PRC: Automated Candidate Search Process .............................. 7-9
    Submitting the Process for a Single Project ..................................................... 7-9
    Submitting the Process for Multiple Projects .................................................. 7-9

Defining and Setting Up Advertisement Rules ......................................................... 7-10
  Overview of Advertisement Rules ........................................................................ 7-10
  Advertisement Rule Actions .................................................................................. 7-10
  Advertisement Rule Action Conditions ............................................................... 7-11
  Advertisement Rule Statuses ................................................................................ 7-12
  Project Staffing Owner ......................................................................................... 7-12
  Advertisement Rule Processes .............................................................................. 7-13
    Obtaining a Default Advertisement Rule ......................................................... 7-13
    Processing Advertisement Actions ..................................................................... 7-13
    Reversing Advertisement Rule Actions ............................................................. 7-14
    Replacing an Advertisement Rule ....................................................................... 7-15
    Auditing Advertisement Rule Activities ............................................................ 7-15
  Implementing Advertisement Rule Functionality ................................................... 7-15
    Defining Advertisement Rules .......................................................................... 7-16
    Specifying the Default Advertisement Rule ...................................................... 7-16
    Submitting the PRC: Perform Action Rules Process .......................................... 7-16

Defining Assignments Statuses and Profile Options ................................................. 7-17
  Predefined Assignment Schedule Statuses and Status Controls .......................... 7-17
  Predefined Assignment Approval Statuses ........................................................... 7-17
  Assignment Status Profile Options ...................................................................... 7-18
8 Defining Calendars and Schedules

Setting Up Calendars

Creating Calendars and Defining Calendar Attributes

Defining Calendar Types

Defining Shift and Shift Patterns

Creating Calendar Exceptions

Creating a Calendar

Assigning Shifts and Exceptions to Calendar

Changing the Calendar

Establishing Default Calendars

Defining the Default Calendar for the Site

Defining Default Calendars for Organizations

Assigning Calendars

Assigning Calendars to Projects

Assigning Calendars to Resources

Establishing the Availability and Overcommitment Calculations

Overview of the Availability Calculation

Setup Requirements for the Availability Calculation

Defining GL Periods and PA Periods for Availability Purposes

Defining Forecast Options for Scheduling Purposes

Overview of the Overcommitment Calculation

Defining Availability and Overcommitment Profile Options

9 Defining the Project Environment

Creating Project Attributes

Establishing Probability Information

Setting Up the Predefined Project Status Controls

Setting Up Your Self-Service Environment

Self-Service Web Applications Profile Options

Configuring the Project Home Page

Specifying the Project Header Section

Enabling Project Shortcut Links
10 Implementing Financial Forecasting

Overview of the Financial Forecast Process and Calculations ................................. 10-2
Financial Forecast Process ............................................................................................ 10-2
Forecast Calculations ................................................................................................. 10-3
Calculating Revenue .................................................................................................... 10-3
  Revenue Calculation for Projects Using Work-Based Distribution Rule ............... 10-4
  Revenue Calculation for Projects Using Cost-Based Distribution Rule ............... 10-4
  Revenue Calculation for Projects Using Event-Based Distribution Rule .......... 10-5
Generating Forecast Information ............................................................................... 10-5
Implementing the Forecast Functionality .................................................................... 10-6
  Defining a Job-Based Cost Rate Schedule ............................................................. 10-6
  Defining Bill Rate Schedules .................................................................................. 10-7
  Updating Project Types with Employee and Job-Based Bill Rate Schedules ....... 10-7
  Defining Forecast-Related Profile Option ............................................................... 10-7
  Defining Periods ....................................................................................................... 10-7
  Defining Unassigned Time Tracking ..................................................................... 10-8
  Defining Forecasting Options ................................................................................ 10-9
    Implementation Options ......................................................................................... 10-10
    Unassigned Time Options ................................................................................... 10-12
Establishing Security on Forecast Functionality ......................................................... 10-13
  Granting Cost Viewing Access to Roles ................................................................. 10-13
  Granting Forecast Authority .................................................................................... 10-13
  Granting Forecast Function Access ........................................................................ 10-14

11 Implementing Resource Utilization

Defining Your Utilization Strategy ............................................................................. 11-2
Utilization Time Periods ............................................................................................ 11-3
Understanding the Utilization Views ......................................................................... 11-3
Choosing a Utilization Calculation Method ............................................................. 11-4
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the Capacity Calculation Method</td>
<td>11-4</td>
</tr>
<tr>
<td>Using the Total Worked Hours Calculation Method</td>
<td>11-4</td>
</tr>
<tr>
<td>Understanding the Utilization Reporting</td>
<td>11-5</td>
</tr>
<tr>
<td>Reviewing the Organization Utilization Page</td>
<td>11-6</td>
</tr>
<tr>
<td>Employees and Others (Summary)</td>
<td>11-6</td>
</tr>
<tr>
<td>Employees and Others (Sub-Organization Details)</td>
<td>11-6</td>
</tr>
<tr>
<td>Actual Capacity (same as Forecast Capacity)</td>
<td>11-6</td>
</tr>
<tr>
<td>Actual Worked</td>
<td>11-6</td>
</tr>
<tr>
<td>Weighted Actual</td>
<td>11-6</td>
</tr>
<tr>
<td>Actual Utilization (%)</td>
<td>11-7</td>
</tr>
<tr>
<td>Forecast Work</td>
<td>11-7</td>
</tr>
<tr>
<td>Weighted Forecast</td>
<td>11-7</td>
</tr>
<tr>
<td>Forecast Utilization (%)</td>
<td>11-7</td>
</tr>
<tr>
<td>Reviewing the Resource Utilization by Organization Manager Page</td>
<td>11-7</td>
</tr>
<tr>
<td>Employees and Others (Summary)</td>
<td>11-7</td>
</tr>
<tr>
<td>Person Details</td>
<td>11-7</td>
</tr>
<tr>
<td>Reviewing the Resource Utilization by Resource Manager Page</td>
<td>11-8</td>
</tr>
<tr>
<td>Employees and Others</td>
<td>11-8</td>
</tr>
<tr>
<td>Actual Capacity (same as Forecast Capacity)</td>
<td>11-8</td>
</tr>
<tr>
<td>Actual Worked</td>
<td>11-8</td>
</tr>
<tr>
<td>Weighted Actual</td>
<td>11-9</td>
</tr>
<tr>
<td>Actual Utilization (%)</td>
<td>11-9</td>
</tr>
<tr>
<td>Forecast Work</td>
<td>11-9</td>
</tr>
<tr>
<td>Weighted Forecast</td>
<td>11-9</td>
</tr>
<tr>
<td>Forecast Utilization (%)</td>
<td>11-9</td>
</tr>
<tr>
<td>Reviewing the Personal Utilization Page</td>
<td>11-9</td>
</tr>
<tr>
<td>Capacity Amount</td>
<td>11-9</td>
</tr>
<tr>
<td>Capacity Hours</td>
<td>11-10</td>
</tr>
<tr>
<td>Worked Hours</td>
<td>11-10</td>
</tr>
<tr>
<td>Utilization</td>
<td>11-10</td>
</tr>
<tr>
<td>(Forecast) Provisional Hours</td>
<td>11-10</td>
</tr>
<tr>
<td>(Forecast) Confirmed Hours</td>
<td>11-10</td>
</tr>
<tr>
<td>(Forecast) Utilization</td>
<td>11-10</td>
</tr>
<tr>
<td>Correlation of Utilization Totals</td>
<td>11-10</td>
</tr>
<tr>
<td><strong>Implementing Your Utilization Strategy</strong></td>
<td>11-12</td>
</tr>
</tbody>
</table>

Implementing Your Utilization Strategy
Determining Utilization Jobs ................................................................. 11-12
Establishing Utilization Categories and Work Types ................................. 11-13
  Defining Utilization Categories ......................................................... 11-13
  Creating Utilization Categories ....................................................... 11-13
  Using Utilization Categories ......................................................... 11-13
  Defining Work Types ...................................................................... 11-14
  Creating Work Types ..................................................................... 11-14
  Using Work Types ......................................................................... 11-15
Implementing Utilization Forecasting Functionality .................................... 11-16
Establishing Unassigned Time Tracking .................................................. 11-16
Choosing Your Reporting Time Period .................................................... 11-16
Granting Utilization Authority ................................................................. 11-17
  Review of Responsibilities ............................................................ 11-17
  Granting Organization Utilization Authority ..................................... 11-18
Defining the Utilization Profile Options .................................................... 11-19

12 Setting Up for Reporting Capabilities

  Oracle Discoverer 4i Postinstallation Tasks ........................................... 12-2
  Oracle Discoverer 3i Postinstallation Tasks ........................................... 12-3
    Oracle Discoverer Postinstallation Tasks Checklist .......................... 12-3
    Create the End User Layer ............................................................. 12-4
      Creating the Database User ......................................................... 12-4
      Creating the Applications Mode EUL ........................................... 12-4
    Modify the Indexes of the End User Layer Owner ............................. 12-6
    Copy Files to Discoverer Administration Tier .................................. 12-6
    Connect to Discoverer Administration Edition .................................. 12-7
    Import the End User Layer EEX File .............................................. 12-7
    Set Up Access to Business Areas and End User Discoverer Edition .... 12-8
    Refresh Business Areas .................................................................. 12-9
    Connect to Discoverer User Edition ............................................... 12-9
    Install the Project Resource Management Reporting Workbooks for Discoverer ... 12-10
    Set Up Access to the Reporting Workbooks .................................... 12-11
  Test Your Installation and Set Up ......................................................... 12-11
  Overview of the Business Areas and Business Views ............................ 12-12
    List of Business Areas .................................................................. 12-12
<table>
<thead>
<tr>
<th>Staffing Business Area</th>
<th>12-12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Business Area</td>
<td>12-14</td>
</tr>
<tr>
<td>List of Staffing Business Area Folders</td>
<td>12-15</td>
</tr>
<tr>
<td>Staffing Organization Rollup Groups</td>
<td>12-15</td>
</tr>
<tr>
<td>Resource Managers</td>
<td>12-16</td>
</tr>
<tr>
<td>Fiscal Years</td>
<td>12-16</td>
</tr>
<tr>
<td>Fiscal Quarter Numbers</td>
<td>12-16</td>
</tr>
<tr>
<td>Calendar Years</td>
<td>12-16</td>
</tr>
<tr>
<td>Calendar Months</td>
<td>12-17</td>
</tr>
<tr>
<td>Work Types</td>
<td>12-17</td>
</tr>
<tr>
<td>Required Project Hours by GL Period</td>
<td>12-17</td>
</tr>
<tr>
<td>Required Project Hours by GL Period: Team Role Detail</td>
<td>12-18</td>
</tr>
<tr>
<td>Required Project Hours by PA Period</td>
<td>12-18</td>
</tr>
<tr>
<td>Required Project Hours by PA Period: Team Role Detail</td>
<td>12-19</td>
</tr>
<tr>
<td>Required Project Hours by Global Week</td>
<td>12-20</td>
</tr>
<tr>
<td>Required Project Hours by Global Week: Team Role Detail</td>
<td>12-20</td>
</tr>
<tr>
<td>Resource Capacity by GL Period</td>
<td>12-21</td>
</tr>
<tr>
<td>Resource Capacity by PA Period</td>
<td>12-22</td>
</tr>
<tr>
<td>Resource Capacity by Global Week</td>
<td>12-22</td>
</tr>
<tr>
<td>Resource Schedule by GL Period</td>
<td>12-23</td>
</tr>
<tr>
<td>Resource Schedule by GL Period: Team Role Detail</td>
<td>12-24</td>
</tr>
<tr>
<td>Resource Schedule by PA Period</td>
<td>12-25</td>
</tr>
<tr>
<td>Resource Schedule by PA Period: Team Role Detail</td>
<td>12-26</td>
</tr>
<tr>
<td>Resource Schedule by Global Week</td>
<td>12-27</td>
</tr>
<tr>
<td>Resource Schedule by Global Week: Team Role Detail</td>
<td>12-28</td>
</tr>
<tr>
<td>Resource Schedule and Capacity by Global Week</td>
<td>12-29</td>
</tr>
<tr>
<td>Available Resource Hours by Global Week</td>
<td>12-30</td>
</tr>
<tr>
<td>Resource Overcommitment by Global Week</td>
<td>12-31</td>
</tr>
<tr>
<td>List of Financial Business Area Folders</td>
<td>12-32</td>
</tr>
<tr>
<td>Financial Organization Rollup Groups</td>
<td>12-32</td>
</tr>
<tr>
<td>Project Managers</td>
<td>12-32</td>
</tr>
<tr>
<td>Fiscal Years</td>
<td>12-33</td>
</tr>
<tr>
<td>Fiscal Quarter Numbers</td>
<td>12-33</td>
</tr>
<tr>
<td>Project Role Types</td>
<td>12-33</td>
</tr>
<tr>
<td>Project Members</td>
<td>12-33</td>
</tr>
</tbody>
</table>
Sales Pipeline by GL Period .......................................................... 12-33
Sales Pipeline by PA Period .......................................................... 12-35
Lookup for Class Categories ....................................................... 12-36
List of Competence Business Area Folders .................. 12-36
Organization Competence Summary ........................................ 12-36
Resource Listing for Organization and Competence .................. 12-37
Resource Competence Details .................................................. 12-37
Organization Resource Competencies ................................... 12-38
Project Resource Competencies ............................................ 12-38
Resource Projects ..................................................................... 12-39
Competence Organization Rollup Groups ......................... 12-39
Competencies .......................................................................... 12-40
Include Sub Organizations ..................................................... 12-40
Billable Job Only ..................................................................... 12-40
Resources ................................................................................ 12-40
All Resource Managers .............................................................. 12-41
Jobs .......................................................................................... 12-41
Job Levels .............................................................................. 12-41
List of Business Views ............................................................... 12-42
Security Overview ................................................................. 12-44
Discoverer Workbooks .............................................................. 12-44
Required Project Hours (PAREQPRJ) ......................... 12-45
Required Project Hours by GL Period ..................... 12-46
Required Project Hours by PA Period ...................... 12-47
Required Project Hours by Global Week .................. 12-49
Scheduled Resource Hours (PASCHRES) ......................... 12-51
Scheduled Resource Hours by GL Period .................. 12-51
Scheduled Resource Hours by PA Period .................. 12-54
Scheduled Resource Hours by Global Week ............... 12-56
Available Resource Hours (PAAVLRES) ....................... 12-58
Available Resource Hours by GL Period .................. 12-59
Available Resource Hours by PA Period .................. 12-61
Available Resource Hours by Global Week ............... 12-63
Overcommitted Resource Hours (PAOVCRES) ............ 12-65
Overcommitted Resource Hours by GL Period .......... 12-65
13 Maintaining Your Data

Understanding Data Processing .............................................................. 13-2
Understanding the Impact of Changes to HRMS-Based Information .......... 13-3
   Changing Job Information ................................................................. 13-3
      Job Levels .................................................................................. 13-3
      Job Billability ........................................................................... 13-4
   Utilization Calculation ................................................................. 13-4
   Changing Organization Information ............................................. 13-4
   Changing Organizational Hierarchy Information ......................... 13-4
   Changing Resource Information .................................................. 13-5
   Changing an Assignment ......................................................... 13-5

Maintaining Schedules ................................................................. 13-6
   Updating Schedules with Calendar Changes .................................. 13-6
   Updating Schedules and Timelines to Reflect a New Calendar ........ 13-7

Maintaining Utilization Values ......................................................... 13-8

Maintaining Forecast Information .................................................... 13-9
   Running a List of Forecast Exceptions ....................................... 13-9
   Reprocess Forecast Exceptions ............................................... 13-10
14 Overview of the Predefined Workflows

Initiating Deferred Workflow Processes ................................................................. 14-2
Available Item Types .............................................................................................. 14-2
Recommended Process Scheduling Parameters ...................................................... 14-3
Assignment Approval Workflow Process .................................................................. 14-4
Assignment Approval Workflow Item Type and Processes ......................................... 14-5
Assignment Approval Workflow Notification Messages ........................................... 14-6
Assignment Schedule Statuses .................................................................................. 14-7
Assignment Approval Workflow Extensions ............................................................. 14-8
Assignment Approval Changes Extension ............................................................... 14-8
Assignment Approval Notification Extensions ....................................................... 14-9
Candidate Workflow Processes ............................................................................... 14-13
Candidate Notification Workflow Extension ......................................................... 14-13

A Implementation Steps Checklist

Overview of the Implementation Environment .......................................................... A-2
Oracle Applications Implementation Wizard ........................................................... A-2
Setting Up Underlying Oracle Applications Technology .......................................... A-2
Implementation Considerations ............................................................................... A-3
Overview of the Oracle Projects Implementation Checklists ..................................... A-4
Oracle Projects Implementation Checklist ............................................................... A-5
Oracle Applications Implementation Checklist for Oracle Projects Integration .... A-27

Glossary

Index
Part No.  B10049-01

Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this document. Your input is an important part of the information used for revision.

- Did you find any errors?
- Is the information clearly presented?
- Do you need more information? If so, where?
- Are the examples correct? Do you need more examples?
- What features did you like most?

If you find any errors or have any other suggestions for improvement, please indicate the document title and part number, and the chapter, section, and page number (if available). You can send comments to us in the following ways:

- FAX: (650) 506-7862   Attn: Oracle Financial Applications Documentation
- Postal service:
  Oracle Corporation
  Financial Applications Documentation, Oracle Project Resource Management
  500 Oracle Parkway, M/S 3op11
  Redwood Shores, CA 94065
  USA

If you would like a reply, please give your name, address, telephone number, and (optionally) electronic mail address.

If you have problems with the software, please contact your local Oracle Support Services.
This guide provides you with information on how to implement Oracle Resource Management, Release 11i, Oracle Projects Family Pack J (11i.PF_PJ.J). This preface describes the organization of this guide.

**Intended Audience**

The intended audience for the material presented in this guide is system administrators and persons responsible for performing the duties of implementing, configuring, and administrating the Oracle Project Resource Management application.

**Structure**

The organization of this guide is as follows:

- **Chapter 1, "Introduction"** describes the purpose and key features of the product. It also covers the required technology stack and implementation considerations.
- **Chapter 2, "User Process Flows and Concepts"** discusses the various user and process flows within Oracle Project Resource Management.
- **Chapter 3, "Establishing Your Enterprise Structure"** covers how to set up your organization and its various components such as business groups and organizational hierarchies.
- **Chapter 4, "Defining Your People"** discusses how to define the various resource attributes and how to establish your resource pool.
- **Chapter 5, "Configuring Your Organization Security"** describes responsibility-based security and how to establish a security structure for your organization.
Chapter 6, "Defining Project Roles" discusses how to define roles and role attributes.

Chapter 7, "Setting Up Staffing Capabilities" describes how to define staffing-related attributes, profile options, and statuses.

Chapter 8, "Defining Calendars and Schedules" describes calendars and schedules, and covers how to define the associated attributes. It also describes how to maintain the calendars and schedules so they stay current.

Chapter 9, "Defining the Project Environment" describes the attributes associated with projects, setting up probability, establishing the status and workflow structures, and setting up the self-service environment.

Chapter 10, "Implementing Financial Forecasting" describes how to set up forecasting functions so you can perform forecasting on your project resources.

Chapter 11, "Implementing Resource Utilization" describes how to set up utilization functions for tracking your resource utilization.

Chapter 12, "Setting Up for Reporting Capabilities" covers how to set up reporting functions in order for you to perform reporting on your projects and resources. This chapter also describes the predefined reports.

Chapter 13, "Maintaining Your Data" discusses the various processes you must run in order to maintain accuracy in your data.

Chapter 14, "Overview of the Predefined Workflows" explains predefined workflows and the extensions that you can customize.


This guide also includes a Glossary and an Index.

Related Documents

The chapters of this guide provide basic and product-related information for setting up, configuring, and maintaining information such as your enterprise structure, resources, calendars, and schedules. For additional information, you are referred to other sources of information as appropriate for the topic. Depending upon which application you are using to perform the set up, your reference source may differ.

These sources include:

- Oracle Applications User Guide
- Oracle Alert User Guide
Oracle Applications Implementation Wizard User Guide
Oracle Applications Developer’s Guide
Oracle Applications User Interface Standards
Oracle Self-Service Web Applications Implementation Guide
Managing People Using Oracle HRMS
Oracle Applications Concepts
Installing Oracle Applications
Upgrading Oracle Applications
Oracle Applications Product Update Notes
Oracle Applications System Administrator’s Guide
Oracle Workflow Guide
Oracle Applications Flexfields Guide
The OA Framework - Release Notes & Configuration for the Phase 5.5 Release
Oracle Projects User Guide
Implementing Oracle HRMS
Oracle Projects 11i Release 11.5.3/Mini Pack B User Guide Supplement
Documentation Update for Patch Numbers 1383905 and 1377992 - Global Competencies
Oracle Applications System Administrator’s Guide
Oracle Applications Developer’s Guide

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation accessible, with good usability, to the disabled community. To that end, our documentation includes features that make information available to users of assistive technology. This documentation is available in HTML format, and contains markup to facilitate access by the disabled community. Standards will continue to evolve over time, and Oracle Corporation is actively engaged with other market-leading technology vendors to address technical obstacles so that our documentation can be accessible to all of our customers. For additional information,
visit the Oracle Accessibility Program Web site at http://www.oracle.com/accessibility/.

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or organizations that Oracle Corporation does not own or control. Oracle Corporation neither evaluates nor makes any representations regarding the accessibility of these Web sites.
## Conventions

The following conventions are used in this guide:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>.</td>
<td>Vertical ellipsis points in an example mean that information not directly related to the example has been omitted.</td>
</tr>
<tr>
<td>.</td>
<td></td>
</tr>
<tr>
<td>.</td>
<td></td>
</tr>
<tr>
<td>. . .</td>
<td>Horizontal ellipsis points in statements or commands mean that parts of the statement or command not directly related to the example have been omitted.</td>
</tr>
<tr>
<td><strong>boldface text</strong></td>
<td>Boldface type in text indicates a term defined in the text, the glossary, or in both locations.</td>
</tr>
<tr>
<td>&lt; &gt;</td>
<td>Angle brackets enclose user-supplied names.</td>
</tr>
<tr>
<td>[ ]</td>
<td>Brackets enclose optional clauses from which you can choose one or none.</td>
</tr>
</tbody>
</table>

Since Oracle Project Resource Management is a self-service application, references to a page within the application are specific to a self-service Web page. Any references to forms refers to forms within the Oracle Projects, Oracle Human Resources Management System (HRMS), or Oracle CRM applications.
Oracle Project Resource Management is a self-service application to manage the deployment and capacity of your resources in a global environment. You use this application to manage your project resource needs, project profitability, and organization utilization, by locating and deploying qualified and available resources to your projects across your global, extended enterprise.

Using this application, project managers, resource managers, and staffing managers throughout your enterprise can manage their resources and more effectively communicate their needs to one another.

This chapter discusses the key features of the Oracle Project Resource Management application and considerations to review in your implementation process through the following topics:

- Key Features
- Required Technology Stack
- Implementation Planning
- Determining the Deployment Method
Key Features

The Oracle Project Resource Management application includes features such as:

- Role-based security
- Detailed requirement definition
- Search functions for:
  - matching qualified resources to open requirements
  - locating requirements for which resources may nominate themselves
- Tracking candidates for filling requirements
- Automated approval processing
- Detailed schedule management of your project team, including timeline views
- Utilization reporting on your resource assignments from the individual resource level to the organization level
- Capabilities for performing analysis and financial forecasts on your projects
- Simple Web interface for easy access by all project stakeholders
- Complete project and customer sales history access through the integration with Oracle Sales Online
Required Technology Stack

Prior to installing the Oracle Project Resource Management application, you must install other software components that build a base. This base provides the structure for the Oracle Project Resource Management application.

The required base installation for Oracle Project Resource Management is Oracle Applications, Release 11i.

You must upgrade your Oracle Applications Web Tier environment to include the Self-Service Framework technology stack. The instructions for upgrading your Oracle Applications Environment to use the Oracle Applications Self-Service Framework are included with the framework patch in README-Config-FAQ-Apps-HTTPServer.html located under the top level patch directory. Please complete all steps in those instructions before proceeding with the installation of Oracle Project Resource Management.

For additional information on installing these products and patches, you can refer to the following sources:

- *Installing Oracle Applications, Release 11i*
- Associated readme files for each patch
Implementation Planning

Since Oracle Project Resource Management is integrated with applications such as Oracle Projects, Oracle Human Resources Management System (HRMS), and Oracle CRM, many interdependencies exist. Careful planning is required because of these interdependencies. A large portion of the information you must enter for your implementation is actually loaded through these applications. Therefore, you should create an implementation plan. Use the checklist provided in Appendix A as a starting point for this plan because it identifies all the required and optional steps for your implementation.

Shared Data

All organization and employee data is stored in Oracle HRMS tables. As most of these tables are shared, you can enter this information using Oracle HRMS and access the information through other Oracle applications such as Oracle Projects. However, if your business does not currently use Oracle HRMS, you can define the resource data through Oracle Projects. For more information, refer to Chapter 17, "Oracle Projects Setup and Implementation," in the Oracle Projects User Guide, Volume 3.
Determining the Deployment Method

Prior to implementing Oracle Project Resource Management, you must determine how you want to handle project staffing. You have three possible approaches in addressing who manages the task of project staffing:

- **Centralized**
  The centralized approach uses staffing analysts (resource analysts.) These analysts are responsible for managing requirements and assignments for all the projects of an organization.

- **Decentralized**
  The decentralized approach uses project managers, or project assistants, who work with resource managers to fill project requirements.

- **Combination**
  The combination approach is used by companies who have all these roles interacting in the effort to fill project requirements and to obtain the highest utilization of the available resources.

The method you choose effects how you roll out the implementation of the application, how you establish training plans, and determines your security strategy.
The Oracle Project Resource Management application provides functionality to meet the needs of several key user scenarios, each with its own set of responsibilities and related task flows. You can adapt these scenarios into your environment, or modify them accordingly.

Understanding the process flows and user concepts of the application provides you with the appropriate knowledge for making key decisions for your implementation.

This chapter covers the following topics:

- Defining a Project Team
- Standard Task Flows
- Application Process Flows
Defining a Project Team

A project team has two layers: the delivery team and the extended team. The delivery team consists of all the key members who perform the project tasks. These members are scheduled and tracked within the organization that owns the project. The extended team consists of team players outside of the project team such as individuals within the organization performing administrative duties and client participants. These players interact with the team members, but are not managed within the organization owning the project.

The following diagram demonstrates how the delivery team and extended team own requirements and assignments.

Administrative assignments are not included in the domain of the delivery team as these assignments are typically tracked on an indirect/administrative project. Therefore, to distinguish these assignments from delivery assignments, they are shown outside the framework of the project team. Administrative projects can have project managers who manage these assignments, but having a project manager is not a requirement.
Standard Task Flows

You can divide the overall process flow of Oracle Project Resource Management into three segments: Demand, Supply, and Financial Management. The borders dividing these segments are not definite. In fact, many of the tasks are shared between segments.

The segments demonstrate how Oracle Project Resource Management addresses the different, but related, tasks and viewpoints needing access to project staffing data. Different needs coming together to use the same data.

The following diagram illustrates how the different needs of the users can use the same data through process flows. It also provides the segment division of task flows and the various user roles that might use these segments.

The objectives of the role a user is playing on a project drives the tasks the user must perform. The implementation of Oracle Project Resource Management provides predefined roles to which you can add your own to suit your business needs.
needs. In the above diagram, typical user roles are associated with the applicable process segments. For example, a Financial Analyst performs tasks related to financial management, and a Project Manager concentrates on tasks relating to project staffing from the demand side.

In general, you have the following typical user roles to address the issues of project staffing:

- **Project Manager**
  
  A project manager initiates the creation of the project and requirements. In order to fill the requirements, the project manager must perform searches from which candidates can be identified. Once a candidate is selected, a provisional assignment is created for the resource. The provisional assignment is forwarded to the resource manager or primary contact for approval. If the project manager wants specific persons to fill requirements, the search step can be bypassed and direct provisional assignments can be made.

- **Staffing Manager**
  
  Staffing managers generally fill the supply side of the task flows as they have the access to all the resource data and manage the schedules and utilization of the resources. Therefore, these persons know the availability of their own resources. Staffing managers can approve assignments given the proper authority, as well as, search for resources, nominate candidates, and fill open requirements.

- **Resource Manager**
  
  Resource managers confirm or deny resource assignments, and manage the schedules and utilization of their direct reports (resources.)

- **Team Member**
  
  Team members are the resources. They can manage their own competence profiles and work information through the shared professional model of Self-Service Human Resources. Team members can also view their schedule of project assignments and search for requirements to nominate themselves as candidates.
Application Process Flows

The process flows of the Oracle Project Resource Management application entail activities such as creating a requirement, electing a person as a candidate, and creating assignments. Based on the responsibility of the user, these process flows may vary. This section describes some of the basic process flows of the application.

Creating Requirements

Through Oracle Project Resource Management, you have the ability to define the requirements for a given project. The purpose of these requirements is to provide a representation of the resources that are needed to complete the project.

For example, you have a project to install a product at a customer site. This project may require two DBAs and two Implementation Consultants skilled in the product to be installed. Without knowing the specific individuals that will fill these required roles, you can identify information such as what level of experience is necessary, where the work will be carried out, and approximately how long each position is required. You define this information for each requirement which simplifies the process of identifying potential resources to fill these roles.

Performing a Resource Search

When performing a resource search for a requirement, the dates of the requirement are compared with the availability of the resource. If these time periods match, the resource is considered a candidate for the requirement given the other search criteria for the requirement also matches.

Filling Requirements

Filling a requirement involves either directly identifying a known resource, or searching the resource repository to find suitable resources.

When a requirement is filled, an assignment is created. The assignment identifies the period of time a specific resource will fill a specific role. If the person assigning the resource to the requirement has authority over the resource, the assignment is considered a confirmed assignment. Otherwise, the assignment must go through an approval process, either manual or workflow-enabled depending upon how you have implemented your installation. These assignments are provisional until confirmed.

Confirmed assignments appear on the schedules of the assigned resource and the project. This assignment to the resource reduces the availability of the resource.
Adding Assignments to Projects

An assignment is a filled work position on a project associated with a specific resource for a designated period of time. An assignment can have various statuses as required such as proposed, provisional, and confirmed.

Upon selecting the team role for the assignment, default values are provided for the assignment name and job levels. Values for the assignment location and calendar are retrieved from the associated project. You can change any of these defaults as necessary.

After you have entered all the desired assignments, click Save and Submit to submit the assignments for approval. This process prompts you for the approvers of the assignment and then, forwards the assignment through the approval process.

Creating Administrative Assignments

An administrative assignment represents a non-work activity and is tracked against an administrative project. You can use such assignments to block off time on your resource schedules. The following examples demonstrate the functionality of administrative assignments:

- vacation time
- internal training
- project management duties
- personal holiday
- sick time
- jury duty

You may want to track such assignments because they consume the work hours of your resources, and therefore, affect availability, financial forecasting, and resource utilization.
Establishing Your Enterprise Structure

The structure of your enterprise determines how to define your business groups, organizations, hierarchies, jobs, and job groups. You must establish these key pieces of information prior to implementing Oracle Project Resource Management.

If you have already set up some of these features in a previous implementation of Oracle Projects or Oracle Human Resources, you can skip the respective sections of this chapter. However, you may want to review the information to ensure it corresponds to the data you want to use with Oracle Project Resource Management.

This chapter covers the following topics:

- Setting Up Your Business Group Model
- Defining Organizations
- Defining Organizational Hierarchies
- Defining Jobs and Job Mapping
Setting Up Your Business Group Model

A Business Group is a special class of organization. Every business group can have its own set of default values, with its own internal organizations, grades, jobs, positions, payrolls, employees, applicants, compensations, competence structures, and benefits.

In setting up your enterprise structure, you can establish one business group or divide it into multiple business groups. If you set up more than one business group, the associated data, such as organizations and employees, is partitioned accordingly. Establishing an organization as a business group is not reversible, therefore, you should plan your business group setup carefully.

For more information on business groups and structuring your enterprise, see "Adapting or Creating a New Business Group," in Using Oracle HRMS – The Fundamentals.

Prerequisites
Your enterprise structure strategy plan outlines your business groups. Prior to actually setting up your business groups, you must complete the following tasks:

- Set the HR: Cross Business Group Profile as described in the Oracle Projects 11i Release 11.5.3/Mini Pack B User Guide Supplement.

- Define the six key flexfield structures outlined in "Implementation Steps" in Documentation Update for Patch Numbers 1383905 and 1377992 - Global Competencies.
Defining Organizations

Organizations are the basic work structure of any enterprise. They represent the functional, management, or reporting groups for individual business groups or globally for your entire enterprise.

You can choose any organization, but typically, you use expenditure organizations to track project resource-related expenses. Expenditure/Event organizations can own project events, incur expenditures, and hold budgets for projects. To enable these capabilities in the organization, you must perform the following tasks when defining an organization:

- Enable the Project Expenditure/Event organization classification.
- Define a default operating unit for the organization in the Additional Information section. This step causes all resources belonging to this organization to inherit the specified operating unit and calendar as their default operating unit and calendar.
- Enable the HR Organization classification. This task is necessary in order to have the ability to assign resources (people) to the organization.
- Attach the organization to the Expenditure hierarchy assigned to the operating unit using the Setup Implementation Options form.

For instructions on performing these tasks, refer to the following sources:

- "Entering Organization Classifications" in Using Oracle HRMS – The Fundamentals
- "Entering Additional Information" in Using Oracle HRMS – The Fundamentals

Understanding the Resource Operating Unit

Every resource, employees and contractors alike, is associated with an operating unit for security and forecasting reasons. This operating unit is derived from the organization operating unit. The operating unit of the resource is active for the duration of an assignment. It drives forecasting based on the transfer price defined for the operating unit if the resource is assigned on a project under a different operating unit, in other words, a borrowed resource.

Each time the employee assignment changes or if the default operating unit originally set up for the employee changes, the Project Resource Management application updates the resource operating unit. A history is maintained for
Defining Organizational Hierarchies

An organization hierarchy provides the structure of the relationships between your organizations. Depending on your business needs, you can define one hierarchy or multiple hierarchies for the following purposes:

- project-owning organizations
- expenditures
- reporting
- project burdening hierarchies for each business group

For more information on organization hierarchies, refer to the following sources:

- "Organization Hierarchy" in the *Oracle Projects User Guide*
- "Define Global Organization Hierarchies" in the *Oracle Projects 11i Release 11.5.3/Mini Pack B User Guide Supplement*
- "Creating Organization Hierarchies" in *Using Oracle HRMS - The Fundamentals*
Defining Jobs and Job Mapping

Each person in Oracle HRMS can have only one primary job assignment. However, HR jobs are often too granular for the purposes of project jobs. For example, you may have an HR job defined as Consultant - Level 2, but for the purposes of making project assignments, you want to only see Consultant. Oracle Projects provides you with the ability to map the HR-defined jobs to the project-related jobs.

The following table provides the tasks to complete categorized by the Oracle applications.

<table>
<thead>
<tr>
<th>Application</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Oracle HRMS ...</td>
<td>■ Define Job Groups in Oracle HRMS. Job groups enable you to classify certain types of work.</td>
</tr>
<tr>
<td></td>
<td>■ Define Jobs in Oracle HRMS. Jobs are the precise assignment the employee fills.</td>
</tr>
<tr>
<td></td>
<td>■ Note: If you have shared HR, you can access these forms in Oracle Projects.</td>
</tr>
<tr>
<td>In Oracle Projects ...</td>
<td>■ Define Job Mapping in Oracle Projects. Job mapping enables you to link similar jobs in different job groups.</td>
</tr>
<tr>
<td></td>
<td>■ Select Job Groups for Resource Lists in Oracle Projects.</td>
</tr>
<tr>
<td></td>
<td>■ Select Job Groups for Project Templates in Oracle Projects. You can assign a Billing Job Group to contract projects and project templates.</td>
</tr>
<tr>
<td></td>
<td>■ Specify the job group to use for searches.</td>
</tr>
</tbody>
</table>

You can enter this information directly through Project Resource Management using the Project Super User responsibility, if you do not have Oracle HRMS or Oracle Projects.

For more information and instructions for setting up these job-related attributes, refer to the following sources:

- Implementing Oracle HRMS
- Oracle Projects User Guide
- the Oracle Projects 11i Release 11.5.3/Mini Pack B User Guide Supplement
Defining Jobs and Job Mapping

Defining Job Relationships

Every job has an associated level and job code. The level is a numeric value that indicates the skill level. The job code is an alphanumeric identifier used for reporting and utilization.

You assign your jobs to job groups. These groups categorize the jobs into lines of business, such as Consulting, Accounting, Engineering, and Support. These job groups are also useful for reporting and utilization purposes. However, you might have similar jobs in various job groups. In order to align these similar jobs for reporting, you map each job code to a master job group. The master job groups categorize jobs for your entire enterprise.

For example, you may have analyst positions in several job groups such as a Technical Analyst in Engineering, a Support Analyst in Support, and a Research Analyst in Consulting. You can map these three positions to a single master job group called Analysts. If you have several levels of analysts, then you can map these jobs to separate master job groups as appropriate to suit your business reporting needs.

For further explanations and examples of job mapping, refer to the Oracle Projects 11i Release 11.5.3/Mini Pack B User Guide Supplement. However, take note that the job code is a new feature as of this release, and job mapping is no longer dependent upon the sequence or job grade in HR.

Specifying the Job Levels for Searches

Each project requirement has defined minimum and maximum job levels for the purpose of resource searching. During a search, the job levels of the resources are compared to the minimum and maximum job levels of the requirement. If the job level of a resource falls between the minimum and maximum job levels of the requirement, the resource is considered a possible match for the requirement given other search criteria are met.

The Minimum and Maximum Job Level fields default from the levels defined on the requirement, but you can modify them on the Modify Search Criteria page. Modifying these values on this page does not change the original definition on the requirement. The original definition of the requirement is available on the Requirement Details page.

The minimum and maximum job levels are based on the job levels associated with the job group specified as the value for the profile option PA: Project Resource Job Group. For this profile option, you enter the name of the job group you want used.
as the collection of jobs included in searches. This profile option is set at the site level only.

You can use the master job group as the value of this profile option, but remember that it includes every job. If you have jobs that you do not want included in job searches such as accounts payable jobs, administrative jobs, and human resource jobs that are not related to staffing projects, then you can set up a separate job group specifically for searching. This job group should include all jobs that you want included in searches.
A single collection of your resources, their skill sets, and their availability enables you to utilize and manage your resources both effectively and efficiently. To establish such a resource pool, you must understand your enterprise structure, the job groupings, and the required and desired competencies of the resources.

The structure of your enterprise determines how your resources are distributed, how competencies are shared and tracked, and how calendars and schedules are created and maintained. Prior to entering or acquiring resources, you must establish this structure in your system before you set up your resources. For more information, refer to Chapter 3, "Establishing Your Enterprise Structure".

This chapter provides information and instructions on establishing your resource pool through the following topics:

- Understanding Resource Pool Benefits
- Defining Employees and Employee Assignments
- Setting Up Competencies
- Acquiring Your Resources From Oracle HRMS
Understanding Resource Pool Benefits

The resource pool is the collection of all your valid resources into a single group. Each individual within your resource pool has various attributes defined such as personal information, work patterns, location, and competencies. Through entering this information as accurately as possible, you gain the following benefits:

- resources with consistent information from which to search
- secured single-source access to information such as personal information, resume, and competencies
- precise requirement matching capabilities
- forecasting based on resource needs
- resource utilization manageability

Performing Searches on Your Resource Pool

Only valid resources (including future-date employees) are considered in resource search queries. In order for a person to be considered a qualified resource within Project Resource Management, certain criteria must be met. For a complete list of the criteria, refer to Chapter 13, "Maintaining Your Data".

---

**Note:** Future-dated employees can qualify as a match for a requirement only if their start date is on or after the start date of the requirement.

---

When searching your resource pool for potential matches to requirements, you specify certain criteria to limit the search. These criteria include the following:

- **Organizational Hierarchy**
  
  This field identifies the project expenditure/event organization hierarchy in which to conduct the search for resources. The default hierarchy value is the hierarchy assigned to the operating unit for the current responsibility as defined in Implementation Options. You can change this value to any project expenditure/event organization hierarchy in the database. This field is required for performing a resource search.

- **Starting Organization**
  
  This field identifies the starting organization from which to start the search within the specified project expenditure/event organization hierarchy. All
Understanding Resource Pool Benefits

project expenditure/event organizations below the specified starting organization in the organizational hierarchy are considered in the search as well. This field is required for performing a resource search.

■ Country

This field identifies the country for which to conduct the search for resources. This country is compared to the primary address of the resource as of their primary HR assignment start date.

---

**Note:** If a resource does not have a country defined for their primary address, but matches all other search criteria, that resource will be included in the search results.

---

■ Availability

The Minimum Availability field identifies the minimum availability required for the resource to be considered a match for the requirement. Availability is the available number of hours in schedule of a resource. It is equal to the capacity of the resource minus the number of hours on confirmed assignments. Any assignment with a provisional system status does not reduce the availability of the resource.

The availability of a resource is considered from the current system date and does not reflect any past dates. For example, you have a requirement that spans four weeks with the start date that began last week. If a resource is found to have the next three weeks 100% available, then that resource is considered as a 100% match without any regard to the availability of the resource for the first week of the requirement. A resource search will never return any results when the requirement is completely in the past (when the end date of the requirement is prior to the current date.)

In order for a resource to qualify for the search results, the resource must have availability records for at least a portion of the assignment duration. An availability record represents each day a resource has availability. These records are generated for a specific time period in the future for every resource. The specific time period is determined by the profile option PA: Availability Duration. For example, you have a requirement with a time length of two years but a resource has availability records for only the next year with availability (meaning these records are not used for other confirmed assignments), the resource will still be delivered in the search results as a potential match.
You can view the availability of a resource on the timeline on the Resource Details page. The displayed availability may not be correct if the resource does not have an assigned calendar for the duration of the requirement or the calendar schedules have not been generated or updated for the period.

For more information on the calculation of availability, refer to "Establishing the Availability and Overcommitment Calculations" in Chapter 8, "Defining Calendars and Schedules".

- **Job Level Match**

  For an explanation on how the job levels affect searches on your resource pool, refer to "Specifying the Job Levels for Searches" in Chapter 3, "Establishing Your Enterprise Structure".

- **Competencies**

  For an explanation on how competencies affect your search results, refer to "Matching Resource and Requirement Competencies" and "Assigning Global and Local Competencies" later in this chapter.
Defining Employees and Employee Assignments

After establishing your enterprise structure, you can add your employees and their respective primary assignments.

You can enter employee information through the Enter and Maintain People form using either the Project Resource Management Super User, US HR Manager or the Human Resources responsibilities.

---

**Note:** In Oracle HRMS, contractors are set up as employees (system person type) and are created under the user person type of Contractor.

---

Resources are assigned to organizations by creating assignments. You can use these date-specific assignments to define future assignments.

Defining Employees

Oracle Project Resource Management requires the following employee information:

- Last Name
- First Name
- Employee Number
- Start Date
- Organization (Expenditure/Event organizations only)
- Job (HR job)
- Supervisor (for workflow approval processes)
- Location (Address)
- Primary Address
- Calendar

You can enter your employee information manually, or most of the information in a bulkload through the use of an Application Programming Interface (API).

For more information on jobs, refer to "Defining Jobs and Job Mapping" in Chapter 3, "Establishing Your Enterprise Structure".
For technical information about using the HRMS APIs, refer to “Technical Essays” in Implementing Oracle HRMS. For instructions on entering employee information, refer to Managing People Using Oracle HRMS.

For instructions on assigning a calendar to a resource, refer to “Assigning Calendars” in Chapter 8, “Defining Calendars and Schedules”.

**Note:** Each employee must have a defined primary address. This address is used by the search functions within Oracle Project Resource Management. If the address information is missing, the employee cannot be created as a resource within this application.

**Defining Employee Assignments**

Employee assignments, also called primary assignments, describe the role of the person within your organization. This organization must be in the project expenditure organization hierarchy. Every employee, including contractors, must have a primary assignment. For instructions on creating and assigning employee assignments, refer to Managing People Using Oracle HRMS.

**Defining Locations**

The Locations table is populated as you add the employee locations, or any locations, in the free text fields through the Project Resource Management application. Users can reuse previous entries or create new locations. For example, if you enter the following as a new location:

City: San Francisco  
State: California  
Country: United States

Any user can access this location information when prompted for location anywhere in the application. However, you can add only city and states, not countries.
Setting Up Competencies

Competence management encompasses a full cycle of events, from designing your competence structure to performing project resource matching. Once established, you can use your competencies for various activities such as determining the competence profiles of your resources, staffing projects using skill matching, and searching your staff for specific skills.

Defining Your Competence Structure

In defining your competence structure and competencies, you must first decide if you want to share the competencies across business groups. This decision determines if you will setup global competencies, local competencies for each business group, or both.

Oracle Project Resource Management recognizes all competencies regardless of whether they are flagged as global or local. However, you can only establish global competencies if the HR: Cross Business Group profile option is set to Yes. If you are not in cross-business group mode, you can only view the local competencies for your business group. This exclusion eliminates viewing any competencies that belong exclusively to other business groups.

Note: You must make a decision on your competence structure in the planning stage because once you set up the competencies, you cannot change the structure.

Your competence structure can reflect skills or measurable behaviors broken down into multiple levels. The number of levels you want to set up determines how you should set up your key flexfield structures.

The following table provides an example of how a competence of language expertise can be broken down into multiple levels:

<table>
<thead>
<tr>
<th>Competence - Level 1</th>
<th>Level 2</th>
<th>Level 3</th>
<th>Level 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>Indo-Iranian</td>
<td>Indic</td>
<td>Assamese</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Bengali</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Sindhi</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Hindi</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Urdu</td>
</tr>
</tbody>
</table>
Unless your business is very specific about linguistics, you most likely would not categorize the languages into such detail. However, the example does demonstrate how you might use the various levels of competencies to categorize the skills.

Using a different example, you may have a competence such as knowledge of the Oracle Projects applications. As your business may have many software skills you want to track, you might want to set up a higher competence level labeled "Knowledge of Software Applications". The following table provides an overview of how you might breakdown the competence levels:

<table>
<thead>
<tr>
<th>Competence - Level 1</th>
<th>Level 2</th>
<th>Level 3</th>
<th>Level 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>Indo-Iranian</td>
<td>Iranian</td>
<td>Persian</td>
</tr>
<tr>
<td>Language</td>
<td>Germanic</td>
<td>West Germanic</td>
<td>English</td>
</tr>
<tr>
<td>Language</td>
<td>Germanic</td>
<td>North Germanic</td>
<td>Icelandic</td>
</tr>
</tbody>
</table>

For more information on setting up competencies, refer to the following sources:

- Documentation Update for Patch Numbers 1383905 and 1377992 - Global Competencies
- "Career and Succession Management" in Implementing Oracle HRMS
- "Creating a Competence" in Managing People Using Oracle HRMS
Setting Up Competencies

- "Planning Your Descriptive Flexfields" in the *Oracle Applications Descriptive Flexfields Guide*
- "Defining Descriptive Flexfields" in the *Oracle Applications Descriptive Flexfields Guide*

---

**Note:** When creating your competencies, you must define proficiency levels in order for the competencies to be recognized in resource requirement searches. The Oracle HRMS application does not require you to complete this information.

---

Assigning Competencies

The following objects can have assigned competencies:

- Resources (people)
- Jobs
- Roles
- Requirements

If all of these objects have defined competencies, a structure exists in which your users can perform competence matching to find potential candidates for requirements.

Assigning Job Competencies

You define jobs through the Oracle HRMS application. For each job, you can assign required and desired competencies. For more information on defining jobs, see *Implementing Oracle HRMS*.

Assigning Project Role Competencies

When users define requirements, they must associate project roles to the requirements. The project role determines the default competencies of the requirement that are used for performing searches to fill the requirement.

You define project roles using the Define Project Roles window in Oracle Projects. For each project role, you define a default job. All job-associated competencies are automatically copied over to the project role. You can add, modify, or delete
competencies and their associated proficiency levels to the project roles as suits your needs. For information on creating project roles, see Chapter 6, "Defining Project Roles".

**Note:** You can assign only global competencies to a project role.

### Assigning Requirement Competencies

Your users define project requirements using the Requirement Detail page. The system copies the competencies of the project role to the requirement to which they can add, modify, or delete as meets their needs. Each competence determined to be mandatory for the requirement must have the required range of proficiency specified in that skill. This range is used for comparison during a resource search.

**Note:** Your users can assign global competencies to a requirement, as well as local competencies belonging to the business group of the requirement.

### Assigning Resource Competencies

Users with resource authority can define the competence profile and other professional details of a resource using the Self-Service Human Resources (SSHR) Professional Details module. This module is a component of the shared foundation of Oracle HRMS that is integrated with Project Resource Management. Resources can maintain their own competencies through SSHR. Changes to competence profiles initiate a workflow approval process to the resource manager.

The SSHR responsibilities are as follows:

<table>
<thead>
<tr>
<th>Oracle HRMS Installation</th>
<th>SSHR Foundation Only</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Self-Service V4.0</td>
<td>Employee Self-Service Foundation</td>
</tr>
<tr>
<td>Manager Self-Service V4.0</td>
<td>Manager Self-Service Foundation</td>
</tr>
</tbody>
</table>

For more information, see the following sources available on Oracle MetaLink:

- **Implementing Oracle Self-Service Human Resources 4.0**
- **Oracle Self-Service Human Resources 4.1 - Supplement**
These competencies, in addition to other pertinent information, are compared to the competencies of a requirement when performing resource searches. For more information on the search comparison, see the following section "Matching Resource and Requirement Competencies".

**Matching Resource and Requirement Competencies**

When a user performs a resource search to fill a requirement, all the mandatory and optional competencies of the requirement are compared to those of the resource. All resources with the mandatory competencies and desired competence levels are potential matches given the other search criteria is met. Each resource produced from the search must have these mandatory competencies at a level that is within the specified competence levels for the requirement. If a competence associated to a resource or a requirement has no proficiency level then it is considered to be at the lowest proficiency level.

For each matching resource, the matches between the optional competencies of the requirement and the competencies of the resource display in the following format: 0/2. The first number indicates the number of matches, and the second number refers to the actual number of optional competencies of the requirement. For example, 4/5 means that the resource has four of the five optional competencies at the specified proficiency level for the requirement.

The competencies in the Modify Search Criteria page will default from the competencies defined for the requirement, but you can also modify them, their associated proficiency levels, as well as their mandatory flag on the Modify Search Criteria page as well. Note that by modifying them on this page, you are not changing the original definition on the requirement.

**Assigning Global and Local Competencies**

Local competencies are competencies defined for a particular business group. Global competencies span across all business groups.

You can assign both global and local competencies to a resource. However, to assign a local competence to the resource, the local competence must belong to the same business group as the resource.

For a requirement, the competence list is based on the selected role. You can modify this list through the Requirement Details page, defining both mandatory and optional competencies.
You can assign both global and local competencies to a requirement. If you flag local competencies as mandatory on a requirement, ensure that these competencies all belong to the same business group. Assigning mandatory local competencies from different business groups will prevent the search functionality from producing any results. A resource can have assigned local competencies only within their own business group. Therefore, you should make such local competencies optional for the requirement, or only select global competencies.
Acquiring Your Resources From Oracle HRMS

A concurrent process called PRC: Maintain Project Resources copies your resources and their associated attributes from the Oracle HRMS tables to Oracle Project Resource Management data tables. It identifies valid employees and project-related information that are set up in the Oracle HRMS People definition windows and adds them as resources in Project Resource Management.

You must run this process during your implementation to acquire your resource pool. Thereafter, a background workflow process maintains the resource data. For more information, see:

- "Understanding the Impact of Changes to HRMS-Based Information" in Chapter 13, "Maintaining Your Data"
- "Initiating Deferred Workflow Processes" in Chapter 14, "Overview of the Predefined Workflows"

**Note:** You may need to run this process if you encounter workflow processing errors related to resource information.

Qualifying Criteria for the Resource Pull

The PRC: Maintain Project Resources process checks the qualifying criteria for each resource to ensure that the resource has the necessary information to be an active resource pool member. The qualifying criteria is as follows:

- The resource must have an active and current primary assignment.
- The resource must have a person type of Employee, or a person type that maps to the system type of Employee.
- The end date of the primary assignment should be later than the current (system) date.
- The primary assignment must have a defined job. This job must be mapped to a master job group with an associated job level. This master job group or an associated other job group must be classified as the Project Resource Job Group. For more information, see "Defining Jobs and Job Mapping" in Chapter 3, "Establishing Your Enterprise Structure".
- The primary assignment organization must:
  - have a default operating unit; this operating unit must implement Oracle Projects
– have a specified default calendar or, the profile option PA: Default Calendar must have a defined value
– have the classification of Project Expenditure/Event Organization
– belong to the project expenditure hierarchy

■ The operating unit of the resource must have Forecasting Options definitions.

■ GL Periods and PA Periods must be defined for one year prior to the current system date, as well as, for a minimum of the time period defined for the PA: Availability Duration profile option. For more information, refer to "Overview of the Availability Calculation" in Chapter 8, "Defining Calendars and Schedules".

---

**Note:** Since one of the qualifying criteria is that the resource has a valid calendar, run the PRC: Generate Calendar Schedules process before running this process to ensure all qualified resources are copied.

---

**Running the PRC: Maintain Project Resources Process**

To run this process, complete the following steps:

1. Navigate to the Submit Request screen.
2. Choose Submit > PRC: Maintain Project Resources.
3. Enter the range of employee numbers, or leave the fields blank to retrieve all employees.
4. Select Yes or No for the Update Existing Resource Information field.
   The value of Yes indicates to copy all resource information from the HR tables to the Project Resource Management tables. Therefore, existing resource information in Project Resource Management will be updated.
   If you select No, only new employees are copied to Project Resource Management, therefore, existing resource information is not updated.
5. Enter the desired organization, or leave blank to run the process for all organizations.
6. Click Submit.

You can view the exceptions report generated from this process to see any employees that did not qualify for the resource pool and the reason why.
Migrating Resource Data From Other Systems

Project Resource Management relies on the primary assignment of a resource for a number of internal processes. The primary assignment of the resource and the resource information is established in the Oracle HRMS data tables. Resources are created in Project Resource Management from these tables through one of the following methods:

- Running the concurrent process PRC: Maintain Project Resources. You run this process only during the implementation of Project Resource Management.
- A deferred workflow process called HR Related Update Workflow. This scheduled process synchronizes the HR tables with the Project Resource Management tables in order to maintain current resource data. This workflow process is launched when any update is made to the HR tables.

If you are using a different database instance or a different system from Oracle HRMS to maintain your employee data, you must migrate that data into the HR tables within the same database instance that the Project Resource Management application is running in. Oracle HRMS has several API programs you can use to achieve this task.

These API programs queue up the deferred workflow processes. If the workflow queue becomes too large, you may encounter process failures and errors. To avoid this situation, use the following recommended procedures for migrating your employee data for either a new instance or an existing instance.

Migrating Data for a New Instance

If you are implementing Project Resource Management for the first time and have a large amount of employee data to migrate from Oracle HRMS, use the following steps to avoid overloading the workflow queue during data migration:

1. Disable workflow triggers (using the script par1th02.sql).
2. Migrate your employee data.
3. Run the PRC: Maintain Project Resources process. It is recommended to run this process multiple times with each process using different parameters. Avoid overlapping the parameters so that the same person is not accessed by multiple processes.
4. Enable workflow triggers (using the script par1th03.sql).
Migrating Data for an Existing Instance
If you have implemented Project Resource Management and you migrate employee data into Oracle HRMS on a periodic basis, use the following the guidelines.

■ Small Implementation
    Use the Oracle HRMS API programs to migrate data without disabling the triggers. You do not have to run the PRC: Maintain Project Resources process because the deferred workflow process activated from updates in HR tables will synchronize the data into Project Resource Management tables. However, make sure that the workflow background process is running.

■ Larger Implementation
    To prevent the workflow process queue from becoming too large, separate the migration of new and existing employees. For new employees, complete the steps provided in the previous section "Migrating Data for a New Instance".

    For migrating updates to existing employee information, use the Oracle HRMS API programs. The deferred workflow process will update the Project Resource Management tables. If you encounter problems with the workflow queue, perform the data migration more frequently.
The Oracle HRMS and Oracle Projects applications provide the setup for the core security of your enterprise structure. You define this responsibility-based security structure based on your organization structure and user responsibilities.

With Oracle Project Resource Management, you have an extended project security structure based on project roles. Role-based security enables users to have multiple levels of function access depending upon the assigned roles they have for each given project. For more information on role-based security, see Chapter 6, "Defining Project Roles".

This chapter discusses the project security models through the following topics:

- Defining Your Security Strategy
- Understanding Responsibility-Based Security
- Understanding Role-Based Security
- Defining Organizational Authority
- Demonstrating a Security Check
- Setting Up Security for Viewing Financial Amounts
Defining Your Security Strategy

Your security structure depends heavily on how you manage your projects, and what type of access you want to provide your users. You should determine this information prior to setting up any of the security features. The following table describes some of the basic differences between the responsibility-based and role-based security models:

<table>
<thead>
<tr>
<th>Basic Function</th>
<th>Responsibility-Based Security Model</th>
<th>Role-Based Security Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project List</td>
<td>The project list displays all projects for the given operating unit.</td>
<td>The project list displays all projects for the given operating unit where the user is an active member of has project authority over the project organization.</td>
</tr>
<tr>
<td>View Project Information</td>
<td>The user can view project information except for labor costs for any of the projects appearing on the project list. A user can view the labor costs for a project if this function has been assigned to the responsibility of the user.</td>
<td>If the project member on a project has been assigned to roles with function security enabled, then the member can view the project attributes as allowed by the roles. For users with project authority on a project organization, the user can view all attributes as allowed by the project authority menu. If the member has been assigned to a role with function security disabled, then the member can view the project attributes as allowed by the responsibility level function security. The projects that a user can view are limited by the project list of the user.</td>
</tr>
<tr>
<td>Update Project Attributes</td>
<td>Active key members or users with profile PA: Cross Project responsibility enabled (at the responsibility level) can update the project attributes as allowed by the responsibility level function security.</td>
<td>If the project member on a project has been assigned to roles with function security enabled, then the member can update the project attributes as allowed by the roles. For users with project authority on a project organization, the user can update all attributes as allowed by the project authority menu. If the member has been assigned to a role with function security disabled, then the member can update the project attributes as allowed by the responsibility level function security. The projects that a user can view are limited by the project list of the user.</td>
</tr>
</tbody>
</table>

Each of these models has its own benefits and is described in further detail in the sections to follow.
Understanding Responsibility-Based Security

Within the responsibility-based security structure, users have viewing access to the projects for the operating unit associated to their respective responsibilities. Only project members and cross-project users can update project information or view labor costs (given the appropriate authority.)

You associate functions to menus and the menus to responsibilities. Therefore, the responsibility of a user determines what functions the user can perform.

For further information and instruction, refer to the following sources:

- Implementing Oracle HRMS
- the Security chapter in Customizing, Reporting and System Administration in Oracle HRMS
- User Guide Supplement for Oracle Projects Minipack B (Release 11i Mandatory Patch)

Defining Additional User Level Security

In addition to responsibility based security, you can also define user level security. User level security is determined based on the role the user plays on a project, or by additional security profile options set for the responsibility of the user. For more information on role-based security, see "Understanding Role-Based Security" later in this chapter.

You can define user level security on top of responsibility specific responsibilities assigned to the users at the following levels:

Authority at the Organization Level

You can designate a user to have project, resource, utilization, or forecast authority for a given organization. This specific role defined at the organization level provides access to all projects created under the organization. See "Defining Organizational Authority" in this chapter.

User with View All Projects Access

Cross-project users with view access can view all projects across multiple operating units whether or not they are defined as a project member or have project authority. You can provide view access by setting the profile option called PA: Cross-Project User - View to Yes.
You can set this profile option at the following levels:

- site
- responsibility
- user

The default value for this profile option is Yes. However, for responsibilities of Project Resource Management, you may want to consider setting this profile option to No so that only relevant projects (projects within the operating unit) is available for viewing. For either setting, you want to set this profile option consistently across responsibilities.

**User with Update All Projects Access**

Cross-project users with update access can update any project provided no other restrictions have been applied. However, users can only update information on the project if the project belongs to the same operating unit as the responsibility the user has used to log in.

You can provide update access through the profile option called PA: Cross-Project User - Update. Setting this profile option to Yes provides your users this ability. You can set it at the responsibility and user levels. The default value for this profile option is No.

---

**Note:** This profile option is generally reserved for your power users that need cross-project and cross-organization access.

---

**User with View All Resources Access**

Users with view all resources access can view the resource information for all resources across multiple operating units whether or not they are the resource manager of the resource or have organization resource authority. You can provide view access by setting the profile option PA: View All Project Resources to Yes. You can set this profile option at the responsibility level. The default value for this profile option is set to Yes for the Project Super User responsibility.

Setting this profile to Yes provides your users the ability to view all resources in Project Resource Management and have the security to confirm any assignments for the resources.
Understanding Role-Based Security

Role-based security provides a means of controlling user access based upon the role the user is currently playing on a project team. Every project member is assigned a role. The access levels of that role are bestowed upon the user for the duration of the role assignment. A user can play different roles on different project teams. For example, you may assign a user a project lead role for a particular project in the first half of the year and then, a consultant role on another project for the second half of the year. These roles have completely different project security access and controls. Responsibilities allow access to the overall application and determine the menus and functions to which a user has access.

With role-based security, you assign the menus to roles. This level of assignment offers more flexibility than the responsibility-based security structure.

**Note:** You define project roles for your entire enterprise. They are not specific to any operating group or business group.

Levels of Role-Based Security

Role-based security offers multiple levels of control. You determine how detailed you want your security levels. The available levels are as follows:

- **Roles**
  You assign menus to roles to determine the menu and function access for each role.

- **Menus**
  You assign functions to menus, roles, and responsibilities.

- **Functions**
  You can attach the desired functions (access to pages or actions) to the individual menus.

Predefined Roles

Oracle Project Resource Management provides the following predefined roles. For more information on the individual authorities, refer to "Defining Organizational Authority".
Project Manager
The Project Manager role provides access to all security access functions for the project.

Project Staffing Owner
The Project Staffing Owner is the primary contact for the advertised requirements on the project and is listed on the notifications and e-mails sent out for advertisements. The Project Staffing Owner is different from a staffing manager. Staffing Manager is the primary staffing contact for an entire organization, but a project staffing owner is the primary person for staffing requirements for a specific project.

Project Authority
Project Authority is an internal role at the organization level. A user with project authority on an organization can view all projects in that organization. The Staffing Analyst menu is assigned to this role as predefined data. Therefore, a user with project authority is by default a staffing analyst for all projects within the organization of the user.

Resource Authority
Resource Authority is an internal role at the organization level. A user with Resource Authority can manage all of the resources for that organization. This role provides access to all resource information within the given organization including any project-related information for that resource.

Utilization Authority
Utilization Authority is an internal role at the organization level. A user with Utilization Authority can calculate and view utilization for an organization.

Forecast Authority
Forecast Authority is an internal role at the organization level. A user with Forecast Authority can generate and view forecast information for all projects in an organization.

Predefined Responsibilities

You have the following classes of users who typically need access to project resourcing information:
The implementation of Oracle Project Resource Management provides these user classes as predefined responsibilities on the home page of Oracle Project Resource Management. These responsibilities have the following associated default functions:

**Organization Manager (Business Manager)**
- Project reviews
- Team reviews
- Forecast generation and review
- Resource utilization generation and review

**Project Manager**
- Project creation and maintenance
- Project schedule creation and maintenance for own projects
- Resource searching
- View resource details
- Requirement searching
- Setup of project subteam
- Access notifications

**Resource Manager**
- Perform a requirement search
- View the schedules of resources for which they are responsible
- Enter administrative assignments for resources for which they are responsible
- View and update resource details for resources for which they are responsible
- Access notifications
### Staffing Manager
- Project schedule creation and maintenance for own resources on own projects
- Resource searching
- View resource details
- Requirement searching
- Resource schedule creation and maintenance for own resources (on own projects)
- Access notifications

### Team Member (Resource)
- View their own schedule
- Enter their own administrative assignments
- Requirement searching
- View and update their own resource details
- Access notifications

### Project Resource Management Super User
The Project Resource Management Super User can access (view and edit) everything on all projects and everything related to all resources.

### Overview of Predefined Responsibility Function and Menu Access
The following table highlights whether or not certain function access is enabled for each predefined responsibility:

<table>
<thead>
<tr>
<th>Predefined Function</th>
<th>Project Manager</th>
<th>Resource Manager</th>
<th>Staffing Manager</th>
<th>Resource</th>
<th>Project Super User</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Project</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Project List</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>My Details (Schedule)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

**Note:** The functions listed below are only a subset of the functions associated with each responsibility.
The following table indicates whether or not the menu access is enabled for each predefined responsibility:

<table>
<thead>
<tr>
<th>Predefined Menu</th>
<th>Project Manager</th>
<th>Resource Manager</th>
<th>Staffing Manager</th>
<th>Resource</th>
<th>Project Super User</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Manager</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Project Authority</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Resource Authority</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Resource</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Resource Pool</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Detailed Predefined Function Access by Responsibility

This section provides predefined function access grouped by responsibility as well as the menus associated to each responsibility. A list of the predefined menus and their respective functions are provided in the section titled "Predefined Function Access by Menu" later in this chapter.

Organization Manager Responsibility
The predefined functions that are displayed to the user upon login with this responsibility are:

- Organization Utilization
- Project Pipeline Workbook

The following menu is associated with this responsibility:

- Resource Pool
- Utilization Authority

Project Manager Responsibility
The predefined functions that are displayed to the user upon login with this responsibility are:

- Create Project
- Page Layouts*
- Project List
- Project Templates**
- Required Project Hours Workbook
- Requirement Search
- Workflow Notifications

The following menus are associated with this responsibility:

- Balance by Project, Cost Center: Project View**
- Balance by Project: Project View**
- Project Manager Role
- Resource Pool Role
Transaction Details for Project: Project View**

**Note:** For more information on the predefined function marked with an (*), please refer to the Oracle Projects 11i.PJ_PFI Family Pack Documentation Supplement (document #283837) available on Metalink.

For more information on the predefined function and menus marked with an (**), refer to the About Oracle Projects Family Pack J (11i. PJ_PFJ document # 204637.1) available on Metalink.

**Resource Manager Responsibility**
The predefined functions that are displayed to the user upon login with this responsibility are:

- Resource List
- Requirement Search
- Resource Utilization
- Staffing Home
- Workflow Notifications
- Available Resource Hours Workbook
- Organization Competence Summary Workbook
- Overcommitted Resource Hours Workbook
- Resource Competencies Workbook
- Scheduled Resource Hours Workbook

Predefined portlets available to the user are:

- Resource Manager View of Available Resources
- Resource Manager View of Available Resources Timeline
- Resource Manager View of Overcommitted Resources
- Resource Manager View of Overcommitted Resources Timeline

The following menu is associated with this responsibility:

- Resource Pool Role
**Staffing Manager Responsibility**

The predefined functions that are displayed to the user upon login with this responsibility are:

- My Resources
- Open Requirements
- Project List
- Requirement Search
- Resource Utilization
- Staffing Home
- Workflow Notifications
- Available Resource Hours Workbook
- Organization Competence Summary Workbook
- Overcommitted Resource Hours Workbook
- Resource Competencies Workbook
- Required Project Hours Workbook
- Scheduled Resource Hours Workbook

Predefined portlets available to the user are:

- Staffing Manager View of Available Resources
- Staffing Manager View of Available Resources Timeline
- Staffing Manager View of Overcommitted Resources
- Staffing Manager View of Overcommitted Resources Timeline

The following menu is associated with this responsibility:

- Resource Pool Role

**Team Member Responsibility (Resource)**

The predefined functions that are displayed to the user upon login with this responsibility are:

- Own Resource Details (Schedule)
- Personal Utilization
Understanding Role-Based Security

- Project List
- Requirement Search
- Workflow Notification

The following menu is associated with this responsibility:

- Team Member Role

**Project Resource Management Super User Responsibility**

The predefined functions that are displayed to the user upon login with this responsibility are:

- Advertisement Rule
- Create Project
- My Projects
- My Resources
- Open Requirements
- Organization Roles**
- Organization Utilization
- Page Layouts*
- Page Layout Setup*
- Project Templates**
- Requirement Search
- Team Templates
- Workflow Notifications
- Available Resource Hours Workbook
- Organization Competence Summary Workbook
- Overcommitted Resource Hours Workbook
- Project Pipeline Workbook
- Required Project Hours Workbook
- Resource Competencies Workbook
- Scheduled Resource Hours Workbook
The predefined security functions are:

- Edit Page Layouts
- Edit Project Status Reports
- Remove Conflicts
- View Project Status Reports

The following menus are associated with this responsibility:

- Project Administrator Responsibility**
- Project Authority
- Resource Authority
- Resource Pool Role

**Note:** For more information on the predefined functions marked with an (*), please refer to the Oracle Projects 11i.PJ_PFI Family Pack Documentation Supplement (document #283837) available on Metalink.

For more information on the predefined functions and menu marked with an (**), please refer to the About Oracle Projects Family Pack J (11i. PJ_PFJ document # 204637.1) available on Metalink.

---

**Predefined Function Access by Menu**

The predefined menus are as follows:

- Project Manager
- Project Staffing Owner
- Resource
- Resource Pool
- Project Authority
- Resource Authority
- Utilization Authority
- Forecast Authority
This section provides a list of the predefined functions for each menu in alphabetical order.

**Project Manager**
The predefined functions for this menu are:
- Projects > Apply Team Template
- Projects > Candidates
  - Create
  - Review Log
  - View
- Projects > Identification > Resource Search
- Projects > Forecast
  - Generate
  - View
- Projects > Options > Project
  - View and Edit Additional Information
  - View and Edit Classifications
  - View and Edit Customers and Contacts
  - View and Edit General Information
  - View and Edit Key Members
  - View and Edit Organization
  - View and Edit Page Layouts
  - View and Edit Pipeline
  - View and Edit Project Access Setup
  - View and Edit Team Member List
- Projects > Options > Resource
  - View and Edit Additional Staffing Information
  - View and Edit Candidate Score and Search Settings
  - View and Edit Subteens
- Projects > Page Layouts > View
- Projects > Projects List > View Summarization Columns
- Projects > Requirement/Assignment
  - Create and Delete
  - Edit Advertisement
  - Edit Schedule
  - View and Edit General Information
  - View and Edit Forecast Information
- Projects > Resources > View
- Projects > Setup
- Projects > Status
  - Approved Statuses
  - Change Project Status
  - Closed Statuses
  - Pending Close Statuses
  - Submitted Statuses
  - Unapproved Statuses
- Project Status Reports
  - View
  - Edit

**Project Staffing Owner**
- Projects > Assignment
  - Create and Delete
  - Edit Advertisement
  - Edit Schedule
  - Remove Conflicts
  - View and Edit General Information
- View and Edit Forecasting Information
- Projects > Candidates
  - Create
  - Review Log
  - View
- Projects > Identification > Resource Search
- Projects > Options > Project
  - View and Edit Additional Information
  - View and Edit Classifications
  - View and Edit Customers and Contacts
  - View and Edit General Information
  - View and Edit Key Members
  - View and Edit Organizations
  - View and Edit Page Layouts
  - View and Edit Pipeline
  - View and Edit Project Access Setup
  - View and Edit Team Members
- Projects > Options > Resource Setup
  - View and Edit Additional Staffing Information
  - View and Edit Candidate Score and Search
  - View and Edit Subteams
- Projects > Project Home
- Projects > Project Setup
- Projects > Resources Schedule
  - View

**Resource**
The predefined functions for this menu are:
Understanding Role-Based Security

- Projects > Administrative Assignment
  - Create and Delete
  - Edit Basic Information
  - Edit Schedule
  - View Basic Information
- Projects > Assignment > View Basic Information
- Projects > Identification
  - Requirement Search
- Projects > Requirement Search
  - Nominate Self
- Projects > Resource Candidacy
  - View
  - Withdraw Self
- Projects > Resource Pool
  - View Work Information

**Resource Pool**

The predefined functions for this menu are:

- Projects > Administrative Assignment
  - View Basic Information
- Projects > Resource Pool
  - View Competencies
  - View Resume
  - View Schedule
  - View Work Information

**Project Authority**

This menu has the same predefined functions as the Project Manager menu.
Resource Authority
The predefined functions for this menu are:

- Projects > Administrative Assignment
  - Confirm
  - Create and Delete
  - Edit Schedule
  - View and Edit Forecast Information
  - View and Edit General Information
- Projects > Assignment > Confirm
- Projects > Requirement Search
  - Nominate
- Projects > Resource Candidacy
  - View
  - Withdraw
- Projects > Resource Pool
  - View Competencies
  - View Resume
  - View Schedule
  - View Work Information
- Resource Utilization

Utilization Authority
The predefined functions for this menu are:

- Projects > Personal Utilization
- Projects > Resource Utilization
- Projects > Organization Utilization

Forecast Authority
The predefined functions for this menu are:
- Projects > Assignment > View Basic Information
- Projects > Forecast View
Defining Organizational Authority

Establishing organizational authority enables you to specify the authority for a resource at an organizational level. The key benefit is you do not have to assign roles for people with organizational authority because it provides access to all projects, resources, forecasting, and utilization information for the specified organization.

However, you must specify each organization that a user should have authority over. This authority does not acknowledge organizational hierarchies. For example, if you have resource authority over a top organization, you do not automatically have resource authority for all subordinate organization. You have to individually specify each organization to which you want resource authority. This division provides greater flexibility, especially in the case of a reorganization or change in the organizational hierarchy.

You have four levels of organizational authority providing different access:

- **Project Authority**
  This authority level enables a user to perform staffing functions on a project. The difference between this authority and the Project Manager role is the Project Manager role only applies to assigned projects. A user with project authority can perform staffing functions on all projects within the organization.

- **Resource Authority**
  This authority level provides a user security access similar to the access you would require as a resource manager. You have the ability to perform tasks, such as confirm assignments, for resources for the entire organization.

- **Utilization Authority**
  This authority level enables a user to calculate and view utilization for the specified organization.

- **Forecast Authority**
  This authority level enables a user to generate and view forecast information for projects within the specified organization.

Defining a Primary Contact

For Resource Authority and Forecast Authority, you can specify a primary contact to handle cases where you have more than one person who has authority for an
organization. Specifying the primary contact determines to whom to route workflow approvals for assignments or forecasts.

---

**Note:** You can only assign one primary contact per organization.

---

**Assigning Organizational Authority**

To establish organizational authority for your users:

1. Select the following menu path: Setup > Human Resources > Organizational Authority
2. Click Add Organizations.

You can search for organizations based on the following three fields:

- **Resource Name**
  Select the resource for which you want to establish organizational authority.

- **Hierarchy**
  Select the hierarchy in order to establish a list of resource organizations. This field defaults to the expenditure hierarchy of the operating unit of the resource.

- **Start Organization**
  Select the organization to use as the start organization in order to provide a list of subordinate organizations.

You must at least select the name of the resource to perform a search. After you make your entries, click Find Organizations. The search produces all organizations for which the specified resource has organizational authority.

If you selected a hierarchy or organization as criteria for the search, the results display all qualifying organizations. Any organization for which the resource has authority displays with a checkmark. To grant authority over the organization to this resource, click the checkbox next to the desired organization and click Save. You can assign one or more of the following authorities to a resource for each organizations:

- **Project Authority**
- **Resource Authority**
- **Utilization Authority**
- **Forecasting Authority**
Demonstrating a Security Check

When a user initiates an action by attempting to perform a function in Oracle Project Resource Management, a security check process is invoked. This process searches for the appropriate permissions to allow the user to perform the requested action. The logic of the security checks is as follows:

Check to see if the selected function is for a project.

- If the answer is no, check if the user has the appropriate function security under the assigned responsibility.
  - If the answer is no, end the process.
  - If the answer is yes, perform the action.
- If the answer is yes, check if the user has any secured roles on the project that would allow the user to perform this function.
  - If the answer is yes, perform the action.
  - If the answer is no, check if the user has only secured roles on the project.
    - If the answer is yes, end the process. The process ends here because it has been determined that the user does not have access to this functions through any of the assigned secured roles.
    - If the answer is no, check the client extension called PA_SECURITY ALLOW_UPDATE. If the client extension is set to No, end the process. If it is set to Yes, check if the user has the appropriate function security under the assigned responsibility.
      - If the answer is no, end the process.
      - If the answer is yes, perform the action.

Note: A secured role is a role with defined function security. When the system performs a check for secured roles, it also performs a check on whether or not the user has project authority. If this check returns a true value, then the whole check is considered true.

Figure 5-1, "Security Check Process Flow" demonstrates this process flow.
Demonstrating a Security Check

Figure 5–1  Security Check Process Flow

start

Is the selected function for an existing project?

Yes

No

Does the user have any secured role on the project that allows access to this function?

Yes

No

Does the user have appropriate responsibility level function security?

Yes

No

Perform the allowed actions

Stop

Does the user have only secured roles on the project?

Yes

No

Check client extension PA_SECURITY_ALLOW_UPDATE
Setting Up Security for Viewing Financial Amounts

You can configure the Project List table to display a variety of summarized project-level financial numbers. These numbers are derived from the Project Status Inquiry (PSI) window. The titles of the financial amount columns on the Project List page are exactly the same as those in the PSI window.

---

**Note:** All financial amounts are displayed in the functional currency defined for the project. You cannot see an indication of the functional currency (such as USD for US dollars, for example) on this page.

---

The system secures the financial amounts that display in these columns with the Project List: View Summarization Columns function, which is associated to the Project Manager Role Menu by default. The Project Manager Role Menu is attached to the Project Manager role. Therefore, you can use the Project List: View Summarization Columns function to enforce role-based security for the financial amounts that can appear on the Project List page. For example, you can use the function to ensure that only project managers (for example) see financial amounts on the Project List page.

---

**Note:** All team members have access to projects they have worked on until their security access to those projects is changed.

---

To give users access to financial amounts on the Project List page:

1. Determine which roles you want to have the ability to view financial amounts for projects, and associate those roles to the appropriate employees.
2. Create a new menu.
3. Attach all the functions you need to this menu.
4. Attach the security function Project List: View Summarization Columns to this menu.
5. Create the project role using the Project Roles window in Oracle Projects.
6. Specify the menu you just created as the default menu for the role.
7. Assign the people to the project as key members with the project role you just created.
8. When these key members come to the Project List page, they can see project-level financial amounts and create views that include or exclude those columns as necessary.
Project roles are the templates for your team roles. This chapter covers defining project roles through the following topics:

- Definition of a Project Role
- Overview of Predefined Role Controls
- Defining Role Lists
- Defining Project Roles
Definition of a Project Role

A project role is a collection of default information about a team member role on a project, such as competencies, job information, and security. You create project roles to represent the typical team member roles needed for projects within your organization.

How Project Roles are Used

A team role represents either a requirement or an assignment on a project. You use the project role as a template for your team roles. When you create a team role, you specify the project role from which to obtain all the default information. The default information is copied from the project role to the team role. Thereafter, you can modify the information on the team role as appropriate for that role on that particular project. Any changes you make to the team role are exclusive and do not affect the definition of the project role.

For example, you have a project role called DBA. You create a team role on a project called Lead DBA based on the DBA project role. All the defined competencies, job information, and security information is copied from the DBA project role to this new Lead DBA team role. You decide to add more competencies to the Lead DBA team role and to change the job level. These changes are only reflected on this particular team role.

Each project role has a security structure determining the features users can access and the functions they can perform. This security structure is referred to as role-based security. Though role-based security is optional, it offers you more flexibility than responsibility-based security because the role of a user can change from project to project. Therefore, the function access a user may require can change from project to project. For more information on security, see Chapter 5, "Configuring Your Organization Security".

In the application, the team role is the value displayed on most pages. The project role is only available on the assignment and requirement details pages.
Overview of Predefined Role Controls

You use role controls to define an additional dimension of security layering. These controls determine how you (or other users) can use the role. The following predefined controls are available:

- Allow as Scheduled Member
- Allow as Task Member
- Allow as Project Member
- Allow as Contract Member
- Allow View Labor Costs

You can assign as many of these controls to roles as necessary. For example, the control Allow as Scheduled Member indicates that you can schedule any person assigned to the role as their availability permits. You want to assign this control to any role that should be available for scheduling resources on projects. Since role assignments occur at the project level, you must, at a minimum, assign the role control Allow as Project Member to each role.

**Note:** The role controls Allow as Task Member and Allow as Contract Member are not currently enabled.
Defining Role Lists

You use role lists to categorize your roles into logical groupings. For example, you may have a role list called Consulting to which all roles relating to consulting are assigned.

**Note:** A role list can not be deleted once it has been associated with a project.

To add, modify, or delete role lists, use the Role Lists form under Setup. In this form, you can specify the name, description, and effective dates for a role list. After you define these parameters, you can select the roles you want assigned to this role list.
Defining Project Roles

Prior to defining your project roles, establish the following items:

- Competencies
- Jobs
- Role Lists

You can define the project roles in Oracle Projects through the Define Roles form under Setup. The following table lists the information you must define for each project role:

<table>
<thead>
<tr>
<th>Prompt</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Role Lists</td>
<td>Identify the role lists to which you want the role assigned.</td>
</tr>
<tr>
<td>Access Menu</td>
<td>Identify a security menu that the role can perform on a given project.</td>
</tr>
<tr>
<td>Default Competencies</td>
<td>Identify all default competencies required for the role. These competencies are used for requirement definition.</td>
</tr>
<tr>
<td>Default Job and Job Group</td>
<td>Identify the default job and job group for the role. Calculations for costing, billing, and transfer pricing use the default job to forecast project resource requirements. This default job can be overridden by a Project Cost Job, Project Billing, and Project Transfer Price Job. You can use job mapping logic to map the default job of the role to the master job if they are in different job groups.</td>
</tr>
<tr>
<td>Default Minimum and Maximum Job Levels</td>
<td>Determine the minimum and maximum job levels for this role. The job levels of a requirement are compared to these levels when performing candidate (resource) searches.</td>
</tr>
<tr>
<td>Effective Dates</td>
<td>Identify the date range the specified role is effective.</td>
</tr>
<tr>
<td></td>
<td>In some cases, you may not know the ending effective date because it has not been determined. Therefore, only a start date is required.</td>
</tr>
</tbody>
</table>

You can also assign the appropriate role controls to each project role. At a minimum, you must assign the role control Allow as a Project Member.
The staffing life cycle begins with the creation of requirements on your projects, and ends with assigning resources directly or, through nominating, reviewing, and selecting candidates. The team roles and staffing processes have some required and optional predefined behavior. You can define this default behavior through profile options, statuses, and other attributes.

This chapter describes this setup through the following topics:

- Overview of Predefined Statuses and Status Controls
- Defining Requirement Statuses and Profile Options
- Setting Up Candidate Processing
- Defining and Setting Up Advertisement Rules
- Defining Assignments Statuses and Profile Options
Overview of Predefined Statuses and Status Controls

A status is the state of an object. Objects can only have one status at a time. With your implementation of Oracle Project Resource Management, you are provided with basic predefined statuses for the following objects:

- projects
- requirements
- assignments
- candidates
- assignment approval

You can create new user statuses based on the available system statuses to meet your business needs and create process flows that support those needs. You can also modify the default status controls for each user status.

For each existing user status, you must define the next allowable statuses. Defining the next allowable statuses determines the process flow for your objects. For example, you can specify that a requirement with the user status of Open can have its status changed to the user statuses of either only Filled or Cancelled. This example shows that you have just determined two possible process flows of a requirement:

- Open -> Filled
- Open -> Cancelled

For more information on statuses, status controls, and how workflow processes use the statuses, see the following sources:

- "Setting Up the Predefined Project Status Controls" in Chapter 9, "Defining the Project Environment"
- Oracle Projects 11i Release 11.5.3/Mini Pack B User Guide Supplement
- Oracle Projects User Guide
- Chapter 14, "Overview of the Predefined Workflows"

**Note:** Statuses are available for your entire enterprise, and are not specific to any business group or operating unit.
Defining Requirement Statuses and Profile Options

The requirement status that indicates the state or condition of the requirement in the staffing life cycle. This section describes the predefined values for requirement statuses and status controls. It also describes the related profile options that you must define. Set up of these statuses and profile options is required.

Predefined Requirement Statuses and Status Controls

The following table provides list of the predefined requirement statuses and suggested next allowable statuses.

<table>
<thead>
<tr>
<th>System Status</th>
<th>User Status</th>
<th>Description</th>
<th>Suggested Next Allowable Statuses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Open</td>
<td>The requirement is available for resource assignments.</td>
<td>Filled</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Cancelled</td>
</tr>
<tr>
<td>Filled</td>
<td>Filled</td>
<td>The requirement has an assigned resource.</td>
<td>Cancelled</td>
</tr>
<tr>
<td>Cancelled</td>
<td>Cancelled</td>
<td>The requirement was cancelled.</td>
<td>None</td>
</tr>
</tbody>
</table>

Three status controls exist for the requirement statuses:

- Include in Project Forecasts
- Visible in Requirement Searches
- Assign Resources to the Requirement

Use these status controls to restrict allowable actions on requirements based on status.

Requirement Status Profile Options

You must define the following profile options to set the status defaults for requirements. Each profile option is set at the site level only.

**PA: Starting Requirement Status**

This profile option defines the default status of newly created requirements.
Defining Requirement Statuses and Profile Options

**PA: Default Filled Requirement Status**
This profile option defines the requirement status when the requirement is filled and becomes an assignment.

**PA: Default Cancelled Requirement Status**
This profile option defines the status of a requirement when it is canceled.

**Defining Staffing Priorities for Team Roles**
Staffing priorities provide your users a means of identifying requirements that should receive more attention in staffing efforts than others. You can define values for the Staffing Priorities using the Project Resource Management Super User responsibility and the following navigation path:

Setup > Staffing > Staffing Priorities

Your users can select staffing priorities when they are adding or updating requirements. An assignment retains the staffing priority allocated to the original requirement before it became an assignment (filled requirement).

You define the staffing priorities as lookup values. However, the setup of the staffing priorities is optional. For more information on lookup types, see "Lookups" in the Oracle Applications Developer’s Guide.

**Defining the Team Role Descriptive Flexfield**
A descriptive flexfield is available in Project Resource Management for defining additional information on your team roles. The following table provides the name and lists the pages on which your users can view this descriptive flexfield:

<table>
<thead>
<tr>
<th>Descriptive Flexfield</th>
<th>Pages Containing Descriptive Flexfield</th>
</tr>
</thead>
<tbody>
<tr>
<td>Team Role</td>
<td>Requirement Details</td>
</tr>
<tr>
<td></td>
<td>Assignment Details</td>
</tr>
<tr>
<td></td>
<td>Team Schedule</td>
</tr>
</tbody>
</table>

For both the Requirement Details and Assignment Details pages, this flexfield automatically appears. In order to view this flexfield on the Team Schedule page, you must personalize the page using the Personalize button. When a requirement or assignment is copied, any descriptive flexfield values on the original requirement or
Assignment are also copied to the new requirement or assignment. When a requirement is filled, this flexfield is copied to the assignment.

For more information on descriptive flexfields, see:

- Appendix D, "Descriptive Flexfields" in the Oracle Projects User Guide
- Oracle Applications Flexfields Guide

Setting Up Candidate Processing

Candidates are the nominated resources for open requirements. The setup for nominating and processing candidates includes setting up required statuses and profile options and defining default values for the candidate score and automated search process. This section describes these setup features.

Defining Candidate Statuses and Profile Options

Each candidate has a status that indicates the state of consideration in the nomination process on a given requirement. This section describes the predefined values for candidate statuses and status controls. It also describes the related profile options that you must define. Setup of these statuses and profile options is required.

Predefined Candidate Statuses and Status Controls

The following table provides a list of the predefined candidate statuses with suggested next allowable statuses:

<table>
<thead>
<tr>
<th>System Status</th>
<th>User Status</th>
<th>Description</th>
<th>Suggested Next Allowable Statuses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending Review</td>
<td>Pending Review</td>
<td>The candidate is nominated for the requirement and is ready for review.</td>
<td>Suitable</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Under Review</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Declined</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Withdrawn</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Assigned</td>
</tr>
</tbody>
</table>
You can define your own user statuses based on these system statuses, except for the Assigned system status. This system status is reserved for internal processes. Only one status control exists for the candidate statuses:

- Requires Change Reason

Use this status control to require the user to enter a reason for changing the status of a candidate.
Candidate Status Profile Options
You must define the following profile options to enable candidate processing. These profile options are set at the site level only.

PA: Default Starting Candidate Status This profile option defines the default status of all newly nominated candidates, except for system-nominated candidates.

PA: Cancelled Requirement’s Candidate Status This profile option defines the candidate status when a candidate nomination is declined due to requirement cancellation.

PA: Invalid Resource Candidate Status This profile option defines the candidate status when a candidate nomination is declined due to a person ceasing to be a valid resource in the Project Resource Management application.

Understanding the Candidate Score and the Automated Nomination Process
To assist your users in staffing requirements, you can set up an automated search and nomination process to identify and nominate resources as candidates for open requirements automatically. The setup includes definitions for both calculating the candidate score and performing automated searches for candidates. This section describes the candidate score calculations, the automated search and nomination process. Setup of these features is required only if you choose to use this functionality.

Candidate Score Weightings
Candidate scores enable you to define the level of importance of the availability, competencies, and job level of the resource when matched to the specifications of a requirement. These weightings are used to calculate a score for each resource identified by a resource search and for every candidate on your requirements. This score helps you identify the stronger candidates based on the weightings that you have specified. A high score indicates a better match.

The formula for calculating the scoring percentage is as follows:

\[
\frac{([\text{Competence Match}](\text{Competence Match Weighting}) + (\text{Availability Match})(\text{Availability Match Weighting}) + (\text{Job Level Match})(\text{Job Level Match Weighting}))}{\text{[Competence Match Weighting + Availability Match Weighting + Job Level Match Weighting]}}
\]
Users define these weighting values at the requirement level. Default values will appear for the requirement if they have been defined for the project or project template. Users can change these values at any of these levels. The user can also temporarily change these values when performing a resource search.

Automated Search and Nomination Process

This automated search process identifies resources that meet the specified criteria for the requirement, including a minimum candidate score, and nominates those resources as candidates on the requirement. This search is an optional process that you can set up to run on a regular frequency, such as, daily or weekly through the concurrent manager.

All of the requirements for a project are included in the search process if the Enabled Automated Candidate Nomination Requirements check box is selected on the Candidate Score and Search Settings page of the project. However, users can also select or de-select this check box for individual requirements to include or exclude them from being considered in the automated nomination process. If the check box at the project level is not selected, then none of the requirements on that project are included in the automated search process.

Resources are matched against the search criteria defined in the Automated Search and Nomination fields of the requirement. These fields are:

- minimum availability
- organization hierarchy
- starting organization
- country
- minimum candidate score

Then, the resources are matched against the following criteria retrieved from the requirement:

- minimum and maximum job levels
- requirement dates matched to availability dates
- competencies

All matching resources are nominated as candidates for the requirement and assigned a candidate status of System Nominated. If the user does not change this status, the candidate is re-evaluated to determine if a match still exists for the requirement the next time the automated search process is run. The user can prevent a candidate from being reconsidered by the automated search process by
changing the candidate status to any other candidate status. For more information on candidate statuses, refer to the following discussions in this guide:

- "Defining Candidate Statuses and Profile Options" in this chapter
- "Candidate Notification Workflow Extension" in Chapter 13, "Maintaining Your Data"

If you do not enable the automated search process for a project or requirement, or if a requirement is excluded from the automated search, the search process still uses the Automated Search and Nomination values to identify qualified requirements for resources. Resources can nominate themselves as candidates from their Candidacy Lists for these requirements.

**Submitting the PRC: Automated Candidate Search Process**

You can set up this process to run on a scheduled basis using the Concurrent Manager. You can also set up multiple instances of this process to run in parallel. In either case, to benefit the most from this process, you want to run this process frequently to accommodate the addition of new projects and requirements and the fluctuation in resource availability.

**Submitting the Process for a Single Project** To run this process for a single project, complete the following steps:

1. Navigate to the Submit Request screen.
2. Choose Submit > PRC: Automated Candidate Search for a Single Project.
3. Select the project.
4. Specify the number of days to look forward for newly starting requirements, or leave blank to include all requirements.
5. Click Submit.

**Submitting the Process for Multiple Projects** To run this process for a range of projects, complete the following steps:

1. Navigate to the Submit Request screen.
2. Choose Submit > PRC: Automated Candidate Search for a Range of Projects.
3. Enter the project number range, or leave blank to include all projects.
4. Specify the number of days to look forward for newly starting projects, or leave blank to include all projects.
5. Specify the number of days for newly starting requirements, or leave blank to include all requirements.

6. Enter a specific project status, or leave blank to include projects of all statuses.

7. Click Submit.
Defining and Setting Up Advertisement Rules

An advertisement rule is an automated method of controlling the visibility of a requirement to resources and managers of an organization over a period of time. It is a list of actions that are performed when the condition associated with each action is met.

With the advertisement rule functionality, users can perform the following tasks:

- Create and maintain advertisement rules
- Define default advertisement rules at various levels
- Define and maintain advertisement actions on a requirement
- View audit history and current status of an advertisement rule on a requirement
- Replace advertisement rule on a requirement
- Start, pause, or resume an advertisement rule on a requirement
- Reverse advertisement actions on a requirement

This section describes advertisement rules, associated processes, and how to implement this functionality. Setup of the advertisement rules is required only if you choose to use this functionality.

Overview of Advertisement Rules

Advertisement rules enable users to control the staffing, visibility, and escalation of requirements based on actions. For example, users can define actions to specify when and which staffing managers and organizations can view the open requirement and who should be notified if the requirement is not staffed within a specified time.

Advertisement Rule Actions

The action choices are as follows:

- **Publish to All**: Make advertisement visible to all resources, across all organizations on the Staffing Home, Requirement List, and Requirement Search Result pages.

- **Publish to Project Authority**: Make requirement visible to resources with project authority within a specified organization on the Staffing Home, Requirement List, and Requirement Search Result pages.
Defining and Setting Up Advertisement Rules

- **Publish to Organizations**: Make requirement visible to all resources in a specified organization hierarchy on the Staffing Home, Requirement List, and Requirement Search Result pages.

- **Escalate to Next Level**: Make the requirement visible to everyone in the next level in the organization hierarchy. This action is only valid if one of the previously defined actions is Publish to Organizations.

- **Send Email**: Send an e-mail to a specific e-mail address. You can use any external e-mail address. You can also enter multiple e-mail addresses separated by a comma.

- **Send Notification to Person**: Send a notification to a specified person regarding the open requirement.

- **Send Notification to Project Role**: Send a notification to a specified role on the requirement-owning project.

- **Update Staffing Priority**: Update the staffing priority of the requirement to the selected value.

- **Cancel Advertisement**: Remove visibilities of requirement in all pages and searches.

**Advertisement Rule Action Conditions**

Each advertisement rule action has an associated condition. The possible conditions of the advertisement rule actions are:

- Number of days since the advertisement rule has been started for a requirement, or

- Number of days remaining before start of the requirement, or

- Combination of above two conditions

The user can indicate to either begin the advertisement rule automatically upon the requirement creation, or activate the rule later for each requirement. Oracle Project Resource Management evaluates the open requirements that have an advertisement rule with a status of "Started" or "Resumed" and performs all of the actions where the conditions are met. You must schedule this evaluation process using a concurrent process.
Advertisement Rule Statuses
Each advertisement rule on a requirement has a status. Possible statuses are provided in the following table:

<table>
<thead>
<tr>
<th>Advertisement Rule Status</th>
<th>Possible Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Started</td>
<td>■ Start the advertisement rule on the requirement</td>
</tr>
<tr>
<td></td>
<td>■ Assign a resource to fill the requirement</td>
</tr>
<tr>
<td>Started</td>
<td>■ Pause the advertisement rule on the requirement</td>
</tr>
<tr>
<td></td>
<td>■ Assign a resource to fill the requirement</td>
</tr>
<tr>
<td>Paused</td>
<td>■ Resume the advertisement rule on the requirement</td>
</tr>
<tr>
<td></td>
<td>■ Assign a resource to fill the requirement</td>
</tr>
<tr>
<td>Resumed</td>
<td>■ Pause the advertisement rule on the requirement</td>
</tr>
<tr>
<td></td>
<td>■ Assign a resource to fill the requirement</td>
</tr>
<tr>
<td>Closed</td>
<td>None</td>
</tr>
</tbody>
</table>

The default advertisement rule status on the requirement can be either "Not Started" or "Started". When the requirement is staffed, the advertisement rule status becomes "Closed". Users can change the status by performing different actions such as start, pause, or resume the advertisement rule on the requirement. All actions are recorded in the audit history.

Project Staffing Owner
A predefined role call Project Staffing Owner exists to identify the primary contact for advertisements of the requirements of a given project. This role has predefined security functions and is an optional assignment for every project.

This role differs from the Staffing Manager role because a staffing manager is responsible for staffing requirements on projects across organizations. For more information, see Chapter 5, "Configuring Your Organization Security"
Advertisement Rule Processes

This section describes the various process flows of the advertisement rules.

Obtaining a Default Advertisement Rule

Users can set advertisement rules at various levels. The value defined at each level becomes the default value for the next subsequent level. The levels and the default sequence is as follows:

1. Implementation Options
2. Project Template
3. Project
4. Requirement

You set the overall default advertisement rule in the Implementation Options. When a user creates a project template, the project template retrieves the advertisement rule from the Implementation Options. When a user creates a project, the project advertisement rule is copied from either the project template or from the original project from which the new project is being copied. Any new requirements added to the project also adopt the project advertisement rule.

The user can override the default advertisement rule at any of the levels from the project template to the requirement. In addition, the user can modify the actions of the advertisement rule on individual requirements without affecting the original default advertisement rule.

Processing Advertisement Actions

An advertisement rule action on a requirement is performed only if the associated condition is met and the advertisement rule status is "Started" or "Resumed". The associated condition for advertisement actions is validated in the following three methods:

- Concurrent Process
  
  The concurrent process, PRC: Perform Action Rules, set at regular frequency performs the advertisement actions of the open requirements that have met the associated condition.

- Online update
  
  The associated conditions of the actions on a requirement are re-evaluated online if the start date of the requirement is changed or, if the advertisement
rule on the requirement is updated. The qualified actions are performed if the advertisement rule status is "Started" or "Resumed".

- Advertisement Rule is Started or Resumed

When a requirement advertisement rule is first activated or resumed, the system validates the advertisement actions to check if they meet the associated condition. The qualifying actions are performed.

Reversing Advertisement Rule Actions

Advertisement rule actions that have been already completed for a requirement can be reversed by one of the following methods:

- deleting the individual advertisement action from a requirement
- using the Cancel Advertisement Rule action to cancel all advertisement rule actions of the requirement
- replacing the entire advertisement rule on a requirement with a new advertisement rule

The following table describes the result of reversing each action.

<table>
<thead>
<tr>
<th>Action</th>
<th>Result of Action Reversal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publish to All</td>
<td>Resources of all organizations can no longer view the requirement</td>
</tr>
<tr>
<td>Publish to Project Authority</td>
<td>Users with project authority of the organization can no longer view the requirement</td>
</tr>
<tr>
<td>Publish to Organizations</td>
<td>Resources of the organizations can no longer view the requirement</td>
</tr>
<tr>
<td>Escalate to Next Level</td>
<td>Resources of the organizations can no longer view the requirement</td>
</tr>
<tr>
<td>Update Staffing Priority</td>
<td>This action cannot be reversed</td>
</tr>
<tr>
<td>Send Email</td>
<td>An email is sent to the individuals and distribution lists informing them that the requirement is no longer available</td>
</tr>
<tr>
<td>Send Notification to Person</td>
<td>A notification is sent to the individuals informing them that the requirement is no longer available</td>
</tr>
<tr>
<td>Send Notification to Project Role</td>
<td>A notification is sent to the project roles informing them that the requirement is no longer available</td>
</tr>
</tbody>
</table>
Replacing an Advertisement Rule

Users can replace an advertisement rule on an open requirement by selecting a different rule. All the previously performed actions on the requirement are reversed and the actions on the new rule are performed if the associated conditions are met. All changes are recorded in the advertisement audit history for the requirement.

Auditing Advertisement Rule Activities

As the system performs advertisement actions for a requirement, the details and the date of the actions are recorded in an audit history. This report lists all of the advertisement activities and the related details on the requirement. For example, when an action is activated, an audit record is created. This record provides a list of the names of staffing managers, organization names and email addresses to whom the requirement has been advertised and the date when the requirement was made visible.

Implementing Advertisement Rule Functionality

One predefined advertisement rule called “Publish to Everyone” comes with your installation of Oracle Project Resource Management. This system default rule contains one action, Publish to All, and cannot be modified or deleted. This rule publishes the requirements to everyone beginning on the creation date of the requirement. If you do not want to use the advertisement rule functionality, you do not have to set up or change anything. In this case, users should leave the Start Advertisement Rule check box selected for each requirement. If a user de-selects this check box, then the requirement will not be visible in any requirement searches or Requirement List pages.

If you want to implement and utilize the advertisement functionality, you must define your own rules and set them up accordingly. This section describes the required setup steps in more detail.
Defining Advertisement Rules
To create advertisement rules, complete the following steps:

1. Using the Project Super User authority, select Advertisement Rules from the main portal page.
2. Click Create Advertisement Rule.
3. Enter the name, description, and effective dates and click Add Action.
4. Enter action and condition information and click Apply. After you enter and save the action, the Create Advertisement Rule page appears with the updated information.
5. Repeat step #4 for each action you want to define for this advertisement rule.
6. When you are finished entering all actions, click Apply on the Create Advertisement Rule page to save the entire advertisement rule.

Specifying the Default Advertisement Rule
After you define your advertisement rules, you can specify the default rule on the Staffing tab in system Implementation Options window. For information on the full defaulting process, see "Obtaining a Default Advertisement Rule" in this chapter.

Submitting the PRC: Perform Action Rules Process
The PRC: Perform Action Rules process evaluates the action conditions for each action on a scheduled basis. If a condition is valid, then the process activates the related action.

This process applies to all types of action rules. However, you can specify to run this process for only advertisement rule actions. Only advertisement rule actions for open requirements with an advertisement rule status of "Started" or "Resumed" are processed.

To schedule this process, navigate to the Submit Request screen, select whether to run this process for a single project or a range of projects, and complete the parameters.
Defining Assignments Statuses and Profile Options

Each assignment has a status that indicates the state of the assignment in the staffing life cycle. This section describes the predefined values for assignment statuses and status controls. It also describes the related profile options that you must define. Setup of these statuses and profile options is required.

Predefined Assignment Schedule Statuses and Status Controls

The assignment schedule status is the daily assignment status. Therefore, each day of the assignment has its own schedule status. The following table provides a list of predefined assignment schedule system statuses with suggested next allowable statuses:

<table>
<thead>
<tr>
<th>System Status</th>
<th>User Status</th>
<th>Description</th>
<th>Suggested Next Allowable Statuses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provisional</td>
<td>Provisional</td>
<td>A resource is assigned to the assignment on a provisional basis.</td>
<td>■ Confirmed  ■ Cancelled</td>
</tr>
<tr>
<td>Confirmed</td>
<td>Confirmed</td>
<td>The resource is confirmed and scheduled for the assignment.</td>
<td>■ Cancelled</td>
</tr>
<tr>
<td>Cancelled</td>
<td>Cancelled</td>
<td>The assignment was cancelled.</td>
<td>None</td>
</tr>
</tbody>
</table>

Only one status control exists for the assignment statuses:

■ Include in Project Forecasts

Use this status control to include assignments in project forecasts based on the status.

Predefined Assignment Approval Statuses

Assignment approval statuses are used by workflow processes. This status represents the approval status for the entire assignment. You cannot add, modify, or delete these statuses. In addition, users cannot manually change these statuses. The status is applied to an assignment based on the action being undertaken.

The following table provides a list of the predefined assignment approval statuses with their associated next allowable status:
Defining Assignments Statuses and Profile Options

Assignments Statuses

<table>
<thead>
<tr>
<th>System Status</th>
<th>Description</th>
<th>Next Allowable Statuses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working</td>
<td>The assignment is new and has not yet been submitted, or the assignment has been changed and is waiting to be resubmitted for approval.</td>
<td>Submitted</td>
</tr>
<tr>
<td>Submitted</td>
<td>The assignment is submitted for approval. Approval can be sought either manually or through an automated workflow process.</td>
<td>Approved, Rejected</td>
</tr>
<tr>
<td>Approved</td>
<td>The assignment is approved and the resource is confirmed.</td>
<td>Requires Resubmission</td>
</tr>
<tr>
<td>Cancelled</td>
<td>The assignment is cancelled.</td>
<td>None</td>
</tr>
<tr>
<td>Rejected</td>
<td>The assignment is rejected. The user can choose to modify the assignment and resubmit it for approval.</td>
<td>Requires Resubmission</td>
</tr>
<tr>
<td>Requires Resubmission</td>
<td>The assignment has been changed and requires a resubmission for approval.</td>
<td>Submitted</td>
</tr>
</tbody>
</table>

Assignment Status Profile Options

You must define the following profile options to set the status defaults for the assignments. Each profile option is set at the site level only.

**PA: Starting Assignment Status**

This profile option defines the default status of newly created assignments.

**PA: Default Cancelled Assignment Status**

This profile option defines the status of cancelled assignments.
Defined calendars are the basis of all schedules for resources, requirements, and assignments. You establish resource schedules based on the calendar assigned to the resource. You can assign a calendar to a resource, or accept the default calendar from the site, organization, or project.

This chapter provides information creating calendars and maintaining schedules through the following topics:

- Setting Up Calendars
- Establishing the Availability and Overcommitment Calculations
Setting Up Calendars

A calendar provides basic information such as working days, non-working days, and holidays. When a resource is assigned to a specific calendar, that calendar represents the capacity of the resource. Assignments using these calendars provide information such as the scheduled days for the assignment, and determine the availability of the resource.

You can set up an unlimited number of calendars to meet your various scheduling challenges. For example, you may have certain people that work specific days of the week. Therefore, you would create a calendar for each unique work pattern arrangement.

Creating Calendars and Defining Calendar Attributes

You must create a calendar in order to establish the schedule work patterns of your resources. These work patterns determine the availability of a resource for project assignments and scheduling. You can create an unlimited number of calendars to define the work patterns, but you must define at least one.

In order to create a complete calendar, you must first define the following calendar attributes:

- calendar types
- shifts and shift patterns
- calendar exceptions

After defining these attributes, you can create calendars.

Defining Calendar Types

Calendar types enable you to classify your calendars. For example, you may have a calendar type of "Part Time" to which you assign to all calendars that are defined with part time shifts.

To create a calendar type, complete the following steps:

1. Select Setup > Schedule Management > Scheduling Calendar > Define Calendar.
2. Select the Define Calendar Type tab.
3. Enter a code for the calendar type in the New Code field.
4. Enter a meaningful description in the Description field.
5. Enter dates in the From Effective Date and To Effective Date fields, if applicable. You can now use this new calendar type to create a calendar.

**Defining Shift and Shift Patterns**
Shifts define the daily work hours in a week and are defined for a given range of dates. The effective dates of the shift or shift pattern override any other preset effective dates when used on a schedule.

For example, if a shift or shift pattern is not effective for the period or part of the period for which requirement or assignment schedules are created, then the schedule is not created for that period.

To create shifts and shift patterns, complete the following steps:
1. Select Setup > Schedule Management > Scheduling Calendar > Define Calendar.
2. Select the Define Shifts tab.
3. Enter the name of the shift.
4. Enter the shift description.
5. Enter the effective dates of the shift.

To create shift patterns:
1. Select the desired weekdays.
2. Enter the From and To time range.
3. Enter the effective dates.

Only the total hours for the day are considered for Oracle Project Resource Management. The specific time values do not have any effect.

**Note:** A day with zero hours specified in the shift is considered a non-working day.
Creating Calendar Exceptions

Exceptions define holidays and are considered non-working days.

To create calendar exceptions, complete the following steps:

1. Select Setup > Schedule Management > Scheduling Calendar > Define Calendar.
2. Select the Calendar Exceptions tab.
3. Complete the fields as necessary for the specific calendar exception.

You must create calendar exceptions for public holidays and general holidays for every year that they occur. For all other types of exceptions, make administrative assignments. As described for shifts, only the total number of hours are considered for Oracle Project Resource Management, not the actual time segments.

Creating a Calendar

To create a calendar, complete the following steps:

1. Select Setup > Schedule Management > Scheduling Calendar > Define Calendar.
2. Select the Define Calendar tab.
3. Complete the required information for the calendar.

Assigning Shifts and Exceptions to Calendar

To assign shifts and exceptions to a calendar, complete the following steps:

1. Select Setup > Schedule Management > Scheduling Calendar > Define Calendar > Calendar Shift/Exceptions.
2. Select the desired calendar.
3. Use the Shifts Tab to assign Shifts to the calendar.
4. Use the Exceptions Tab to assign Exceptions to the calendar.

Changing the Calendar

Any changes to the calendar are applied to the schedule work patterns by a periodic process. The changes to calendar will affect the future schedule creations and updates. For more information, see "Updating Schedules with Calendar Changes" in Chapter 13, "Maintaining Your Data".
Establishing Default Calendars

You can set up default calendars at two levels:

- the site level
- the organization level

Defining the Default Calendar for the Site

You can select any defined calendar as the default calendar at the site level using the PA: Default Calendar profile option in Oracle Project Resource Management.

This profile option indicates the default calendar for projects, project assignments, and resources in the Oracle Project Resource Management application. You can only update this profile option at the site level.

Defining Default Calendars for Organizations

The calendar assignment at the organization level overrides the calendar assignment at the system site level. You can set up a calendar for a project organization using the Define Organization form in the Additional Information section for the project Expenditure/Event organization classification. This calendar becomes the default calendar for all resources within the organization.

Assigning Calendars

The default calendars you specify for the site and organizations carry down to the projects and resources. You can override these defaults by assigning a calendar directly to the project or resource.

Assigning Calendars to Projects

Assigning a calendar to a project overrides the default calendar retrieved from the project organization or site. To modify the default calendar on a project, use the Project Details page.

Assigning Calendars to Resources

Every resource must have an associated calendar for scheduling purposes. The calendar determines the capacity of the resource. During implementation, you use a process called PRC: Maintain Project Resources to pull the resources from HR tables into Oracle Project Resource Management. This process assigns all resources a default calendar. For more information on this process, see "Maintaining Schedules" in Chapter 13, "Maintaining Your Data".
The default calendar for the resource can come from various sources depending upon how you have set up your system. Oracle Project Resource Management uses the calendar defined for a resource in CRM. If the resource does not have a defined calendar in CRM, the calendar for the resource defaults from the organization. If you do not define a default calendar for the organization, then the calendar for the resource defaults to the entry in the Calendar profile for the site. You can override all these defaults at any time and assign a specific calendar to a resource.

To assign a default calendar to the resource, complete the following steps:

1. Select Setup > Schedule Management > Scheduling Calendar > Define Calendar.
2. Select the Assign Resources tab.
3. Complete the required information on the screen.
Establishing the Availability and Overcommitment Calculations

Availability is the unassigned time of a resource within the capacity boundaries of the resource. Overcommitment occurs when the confirmed and scheduled hours of a resource exceed the capacity of that resource.

This section describes the calculations and profile options used to determine the availability and overcommitment for the resource schedules.

Overview of the Availability Calculation

You determine availability of a resource by subtracting the confirmed scheduled hours of the resource from the capacity hours of the resource. The calendar to which the resource is assigned determines the capacity hours of the resource.

Oracle Project Resource Management calculates future resource availability based on a predefined number of years. You set the number of years for the availability calculation in a profile option called PA: Availability Duration. Availability records are created from today’s date through to the end of the time period you specify using this profile option. For example, if you enter 2 as the value of this profile option, the availability of your resources is calculated from today to the end of two years. The PA: Availability Calculation Period profile option determines whether the availability hours for each resource is built daily or weekly. For more information, refer to "Defining Availability and Overcommitment Profile Options".

Resource availability is recalculated every time a new assignment for a resource is made. Therefore, using the above example, if you make an assignment on a resource until the end of April, the availability is recalculated to move out for two years from the end of April.

If you create an assignment for a resource outside of the availability period, such as 10 years in the future, the availability is not recalculated because it is outside of the range defined in the above profile option. If this is a real assignment, then you must break it up into segments of two years or change the profile option to be set to 10 years or greater.

Setup Requirements for the Availability Calculation

The availability calculation looks for defined GL Periods and PA Periods, as well as defined Forecasting Options.

Defining GL Periods and PA Periods for Availability Purposes In order for the availability of a resource to be calculated, you must have both GL Periods and PA Periods defined for the availability duration. Since the availability of a resource is
recalculated every time an assignment is added, this can be a moving target. Therefore, a suggested formula for determining how far in advance to set up these periods is to double the value you have entered for the PA: Availability Duration profile option. For example, if you have defined this profile option with a value of 2 (for 2 years), then define GL and PA Periods for 4 years out.

The first time you run the PRC: Maintain Project Resources process to pull in your resources, if you have resources that have a start date prior to the system date, the resource availability will be calculated one year prior to the current system date. This availability is used solely for timeline displays for the prior year. These displays are useful if you are converting and tracking assignments that started in the previous year. GL Periods and PA Periods must be established for this prior year. If these periods are not defined, then any resource with an HR assignment start date earlier than the current system date will not be considered a valid resource in Project Resource Management.

**Defining Forecast Options for Scheduling Purposes** The forecast options must be defined for each operating unit. These forecast options define your preferences on handling resource utilization and financial forecasting. Some of this information is also used for calculating resource availability. For more information, refer to "Defining Forecasting Options" in Chapter 10, "Implementing Financial Forecasting".

---

**Overview of the Overcommitment Calculation**

A resource is considered overcommitted based on how the overcommitment is calculated. Two profile options affect this calculation:

- **PA: Overcommitment Percentage**
- **PA: Availability/Overcommitment Calculation Period**

The PA: Overcommitment Percentage specifies the maximum tolerance of overcommitment. Therefore, if you set this profile option to 10, then you are indicating that resources will not be considered overcommitted until their confirmed scheduled and confirmed assignment hours exceed their capacity hours by 10% or more. For example, you set this profile option to 10. If a resource has a capacity of 40 hours per week, then the overcommitment tolerance is 4 hours (40 hours X 10% = 4 hours). Any overcommitment beyond this number of hours qualifies the resource to be flagged as an overcommitted resource. Therefore, the resource will be considered overcommitted if the scheduled confirmed hours for this resource exceeds 44 hours for any one week.

The PA: Availability/Overcommitment Calculation Period determines whether the overcommitment is calculated on a daily basis or a weekly basis. For example, if
you set this profile option to Daily, then the number of confirmed hours and the number of capacity hours are compared for each day for each resource. If the number of confirmed hours for the day exceed the number of capacity hours for the day by more than the tolerated percentage, then the resource is marked as overcommitted for that day.

If you set this profile option to Weekly, the calculation will perform this comparison to identify any overcommitment on a weekly basis. However, using the Weekly setting, a resource can still have overcommitment on a daily basis and not get marked as overcommitted as long as the resource is not overcommitted for the entire week. For example, if the capacity for a resource is 40 hours and the resource has 30 confirmed hours dispersed over 2 days for a given week, this resource is marked as overcommitted using the daily basis, but not for the weekly basis.

The overcommitment calculation uses the start date of the assignment to evaluate overcommitment. Therefore, even though the resource has 40 hours of capacity for a given week and an assignment is scheduled for that week for 40 hours, the distribution of those hours can still cause an overcommitment. For example, an assignment begins on Tuesday and has a work pattern in the first week as illustrated in the following table:

<table>
<thead>
<tr>
<th></th>
<th>Sun</th>
<th>Mon</th>
<th>Tues</th>
<th>Wed</th>
<th>Thur</th>
<th>Fri</th>
<th>Sat</th>
</tr>
</thead>
<tbody>
<tr>
<td>Availability</td>
<td>0</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>0</td>
</tr>
<tr>
<td>Assignment</td>
<td>0</td>
<td>0</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>8</td>
</tr>
</tbody>
</table>

The capacity hours of the resource for the week are calculated from the assignment start date. In this example, the capacity hours begin from Tuesday and end on Friday equaling 32 hours. Since the assignment has 40 hours distributed for this week, the resource is considered overcommitted. This overcommitment can be corrected either by changing the assignment start date to the Monday, or redistributing the extra 8 hours to another week with availability.

As each resource is evaluated, any assignment causing an overcommitment is flagged. Users with the appropriate authority can remove or change conflicting assignments.

**Defining Availability and Overcommitment Profile Options**

Define the following profile options to establish how availability is calculated and how both availability and overcommitment will appear on your resource timelines:
Establishing the Availability and Overcommitment Calculations

- **PA: Availability/Overcommitment Calculation Period**
  This profile option enables you to determine the time period segment to use in calculating the availability. Valid choices are Daily or Weekly, and the default value is Weekly.

- **PA: Availability Duration**
  This profile option determines the length of time (in years) for which the application should create timeline availability records. The availability for a resource is recalculated every time a new assignment is created for the resource. The default value for this profile option is 2.

- **PA: Percentage of Resource’s Capacity**
  This profile option specifies the lowest percentage threshold in determining availability. The default value is 100.

- **PA: Overcommitment Percentage**
  This profile option specifies the minimum percentage to exceed capacity before considered overcommitted. Default value is 0.
Defining the Project Environment

The definition of your project environment includes the setup of all the attributes used for creating projects, tracking pipeline projects, and staffing project roles. It also includes the implementation of your approval and notification processes defined through automated Oracle Workflow processes. You define these features using Oracle Projects, Oracle Project Resource Management, and Oracle Workflow.

This chapter elaborates on the definition and usage of these attributes through the following sections:

- Creating Project Attributes
- Establishing Probability Information
- Setting Up the Predefined Project Status Controls
- Setting Up Your Self-Service Environment
Creating Project Attributes

In creating a project, your users will use a variety of attributes to define the behavior and future processing of the project. To define the following attributes, you use the Oracle Projects windows:

- work types
- class categories
- class codes
- project statuses
- project types
- project templates
- service types
- customer contact types
- customer relationship codes
- customers and customer addresses
- billing schedules
- pipeline information

This list is a subset of the required project attributes. For a complete list, refer to Appendix A, "Implementation Steps Checklist". For information on defining work types, refer to Chapter 11, "Implementing Resource Utilization".


**Note:** You must set up customers in Oracle Projects (or in Oracle Accounts Receivables) in order to assign them to projects.
Establishing Probability Information

When defining a potential project, you can enter pipeline information such as the probability percentage of winning the project, the project value, and the expected approval date. This information is used for calculations such as determining the weighted (discounted) value of all projects in your pipeline. If a project has no defined probability percentage, then it is assumed to be 100% for all calculations performed on the project.

You have control over how percentage values are used on a project through the creation of Probability Lists. The probability list is a list of percentages with descriptions. For example, you create a list called "Quarters" with the following percentages:

- 25% Talks Initiated
- 50% Negotiation
- 75% Contract Proposed
- 100% Approved

You can attach this list to any project type. When you create a project and using a particular project type, these are the values available for selection in the Probability field.

For more information and setup instructions, see the Oracle Projects 11i Release 11.5.3/Mini Pack B User Guide Supplement.

Setting Up the Predefined Project Status Controls

The predefined project statuses are:

- Unapproved
- Submitted
- Approved
- Pending Close
- Closed

These project statuses are described in detail in the Oracle Projects User Guide.
The Oracle Project Resource Management application introduces the following status controls for these statuses:

- **Change Project Probability**
  You can change the probability of the project when this status control is enabled.

- **Allow Provisional Assignments**
  You can create provisional assignments on a project when this status control is enabled.

- **Allow Confirmed Assignments**
  You can create confirmed assignments on a project when this status control is enabled.

The project status controls enable you to define specific restrictions or allow certain actions to occur when a status is applied to a project. The following table lists these controls and indicates whether or not the status control is enabled for each status. You can change these defaults to meet your business needs.

<table>
<thead>
<tr>
<th>Status Control</th>
<th>Unapproved</th>
<th>Submitted</th>
<th>Approved</th>
<th>Pending Close</th>
<th>Closed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Project Probability</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Allow Provisional Assignment</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Allow Confirmed Assignments</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>N</td>
</tr>
</tbody>
</table>

For more information on project status values and status setup instructions, refer to the *Oracle Projects User Guide* and the *Oracle Projects 11i Release 11.5.3/Mini Pack B User Guide Supplement*. For more information on how the workflow processes use the statuses, refer to Chapter 14, "Overview of the Predefined Workflows".

**Note:** Statuses are available for your entire enterprise, and are not specific to any business group or operating unit.
Setting Up Your Self-Service Environment

You can set up your self-service environment to accommodate your business needs and the needs of your users. For complete instructions, refer to the Oracle Self-Service Web Applications Implementation Manual.

This section discusses the following topics:
- Self-Service Web Applications Profile Options
- Configuring the Project Home Page
- Enabling Project Shortcut Links
- Configuring Table Views

Self-Service Web Applications Profile Options

The following table lists the required Self-Service Web Applications profile options for the home page setup:

<table>
<thead>
<tr>
<th>Profile Option</th>
<th>Description</th>
<th>Value</th>
<th>Example Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ICX: Language</td>
<td>Determines the default language</td>
<td>Language</td>
<td>American English</td>
</tr>
<tr>
<td>ICX: Date language</td>
<td>Determines the default language in which dates are displayed.</td>
<td>Language</td>
<td>American English</td>
</tr>
<tr>
<td>ICX: Date format mask</td>
<td>Determines the date format mask to use</td>
<td>Date Format Mask</td>
<td>The American English default is DD-MON-YYYY; for example, 12-NOV-1997</td>
</tr>
<tr>
<td>ICX: Numeric characters</td>
<td>Determines the characters to use to delimit numbers</td>
<td>.</td>
<td>.</td>
</tr>
<tr>
<td>ICX: Territory</td>
<td>Geographical area</td>
<td>Geographical area</td>
<td>America</td>
</tr>
</tbody>
</table>
Configuring the Project Home Page

You can configure the layout of the Project Home page to display specific information in a specified order. This functionality enables your project managers to provide a higher level of direction and focus to their team members. The team members see only the information they need, organized in order of importance.

Sections of information compose the home page. You can choose the sections you want to appear and the order in which they should display. The home page layouts also include shortcut links to useful pages within the application for the specific project. You can specify project shortcut links you want on your project home page layouts. For more information, see "Enabling Project Shortcut Links" in this chapter.

To create a project home page layout:

1. From the Project Super User responsibility, click Page Layout Setup menu option.
2. Select Project Home in the Create Page Layout selection list and click Go.
3. On the Create Page Layout page, enter the information for your new layout.
4. Click Update Sections List to add the desired sections for both the right and left sections of the page.
5. Click Apply.

You can create multiple configurations of the Project Home page, however, you can only use one configuration per project.

**Specifying the Project Header Section**

The project header section is the basic information that appears on the various project pages. Two predefined header sections are available:

- **Default Project Header**: Displays the organization, project manager, project type, status, start date, and completion date
- **Project Header with Customer and Project Value**: Displays all information in Default Project Header and the customer and project value

For each project, the project manager can select the header information for the project pages and the project home page layout through the Page Layout page available under the Project tab > Setup subtab.

**Enabling Project Shortcut Links**

Using standard menu functionality in the System Administrator responsibility, you can define a variety of shortcut menus using the Menus window. By tying together submenus, you can create a hierarchical shortcut menu with a maximum of three levels. The lowest level menu is always the shortcut link.

**Note**: For detailed information about the operation of the Menus window, see the *Oracle Applications System Administrator’s Guide*.

Shortcut links are composed of user functions, and therefore, the links are subject to role-based security enabling you to control link access based on defined role of a user on any given project. For example, you can make the Add Team Members link visible only to project managers and other users whose role includes the ability to perform this function. In addition, certain links are subject to product licensing and are not available to organizations that have not licensed Oracle Project Resource Management.
Predefined Shortcut Links
Oracle Projects includes eight link options from which you can select to include in the shortcut menu. Six of these are included in the default project shortcuts menu.

Project Shortcut Links The following tables lists the predefined project shortcut links and related information:

<table>
<thead>
<tr>
<th>Shortcut Link</th>
<th>Page Name</th>
<th>User Function Name</th>
<th>Included in Default Shortcut Menu</th>
<th>Project Resource Management Only</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Team Members</td>
<td>Add Team Members</td>
<td>Projects: Options: Key Members</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>View Classifications</td>
<td>Classifications</td>
<td>Projects: Options: Classifications</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>View Customers</td>
<td>Customer Details</td>
<td>Projects: Options: Customers and Contacts</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

Resource Shortcut Links The following tables lists the predefined resource shortcut links and related information:

<table>
<thead>
<tr>
<th>Shortcut Link</th>
<th>Page Name</th>
<th>User Function Name</th>
<th>Included in Default Shortcut Menu</th>
<th>Project Resource Management Only</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Requirements</td>
<td>Add Requirements</td>
<td>Add Requirements</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Add Assignments</td>
<td>Add Assignments</td>
<td>Add Assignments</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>View Staffing Information</td>
<td>Staffing Information</td>
<td>Projects: Options: Staffing Information</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Apply Team Template</td>
<td>Apply Team Template</td>
<td>Apply Team Template</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Reporting Shortcut Links The following tables lists the predefined reporting shortcut link and related information:
Configuring Table Views

The Oracle Applications Personalization Framework is available for all applications built using the Oracle Applications Framework technology. The Personalization Framework enables administrators and users to configure regions of the user interface through a self-service tool without making any changes to underlying code. Therefore, these changes do not impact your ability to upgrade to future versions of the application.

<table>
<thead>
<tr>
<th>Shortcut Link</th>
<th>Page Name</th>
<th>User Function Name</th>
<th>Included in Default Shortcut Menu</th>
<th>Project Resource Management Only</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintain Status Reports</td>
<td>Maintain Status Reports</td>
<td>Projects: Project Status Reports: Edit</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

Note: A restart of the JVM is not required for configurations to take effect.

The Personalization Framework provides several levels of configuration. A defined administrative user can configure the application Web pages as applicable to Project Resource Management at the following levels:

- Localization
- Site
- Organization
- Responsibility

Most tables have one or more views predefined in the initial implementation. Individual users can copy these views and use them as their default views. Users can also create their own views. Such views are only available to their own respective login sessions, and cannot be viewed by other users.

For more information on Oracle Applications Personalization Framework, refer to OA Customization Framework, CR: 282233 available under ERP Oracle Applications Technology Stack on Oracle MetaLink.
Oracle Project Resource Management can produce financial forecasts for your projects based on existing staffing plans. This self-service financial forecast functionality enables you to:

- perform forecasts based on single or multiple projects
- drill down to find out the distribution of the forecast totals
- regenerate forecasts on adjusted staffing plans

This chapter describes how to set up the required elements for performing forecasting activities through the following topics:

- Overview of the Financial Forecast Process and Calculations
- Implementing the Forecast Functionality
- Establishing Security on Forecast Functionality
Overview of the Financial Forecast Process and Calculations

Oracle Project Resource Management provides a financial forecast process that performs calculations based on your predefined bill and cost rates. These rates are evaluated within the time frame of the assignments and requirements and the scheduled work patterns to provide you forecast totals. Predefined bill rates can be overridden by the user for individual requirements and assignments. This section describes the process and calculations used to generate these forecast totals.

Financial Forecast Process

When you invoke the action to generate a forecast, the process evaluates for the project the daily hours of the staffed labor (assignments) and open requirements. The daily hours of the assignments and requirements are summarized based on the time period (GL Period or PA Period) for the life of the project.

These totals are used to derive your total estimated cost, revenue, margin, and margin percentage for the project. For requirements, the forecast cost and bill rates are obtained from the job assigned to the role in Project Resource Management. For assignments, this information is obtained directly from the assigned employee. Employee and job level bill rates can be overridden by bill rates defined for the requirement or assignment.

After the forecast generation completes, a notification is sent to the user who invoked the process. This notification indicates whether or not the forecast totals were generated successfully. On the Project Forecast page, an indicator appears next to the role or project for which errors on forecast items occurred. A link to the forecast error page is provided on the Project Forecast page. This page provides an explanation of the errors encountered for each assignment or requirement for the project. The user can regenerate the forecast after the errors have been corrected.

Note: The generation of forecast totals is handled through deferred Oracle Workflow processes. As the volume of the forecast items can be large, these processes can require a substantial amount of time to complete the processing of forecast items. You can increase the processing performance by creating additional background process dedicated only to processing the forecast items. For more information, see "Understanding Data Processing" in Chapter 13, "Maintaining Your Data".
Overview of the Financial Forecast Process and Calculations

Forecast Calculations

Each forecast page provides totals for labor hours, cost, revenue, margin, and margin percentage. These totals can vary depending upon how you implement the forecast options. Therefore, it is helpful to review the calculations for each of these totals to assist you with making your implementation decisions.

The calculations used to derive the forecast totals are as follows:

- **Hours** = The number of hours for each requirement or assignment in the Project Resource Management staffing plan, by role and period.

- **Cost** = The labor raw cost represents for each role the cost of the requirements and assignments.

  The cost rates for assignments are based on the employee cost rates. The cost rates for requirements are based on the cost rate of the job associated with the role of the requirement.

  The burden schedule for the project is applied to the raw cost rates to provide the burdened costs that are reflected in the forecast. The formula to derive the cost rate is as follows:

  - **Average Cost Rate** = Total Burdened Cost / Total Hours

    This amount appears in the Average Rate column when you select Cost as the Show Amount.

- **Margin** = Revenue - Cost

  Margin is calculated at the same level as Revenue for each project.

- **Margin %** = [ (Revenue - Cost) / Revenue ] * 100%

  Margin % is calculated at the same level as Revenue for each project.

Calculating Revenue

Revenue is calculated differently based on the revenue distribution rule assigned to your projects. Using the work-based distribution rule, the revenue for time and material projects is calculated by role. Using the cost and event-based distribution rules, the revenue for fixed-price projects appears as one line for the entire project. The formulas for generating the displayed totals are provided below grouped by the distribution rules.

The following sections describe the calculations for each revenue distribution rule. For more information regarding revenue distribution rules, see the Oracle Projects User Guide.
Revenue Calculation for Projects Using Work-Based Distribution Rule  For projects with a work-based distribution rule, the revenue is calculated as follows:

- **Revenue** = Hours * Bill Rate

You can enter a bill rate for requirements and assignments individually on the Requirements and Assignments Details pages. Otherwise, the bill rate is derived from any project-level bill rate overrides. If no overrides exist, then depending on how you define your project, the bill rate is derived from one of the following schedules:

- **Rate Schedules**
  The rate schedules for both assignments and requirements are retrieved from the associated job. For assignments, the rate schedule is overridden if the assigned employee has a rate in the defined employee-based rate schedule.

- **Burden Schedules**
  If you associate a burden schedule with the project, then it is used to determine the revenue by marking up the cost.

After the bill rate is determined, any defined project-level discount percentages are applied. You can set a project-level discount to any project using the following navigation path from the individual project:

Project Options > Bill Rates and Overrides > Standard Billing Schedules

The rates and discount percentages displayed in forecast pages are derived using the following calculations:

- **Standard Rate** = Job-based bill rate schedule (as of the start of the assignment)
- **Average Rate** = Total Revenue / Total Hours
- **Effective Discount %** = \[ \frac{(Standard Rate - Average Rate)}{Standard rate} \] * 100%

Revenue Calculation for Projects Using Cost-Based Distribution Rule  For projects with a cost-based distribution rule, the revenue is calculated as follows:

- **Revenue (For period X)** = \( \left( \frac{A}{B} \right) \times C - D \)

Where:

- \( X = \) Current Period
- \( A = \) Inception to Period X Total Cost
- \( B = \) Total Project Cost
- \( C = \) Total Project Value
Revenue Calculation for Projects Using Event-Based Distribution Rule  For projects with an event-based distribution rule, the revenue is calculated as follows:

- **Revenue** = Total Project Value

  This total appears in the last period of the project. All other periods of the project reflect a zero dollar value. If the project does not have an end date, then the system uses the last period with an assignment or requirement.

Generating Forecast Information

You can generate forecasts by clicking the Generate Forecast button in the Financial Forecast screen, or by submitting the concurrent process PRC: Generate Project Forecasts.

When you submit the concurrent process, you can generate forecasts for:

- a single project
- a range of projects
- all projects in an organization

To run the concurrent process, complete the following steps:

1. Navigate to the Submit Request screen.
2. Choose Submit > PRC: Generate Project Forecasts.
3. Select the desired project range by specifying From Project and To Project parameters. To select a single project, specify the project for both the From Project and To Project parameters. To run the process for all projects in an organization, leave these parameters blank.
4. Enter the desired organization.
5. Click Submit.
Implementing the Forecast Functionality

In order to generate forecasts totals, you have to define specific information on which the forecasts are based. This section provides details for the following implementation steps to establish the forecast feature:

- Defining a Job-Based Cost Rate Schedule
- Defining Bill Rate Schedules
- Updating Project Types with Employee and Job-Based Bill Rate Schedules
- Defining Forecast-Related Profile Option
- Defining Periods
- Defining Unassigned Time Tracking
- Defining Forecasting Options

As the forecast totals for requirements depend upon the job bill and cost rates of the requirement, each role within Project Resource Management must have a job associated with it.

For more information on defining roles, see "Defining Project Roles" in Chapter 6, "Defining Project Roles". See "Defining Jobs and Job Mapping" in Chapter 3, "Establishing Your Enterprise Structure" for more information regarding jobs.

Defining a Job-Based Cost Rate Schedule

Define a job-based cost rate schedule to enable the generation of forecasts on the cost of staffing requirements. To define this schedule, complete the following steps:

1. Navigate to the Rate Schedules form using the following menu path:
   - Setup > Expenditures > Rate Schedules
2. Enter a schedule name and a description of the schedule.
3. Select the organization that uses the schedule.
   - You can enter any organization from your hierarchy regardless of classification or start and end dates.
4. Select the Job tab.
5. Select the appropriate jobs and enter their rates.
Implementing the Forecast Functionality

6. Save your work.

**Note:** Forecasts must be regenerated to reflect retroactively changed cost rates.

---

**Defining Bill Rate Schedules**

Create a job-based bill rate schedule in Oracle Projects to enable the forecast generation of revenue from staffing requirements. You can include bill rate overrides in your forecasts. If you plan to utilize bill rate overrides, you will establish them as they are needed.

For more information on bill rate overrides, see the *Oracle Projects User Guide*.

**Updating Project Types with Employee and Job-Based Bill Rate Schedules**

For any new project types, manually enter the appropriate job-based bill rate schedule in the remaining field (either Job or employee-based) for each project type.

**Defining Forecast-Related Profile Option**

Define the profile option PA: Forecasting Period Type as either GL Period or PA Period as applicable to your business using the following menu path through the System Administrator responsibility:

Profile > System

This profile option is set only at the site level and determines the period type for which you will generate forecast totals and the number of periods to display on the forecast screens:

- 13 periods for PA Period
- 6 for GL Period

If you ever change the forecasting period type after you create forecasts, you must regenerate all existing forecasts.

**Defining Periods**

In order to create forecast totals for the life of a project, you must define an appropriate number of periods that span the life of your projects. These periods are also necessary to create assignments for time periods in the future. You create these
Implementing the Forecast Functionality

periods through Oracle General Ledger tables and migrate them to Oracle Projects tables.

For more information on defining the time periods, refer to the *Oracle General Ledger User Guide* or the *Oracle Projects User Guide*.

**Defining Unassigned Time Tracking**

Oracle Project Resource Management automatically generates totals for unassigned time for all utilization jobs. The calculation for unassigned time subtracts both provisional and confirmed assignment hours from the total capacity for each available day. Any remaining hours generated from this calculation are assigned to projects specifically implemented for the purpose of tracking unassigned hours.

To define unassigned time tracking projects, complete the following steps:

1. Login as Project Resource Management Super User.
2. Navigate to the Project Type form:
   - Setup > Projects > Project Types
3. Create a project type using the indirect project type class.
4. In the Details window, select the following options:
   - Administrative
   - Unassigned Time
5. Create a project template using the unassigned project type using the following path:
   - Setup > Projects > Project Templates
6. Create a project using the unassigned project template.
   - Projects > Find Projects
   Optionally, you can create two unassigned projects: one for billable jobs and one for non-billable jobs.
7. Complete the options on the Unassigned Time Options tab. For more information, refer to "Unassigned Time Options".

This type of project is used solely for tracking unassigned time for utilization and forecasting calculations. Therefore, users cannot manually add any scheduled roles to this project and the Add Requirement and Add Assignment options are not available for this project.
Implementing the Forecast Functionality

Defining Forecasting Options

The Forecast Implementation Options provide implementation settings used for resource scheduling, resource utilization, and financial forecasting at the operating unit level. You can access these options using the following menu path:

Setup > Forecasting > Options

You have a choice of two tabs: Options and Unassigned Time Options. Complete the options as follows:

1. In the Options tab, select the following options:
   a. Check Include Admin Projects.
   b. Enter a value in Max Historical Versions (suggested starting value: 5).
   c. Enter the desired Utilization Calculation Method (suggested starting entry: By Resource Capacity Hours).
   d. Select at least one period type.
   e. Enter the defaults for the Team Role Forecasting Options.

2. Select the Unassigned Time Options tab.

3. In the Billable People region, check Include in Forecast if you want to summarize billable unassigned time in the financial forecasting reports. If you select this option, enter values for the related fields (Unassigned Time Project, Expenditure Type Class, and Expenditure Type.)

4. In the Non-Billable People region, check Include in Forecast if you want to summarize non-billable unassigned time in the financial forecasting reports. If you select this option, enter values for the related fields (Unassigned Time Project, Expenditure Type Class, and Expenditure Type.)

The following sections provide details on the individual options.

Note: All forecast and unassigned time options must be defined for each operating unit.
**Implementation Options**

The following graphic depicts the Options tab:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Admin Projects</td>
<td>Check to indicate that you want to include administrative projects in project forecast totals. This field is scheduled for future use in the forecasting functionality. Note: Although this option is for future functionality, you must enable this option for this release in order to avoid errors because the application cannot yet exclude administrative projects.</td>
</tr>
</tbody>
</table>
## Implementing the Forecast Functionality

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Max Historical Versions       | Enter the maximum number of historical forecast versions that you want to store. This field is scheduled for future use in the forecasting functionality.  

**Note**: At minimum, you must enter a value of 1.  |
| Utilization Calculation Method| Enter the desired method of calculating your resource utilization. This field is scheduled for future use in the forecasting functionality only and does not have any affect utilization summarization or reporting.  

**Note**: Although this option is for future functionality, a selection is required. Capacity is the recommended selection. |
| Period Type                   | Check the desired period type (GL Period or PA Period) that the forecasting process should use to generate the forecast totals. This field is scheduled for future use in the forecasting functionality. |
| Expenditure Type Class        | Select the Expenditure Type Class to classify the forecast items. |
| Expenditure Type              | Select the desired Expenditure Type to apply to all generated forecast items. |
| Transfer Price Amount Type    | For future use in forecasting functionality |
| Project Role                  | Enter the role to display as the project owner. This value is displayed in the Project Forecast List page.  

**Note**: Defining this value is optional. If you leave this field blank, the Project Owner column is hidden in the Project Forecast List page. |
| Job-Based Cost Rate Schedule  | Select the job-based cost rate schedule to use for assignments. |
| Classification                | Select the classification for which you want to generate forecast totals. You can only select a classification where only one value is allowed. The corresponding class code for each project is displayed in the Project Forecast List page. Only those classifications which are defined as mandatory in the project template appear as choices for this field.  

**Note**: Defining this value is optional. If you leave this field blank, the Classification column is hidden in the Project Forecast List page. |
For more information on expenditure types and project classifications, see Chapter 17, “Oracle Projects Setup and Implementation,” in the Oracle Project User Guide.

**Unassigned Time Options**

The following graphic depicts the Unassigned Time Options tab:

This tab has two regions pertaining to the setup of billable people and non-billable people respectively. The fields are the same for both regions. The following table provides a list of the fields and their descriptions in the order they appear within a region:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include in Forecast</td>
<td>Check to indicate that you want to summarize unassigned time in the project financial forecast totals.</td>
</tr>
<tr>
<td>Unassigned Time Project</td>
<td>Enter the name of the project to which unassigned time should be reported.</td>
</tr>
<tr>
<td>Expenditure Type Class</td>
<td>Enter the expenditure type class with which unassigned time should be associated.</td>
</tr>
</tbody>
</table>
Establishing Security on Forecast Functionality

Users can view forecast hour and revenue totals for any project on which they are active key members. You can provide viewing access to other users as well. Key members and other users with the appropriate authority or security access can also view project cost, margin, and margin percentage totals and generate project forecast totals.

You can establish security for these features and functionality through granting roles cost viewing access, granting forecast authority, and providing functions and menu access.

Granting Cost Viewing Access to Roles

To grant a specific role the ability to view cost, margin, and margin percentage totals, you can check the View Labor Cost checkbox on the Role Types form. To access this form, use the Project Super User responsibility and follow this menu path:

Setup > Project > Role Types

Granting Forecast Authority

You can grant a user forecast authority. This authority provides users the ability to view all projects in an organization through the Multiple Project Forecast List. Users can drill down on a project to view all amounts for hours, cost, revenue, margin and margin percentage. Labor cost authority is assumed for users assigned this authority. You can grant this authority using the following menu path:

Setup > Human Resources > Organization Authority

Business managers are likely candidates for these authority levels. You may grant users these authorities at the organization level.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expenditure Type</td>
<td>Enter the expenditure type with which the unassigned time should be associated.</td>
</tr>
</tbody>
</table>
Granting Forecast Function Access

You can add functions to menus associated with user roles to provide access to forecast functionality. The forecast-related functions are:

- **Project Level View Forecast Security**
  This function provides users the ability to view existing project forecasts.

- **Project Level Edit Forecast Security**
  This function provides users the ability to generate project forecasts.

Typical users of the functionality that these security levels provide are project managers or sales directors. For more information on how to edit menu and function access, see "Understanding Role-Based Security" in Chapter 5, "Configuring Your Organization Security".
Implementing Resource Utilization

The utilization functionality of Oracle Projects and Oracle Project Resource Management enables you to generate actual and forecast totals of your resource utilization. In addition, you can classify your resource hours to calculate utilization percentages for:

- Actual hours based on time card expenditures
- Forecast hours based on schedule assignments

Oracle Project Resource Management generates forecasts for both provisional and confirmed assignments enabling you to distinguish between real work hours and potential work hours. This chapter discusses the business considerations and setup requirements for resource utilization through the following topics:

- Defining Your Utilization Strategy
- Implementing Your Utilization Strategy
- Defining the Utilization Profile Options

**Note:** Implementing Oracle Project Resource Management in standalone mode enables you to generate and report the forecast utilization totals. However, if you want to generate actual utilization totals, you must also implement Oracle Projects Costing. For more information on implementing Oracle Projects Costing, see the *Oracle Projects User Guide*. 
Defining Your Utilization Strategy

Prior to implementing utilization for your enterprise, you should understand how the Oracle Project Resource Management application generates the utilization totals and evaluate what you want these totals to represent. Through these considerations, you must decide:

- which resources should be included for reporting utilization
- what reporting time periods you want to use
- who will have access to the utilization totals
- how resource hours are summarized for reporting purposes

The actual utilization totals are generated for all hours reported through employee timecards. Forecast utilization totals are generated based on provisional and confirmed assignments entered through Oracle Project Resource Management.

The utilization functionality classifies actual and forecast hours by work types which enables you to:

- identify each work type as Billable/Capitalizable or Non-Billable/Non-Capitalizable
- determine if specific non-billable/capitalizable work types will reduce capacity
- define a weighting percentage for each Work Type for all capacity work types

**Note:** Work types defined as Non-Capacity always carry a 0% weighting percentage.

The weighting percentage is applied to resource hours when summarizing those hours for the utilization percentage calculation. Two utilization percentages are calculated for both resource utilization categories and organization utilization categories. The calculation for generating these percentages is as follows:

- **Capacity Method** = \( \frac{\text{sum of weighted hours}}{\text{sum of unweighted capacity hours}} \)
- **Total Worked Hours** = \( \frac{\text{sum of weighted hours}}{\text{total weighted hours}} \)

Capacity hours are the total number of hours for the specified time period based on the resource calendar. Actual calendar capacity is modified by subtracting any recorded hours against the project tasks with non-capacity work types. Forecast
capacity is modified by any forecast hours from assignments with non-capacity work types.

**Utilization Time Periods**

The utilization totals are provided for one or more of the following time periods:

- Global Start Week
- PA Period
- GL Period
- Quarter
- Year

**Understanding the Utilization Views**

Resource hours are summarized into two distinct groups of utilization reporting categories. These category groupings are used to create the following two utilization views:

- **Resource Utilization View**
  
  This view summarizes actual and forecast utilization hours by Resource Utilization Categories. The resource utilization percentage is calculated by dividing the weighted resource utilization category hours by the specified utilization method.

- **Organization Utilization View**
  
  This view summarizes actual and forecast hours by Organization Resource Categories. The organization utilization percentage is calculated by dividing the weighted organization utilization category hours by the specified utilization method.

These utilization views provide you with two distinct managerial views of the work that resources and their organizations have performed or will perform.
Choosing a Utilization Calculation Method

The calculation method you select determines the denominator for the utilization percentage calculation. You have two methods from which to choose: capacity or total worked hours. These calculation methods provide different percentages for the utilization views.

Using the Capacity Calculation Method

This method uses the capacity hours as the denominator for the utilization percentage calculation. The following table describes the calculation of the utilization percentages for each utilization view using this calculation method.

<table>
<thead>
<tr>
<th>Utilization View</th>
<th>Numerator</th>
<th>Denominator</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource</td>
<td>Sum of Resource Utilization from Category</td>
<td>Sum of Capacity for all Resources</td>
<td>Resource View Percentage</td>
</tr>
<tr>
<td></td>
<td>Weighted Hours for all Resources</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Organization</td>
<td>Sum of Organization Utilization from Category</td>
<td>Sum of Capacity for all Resources</td>
<td>Organization View Percentage</td>
</tr>
<tr>
<td></td>
<td>Weighted Hours for all Resources</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Using the Total Worked Hours Calculation Method

This method uses the total number of hours recorded by time cards or scheduled on assignments as the denominator. For actual utilization totals, the total number of hours is calculated from reported timecard hours. For forecast utilization totals, the total number of hours is calculated from scheduled confirmed assignments. Unlike the capacity method, this method includes non-capacity work type hours.

The following table describes the calculation of the utilization percentages for each utilization view using this calculation method.

<table>
<thead>
<tr>
<th>Utilization View</th>
<th>Numerator</th>
<th>Denominator</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Utilization View for a Resource</td>
<td>Resource Utilization Category Weighted Hours by Resource</td>
<td>Total worked hours for a resource</td>
<td>Resource View Percentage by Resource</td>
</tr>
</tbody>
</table>
Understanding the Utilization Reporting

Utilization totals are reported to the following organization roles:

- **Organization Manager**
  
  Organization utilization reports for all resource hours for the selected time period a resource is assigned to the specific organization. The organization manager can view utilization for the entire organization as well as drill down to the utilization of individual resources.

- **Resource Manager**
  
  Resource utilization reports for all resource hours for the selected time period where the resource is currently assigned to the resource manager regardless of organization assignment.

- **Individual Resource**
  
  Resources can monitor their personal performances through viewing all their reported and assigned hours for a selected time period.

You can view utilization totals through the following pages:

- **Organization Utilization**
- **Resource Utilization by Organization Manager**
- **Resource Utilization by Resource Manager**
- **Personal Utilization**

Each page is described in the following sections.
Reviewing the Organization Utilization Page

This page provides utilization totals for an organization based on a specified time period. The calculations for the totals on this page are defined below.

Employees and Others (Summary) The employee headcount includes a count of all utilizable employees (employees with an assigned job that qualifies for utilization calculations) and resource managers assigned to the organization as of the first day in the selected time period (Year, Quarter, PA Period, GL Period, Global Week). Other headcount includes all utilizable non-employees assigned to the organization as of the first day in the selected time period (Year, Quarter, PA Period, GL Period, Global Week).

For the period types of PA Period, GL Period, and Global Week, the number of employees included in the utilization related numbers is the count of employees assigned to the organization for the period.

For the period types of Year and Quarter, the number of employees included in the utilization related numbers is the total as of the beginning of the period plus any new headcount addition.

Employees and Others (Sub-Organization Details) The employee headcount includes a count of all utilizable employees and resource managers assigned to the organization as of the first day in the selected time period (Year, Quarter, PA Period, GL Period, Global Week). Other headcount includes all utilizable non-employees assigned to the organization as of the first day in the selected time period (Year, Quarter, PA Period, GL Period, Global Week).

Actual Capacity (same as Forecast Capacity) This value represents the net available hours for the organization, which is the total available hours minus reduced capacity hours.

The total available hours is derived from the schedule of each resource. This value can be correlated to the values shown in the Staffing Home for each of the resources within the organization.

The reduced capacity hours are summarized from transactions that are logged against a work type which reduces capacity, such as unpaid leave.

Actual Worked This value is a sum of the hours from the reported timecards of all resources within the organization for the specified time period.

Weighted Actual This value represents the sum total of weighted actual hours for the organization. It is calculated by multiplying the total from each timecard with the
weighting percentage of the organization before summing them all up. The weighting percentage is taken from the organization utilization category as defined for the work type associated with each job.

**Actual Utilization (%)** This value represents the Weighted Actual Hours as a gross percentage of Actual Capacity or Actual Worked (depending upon the selected filter on the page.) It is calculated by dividing the actual weighted hours by utilization calculation method (capacity or total worked hours) for the organization and specified time period.

**Forecast Work** This value represents the sum total of scheduled hours for the organization for the specified time period.

**Weighted Forecast** This value represents the sum total of weighted forecast hours for the organization. It is calculated by multiplying the total hours for each forecast item with the weighting percentage of the organization before summing them all up. The weighting percentage is taken from the organization utilization category as defined for the work type associated with each job.

**Forecast Utilization (%)** This value represents the Weighted Forecast Hours as a gross percentage of Forecast Capacity or Forecast Work (depending upon the selected filter for the page.) It is calculated by dividing the total forecast weighted hours by the utilization calculation method (capacity or total worked hours) for the organization and specified time period.

**Reviewing the Resource Utilization by Organization Manager Page**

This page provides utilization totals for all resources under a particular organization manager based on a specified time period. The calculations for the totals on this page are defined below.

**Employees and Others (Summary)** The employee headcount summary includes a count of all utilizable employees and resource managers assigned to the organization as of the first day in the selected time period (PA Period, GL Period, and Global Week).

For the period types of Year and Quarter, the employee headcount summary includes a count of all utilizable employees and resource managers assigned to the organization as of the beginning of the period plus any headcount addition on the first day of each primary period (GL Period).

Other headcount summary includes all utilizable non-employees assigned to the organization as of the first day in the selected time period (PA Period, GL Period,
and Global Week). For the period types of Year and Quarter, other headcount summary includes all utilizable non-employees assigned to the organization as of the beginning of the period plus any headcount addition on the first day of each primary period (GL Period).

**Person Details** This link lists all utilizable employees and managers assigned to the organization as of the first day in the selected time period (PA Period, GL Period, and Global Week). For the period types of Year and Quarter, the list includes a count of all utilizable employees and resource managers assigned to the organization as of the beginning of the period plus any headcount addition on the first day of each primary period (GL Period).

Other headcount summary includes all utilizable non-employees assigned to the organization as of the first day in the selected time period (PA Period, GL Period, and Global Week). For the period types of Year and Quarter, other headcount summary includes all utilizable non-employees assigned to the organization as of the beginning of the period plus any headcount addition on the first day of each primary period (GL Period).

**Reviewing the Resource Utilization by Resource Manager Page**

This page provides utilization totals for all resources under a particular resource manager. The calculations for the totals on this page are defined below.

**Employees and Others** This value is a headcount of all utilizable employees reporting to the manager as of the current system date, including future-date employees. Other headcount summary includes all utilizable non-employees assigned to the manager as of the current system date, including future-dated non-employees.

**Actual Capacity (same as Forecast Capacity)** This value represents the net available hours for the resource (the total available hours minus reduced capacity hours.)

The total available hours is derived from the schedule of each resource. This value can be correlated to the values shown in the Staffing Home for each of the resource within the organization.

The reduced capacity hours are summarized from confirmed assignments that are logged against a work type which reduces capacity, such as unassigned time.

**Actual Worked** This value represents the sum total of actual worked hours for the resource as reported on submitted timecards.
**Defining Your Utilization Strategy**

**Implementing Resource Utilization**

**Weighted Actual**  This value represents the sum total of weighted actual hours for the resource. It is calculated by multiplying the total hours of each timecard with the weighting percentage of the resource before summing them all up. The weighting percentage is taken from the resource utilization category as defined for the work type of the assigned job.

**Actual Utilization (%)**  This value represents the Weighted Hours as a percentage of Actual Capacity or Actual Worked Hours. It is calculated by dividing the Weighted Actual Hours by the utilization calculation method (capacity or total worked hours).

**Forecast Work**  This value is the total number of hours of the forecast items for the resource.

**Weighted Forecast**  This value represents the sum total of weighted forecast hours for the resource. It is calculated by multiplying the total hours for each forecast item by the weighting percentage for the resource before summing them all up. The weighting percentage is taken from the resource utilization category as defined for the work type of the assigned job.

**Forecast Utilization (%)**  This value represents the weighted hours as a percentage of Forecast Capacity or Forecast Work (depending upon the selected filter for the page.) It is calculated by dividing the Weighted Forecast Hours by the utilization calculation method (capacity or total worked hours).

**Reviewing the Personal Utilization Page**

This page provides utilization totals for a single resource. The calculations for the totals on this page are defined below.

**Capacity Amount**  Capacity amount represents the total resource available hours minus any assignment hours with a reduced capacity work type, such as unassigned time. The original resource available hours can also be viewed in the Staffing Home page. The actual and forecast worked hours displayed are normal unweighted hours. However, the utilization total is calculated based on the Resource Weighted Hours.

You can specify the default resource utilization calculation method (by total worked hours or capacity) using the profile option: PA: Resource Utilization Calculation Method.
The default resource utilization period type is specified in the profile option: PA: Resource Utilization Period Type.

**Capacity Hours**  This value represents the net available hours for the resource, (the total available hours minus reduced capacity hours.) The total available hours is derived from the schedule of each resource. This value can be correlated to the values shown in the Staffing Home for each resource within the organization.

The reduced capacity hours are summarized from transactions that are logged against a work type which reduces capacity, such as unassigned time.

**Worked Hours**  This value represents the sum total of worked hours for the resource obtained from submitted timecards.

**Utilization**  This value represents the Weighted Hours for the resource as a percentage of Actual Capacity or Actual Worked (depending upon the selected filter for the page.)

**(Forecast) Provisional Hours**  This value represents the sum total of forecast hours for the resource. It is calculated by summing the totals of all forecast items for the resource which have been marked as provisional.

**(Forecast) Confirmed Hours**  This value represents the difference between the Forecast Work Hours and the Provisional Hours (Forecast Work Hours – Provisional Hours.)

**(Forecast) Utilization**  This value represents the Confirmed Weighted Hours for the resource as a percentage of Actual Capacity or Actual Worked (depending upon the selected filter on the page.)

**Correlation of Utilization Totals**
You can correlate the utilization total in the Resource Utilization by Organization Manager page with the Personal Utilization page by selecting the following filter parameters:

- Utilization view: Resource
- Include only: Confirmed Assignment

Ensure that the selected values for Period Type and Utilization Calculation Method/Show Percentage By parameters are similar to the default profile values for the Personal Utilization page.
You can also correlate the utilization total in the Resource Utilization by Organization Manager page with the total shown in the Resource Utilization by Resource Manager page by selecting the following filter parameter:

- Select Manager = <Manager Name>

Selecting this filter returns the same resources, provided that the resource manager is managing resources in the same organization authorized to the organization manager. The actual and forecast worked hours are the same if the resource works in the same organization during the specified period of time. The number may be different if the resource also works in different organizations during the specified period of time. This difference is because of the following page definitions:

- Resource Utilization by Organization Manager displays utilization for resources with a specific resource manager, period, and organization.
- Resource Utilization by Resource Manager displays utilization for resources with a resource manager who is managing the resources for a specific period.
Implementing Your Utilization Strategy

Implementation options and functions are available for you to tailor the utilization calculations to your business needs as well as provide viewing ability to your users. These options include:

- Determining Utilization Jobs
- Establishing Utilization Categories and Work Types
- Implementing Utilization Forecasting Functionality
- Establishing Unassigned Time Tracking
- Choosing Your Reporting Time Period
- Granting Utilization Authority

Determining Utilization Jobs

All HR jobs have a flag which indicates whether or not the job is tracked for utilization. As resources are assigned to these jobs, you can track their hours in the utilization reports.

To include jobs in utilization, complete the following steps:

1. Login as the Project Resource Management Super User.
2. Navigate to the Jobs form:
   
   Setup > Human Resources > Jobs

3. Select the desired HR Job Group
4. For each job, select Others, then Extra Information.
5. In the Job Category Details window, select Yes or No for Include in Utilization.

**Note:** The Billable choice is used only for financial forecast reporting. See Chapter 10, "Implementing Financial Forecasting" for implementation and usage information.
Implementing Utilization Strategy

Establishing Utilization Categories and Work Types

In order to use the utilization functionality, you must define work types and utilization categories. These attributes provide a means of classifying and sorting the work into logical and meaningful utilization reports.

Defining Utilization Categories

Utilization categories are classifications of work types for reporting purposes. Work types are summarized into utilization categories and can carry different weighting percentages to provide two distinct Utilization Views:

- **Resource Utilization View** - to provide a utilization view for resources and their managers
- **Organization Utilization View** - to provide business managers a utilization view for their organizations and related resources

These utilization views enable you to create two distinct managerial views of the work that resources and their organizations have performed or will perform. You can use each utilization category for one or both utilization views.

Creating Utilization Categories

To create your utilization categories, use the following menu path:

Projects Menu > Setup > Utilization > Utilization Categories

When you define a utilization category, you assign a code, a meaning, and description, as well as the attributes as applicable to the category listed in the following table:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a long description for the utilization category. This field is optional.</td>
</tr>
<tr>
<td>Reporting Order</td>
<td>Determine the display order for the categories on the screens and reports.</td>
</tr>
<tr>
<td>Effective Dates</td>
<td>Enter the beginning and ending date for which the utilization category is effective.</td>
</tr>
</tbody>
</table>

Using Utilization Categories

The effectiveness of utilization categories is best illustrated through an example. In the following example, a resource has performed warranty work which is not billable. The challenge is how to reflect that in your utilization reporting so that it does not inflate your revenue-generating utilization.
A resource is assigned to complete some rework (warranty) work on an existing project. The enterprise (project organization) will not receive any revenue for the extra work performed. The assignment has been allocated a work type called "Warranty" which automatically classifies the timecard entries entered by the resource.

As the project organization is responsible for the overall performance of the project, it should not consider rework as receiving utilization credit. Otherwise, the utilization reports provide a false representation of the total number of hours being effectively utilized by the resources of the organization. This company set up the utilization view for the organization to handle this situation. It filters out work hours associated with the Warranty work type by placing a 0% weighting on the organization categories of the work type.

However, the company does not want the contract-related work to negatively affect the personal utilization percentage of the resource. So, the weighting for the resource categories of the Warranty work type was set at 80%. Doing so, ensures the resource receives a discounted credit of the performed effort.

**Defining Work Types**

Work types are classifications of work. As an example, a professional software services enterprise typically needs work types for the following areas:

- Analysis, Design, Implementation, Support [Billable/Productive work]
- Rework [Non-Billable/Productive work]
- Internal IT Support, Internal Reproduction [Internal Billable/Productive work]
- Bid & Proposal, Marketing [Non-Billable/Selling]
- Sick Pay, Holiday, Jury Duty [Non-Capacity/Non-Productive]

**Creating Work Types** To create your work types, use the following menu path:

Projects Menu > Setup > Utilization > Work Types

When you define a work type, you assign a name and a description. The following table provides a list of attributes you can define for the work type:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billable/Capitalizable</td>
<td>Check to identify a work type as being eligible for use on a billable capitalizable task.</td>
</tr>
</tbody>
</table>
Implementing Your Utilization Strategy

Using Work Types  You assign work types to project types, projects, tasks, and assignments. The implementation process initially assigns default work types to existing project types. You can modify these defaults as appropriate for your business needs. Work types assigned to project types default to associated projects and templates, and eventually, to the tasks and assignments of the project. You can override a work type at the project, assignment, and task levels. However, an override does not carry down to existing child tasks or assignments. You must update each existing task and assignment individually.

To assign work types for forecast items on assignments, navigate to the Add Assignment page.

To assign work types to tasks for actual items, navigate to:

Project > Task > Options > Task Detail

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-Capacity</td>
<td>Check to calculate capacity summarization by subtracting the work type hours from the total capacity and total work hours. Only Non-Billable/Capitalizable work types may select this option. If this attribute is enabled, you cannot enter weighting values for the work type.</td>
</tr>
<tr>
<td>Resource Utilization Category</td>
<td>Select the utilization category in which the work type should be considered for resource utilization calculations.</td>
</tr>
<tr>
<td>Resource Weighting Percentage</td>
<td>Enter a value between 0 and 100. The utilization functionality uses this value to define utilization calculations. The default value is 100% if the work type is billable or capitalizable, otherwise, it defaults to 0.</td>
</tr>
<tr>
<td>Organization Utilization Category</td>
<td>Select the utilization category in which the work type should be considered for organization utilization calculations.</td>
</tr>
<tr>
<td>Organization Weighting Percentage</td>
<td>Enter a value between 0 and 100. The utilization functionality uses this value to define utilization calculations. The default value is 100% if the work type is billable or capitalizable, otherwise, it defaults to 0.</td>
</tr>
<tr>
<td>Standard Effective Dates</td>
<td>Enter the date range for which the work type is effective.</td>
</tr>
</tbody>
</table>
Implementing Your Utilization Strategy

Implementing Utilization Forecasting Functionality

Oracle Project Resource Management creates the forecast utilization totals for both both provisional and confirmed assignments. These totals are based on forecast items. Forecast items are generated for each day of an assignment or requirement.

The implementation options determine how forecast items are generated and their default attributes. For more information on the Forecast Implementation Options, see “Defining Forecasting Options” in Chapter 10, “Implementing Financial Forecasting”.

Establishing Unassigned Time Tracking

Oracle Project Resource Management automatically generates totals for forecast unassigned time for all utilizable resources. The calculation for forecast unassigned time subtracts both forecast provisional and forecast confirmed assignment hours from the forecast total capacity for each available day of the resource. Any remaining hours generated from this calculation are assigned to projects specifically implemented for the purpose of tracking unassigned hours.

For more instructions on how to establish unassigned time tracking, see “Defining Unassigned Time Tracking” in Chapter 10, “Implementing Financial Forecasting”.

Choosing Your Reporting Time Period

The reporting time period has a direct impact on how your utilization totals are calculated. Therefore, you have a choice on which periods you want to summarize your enterprise and organization utilization totals. Once this choice is made and you have run the utilization summarization program, you cannot change it.

You have three reporting periods on which you can perform utilization reporting: GL Period, PA Period, and Global Week. The GL Period option summarizes the utilization totals into financial general ledger period totals. The PA Period option summarizes the utilization totals in periods distinct from your GL Period. The Global Week option summarizes utilization totals by weeks (7 day periods). This particular option is useful for calculation totals across the

Note: You can assign Billable/Capitalizable work types only to billable tasks (tasks which have the Billable flag checked.)
organization which have different financial calendar periods. It helps provide an accurate picture of the totals on an enterprise basis.

To define your utilization time periods, complete the following steps:

1. Login as Project Resource Management Super User.
2. Navigate to the Utilization Options form.
3. Select at least one of the following options:
   - PA period
   - GL Period
   - Global Week

**Granting Utilization Authority**

You can provide your users the ability to view resource or organization utilization totals through:

- assigning specific responsibilities
- assigning HR supervisors to employee assignments
- granting Organization Utilization Authority

**Review of Responsibilities**

The following predefined responsibilities allow different levels of access to the utilization information:

- **Organization Manager Responsibility**
  
  This responsibility provides access to the Organization Utilization page. This page displays utilization totals for the organizations for which the business manager oversees. It also provides the ability to drill-down to individual summary amounts for resources assigned to the organization or suborganization.

- **Resource Manager Responsibility**
  
  This responsibility provides access to the Resource Utilization page. This page displays utilization totals for all resources reporting to the manager. These resources include any person who has the Resource Manager currently assigned
as their supervisor in their HR assignment. It also provides the ability to drill-down to resources who are subordinates to direct reports.

- Team Member Responsibility
  This responsibility provides access to the Personal Utilization page to view personal utilization totals.

**Granting Organization Utilization Authority**

The Organization Utilization Authority enables a user to view the utilization amounts for an organization, all direct resources of the organization, all the suborganizations, and the resources of those suborganizations.

To grant this authority to individual users, navigate to:

Projects menu > Human Resources > Organization Authority

For more information on this authority, see "Assigning Organizational Authority" in Chapter 5, "Configuring Your Organization Security".
Defining the Utilization Profile Options

You have control over how utilization totals are processed through the following profile options:

- **PA: Global Week Start Day**
- **PA: Organization Utilization Default Period Type**
- **PA: Organization Utilization Default Calculation Method**
- **PA: Resource Utilization Period Type**
- **PA: Resource Utilization Calculation Method**
- **PA: Utilization Calculation Begin Date**

Each profile option provides a different control on how your utilization totals are calculated and processed. All utilization profile options are set at the site level.

**PA: Global Week Start Day**

This profile option specifies the weekday that you want recognized as the beginning of the week. Set this profile option at the site level. Valid values are 1 through 7 representing the days of the week. The definition of the numeric values are:

1 = Sunday  
2 = Monday  
3 = Tuesday  
4 = Wednesday  
5 = Thursday  
6 = Friday  
7 = Saturday

**Note:** Global weeks use the date of the first day of the defined week as the name of the period. For example, if you define Monday as your week start day, then the name of each week period will be the date of each Monday.

**PA: Organization Utilization Default Period Type**

This profile option determines the default period type used when initially entering an organization or resource utilization reporting screen. Your choices are: PA
Period, GL Period, Global Week, Quarter, and Year. You must use one of the period types selected in Utilization Options.

**PA: Organization Utilization Default Calculation Method**
This profile option determines the default utilization percentage to show when initially entering an organization utilization reporting screen. Your choices are Capacity or Total Worked Hours.

**PA: Resource Utilization Period Type**
This profile option determines the default period type used when initially entering a resource utilization reporting screen. Your choices are PA Period, GL Period, and Global Week. You must use one of the period types selected in Utilization Options.

**PA: Resource Utilization Calculation Method**
This profile option determines the default period type used when initially entering a resource utilization reporting screen for an individual. Your choices are Capacity or Total Worked Hours.

**PA: Utilization Calculation Begin Date**
This profile option determines the date to begin calculating the utilization hours for both actuals and forecast amounts. No resource hours prior to this date will be included in any of the generated totals.

After setting this particular profile option, you must run a concurrent process called PRC: Identify Transactions for Actuals Utilization to flag all transactions that should be excluded from the summarization of actual utilization hours. When this process is run, any transaction with a date prior to the date specified in this profile option will be flagged as a non-utilization transaction. Therefore, these transactions are ignored when the utilization totals are generated.

This process is an optional one-time implementation step and does not have to be repeated unless you change the date in the PA: Utilization Calculation Begin Date profile option.

---

**Note:** Setting this profile option and running the related concurrent process is optional. Only use this profile option and process if you want to exclude a major portion of existing data from the utilization totals.
Oracle Project Resource Management transactional reporting is supported by a web-based Oracle Discoverer solution. The predefined workbooks, worksheets and End User Layer (EUL) provide you and your users the ability to query and manipulate transactional data to proactively measure and analyze corporate performance.

After you implement the reporting solution, users can access the predefined Oracle Discoverer reports from the self-service Project Resource Management menu structure.

This chapter covers the setup and usage of the reporting solution through the following topics:

- Oracle Discoverer 4i Postinstallation Tasks
- Oracle Discoverer 3i Postinstallation Tasks
- Test Your Installation and Set Up
- Overview of the Business Areas and Business Views
- Security Overview
- Discoverer Workbooks

**Recommendation:** To get the maximum benefit of the reporting solution of PJR we recommend that you use Discoverer 4i.

**Note:** To use the enhanced functionality of Discoverer set the profile option ICX_DISCOVERER_USE_VIEWER to Yes when setting up the Discoverer.
Oracle Discoverer 4i Postinstallation Tasks

For installation instructions for Discoverer 4i, refer to the Discoverer 4i with Oracle Applications 11i document #139516.1 on Metalink.

In the above document, in the sections called "Step 5 5.6 Import using adupdeul.sh mode=complete" and "Appendix A.1 Import using adupdeul.sh mode=driver", you can use the following two different parameters to import all shipped Project Resource Management executable files:

- use mode=complete
- use mode= driver and driver=pasb020.drv,pasb018.drv,pasb010.drv,pasb017.drv

If you are currently using Discoverer 4i, please refer to the instructions in Discoverer 4i Maintenance for Oracle Applications 11i document #182106.1 on Metalink.
Oracle Discoverer 3i Postinstallation Tasks

This section describes the Oracle Discoverer install and setup tasks for integration with Oracle Project Resource Management. To set up the reporting solution, you must use the Administrator Edition or client/server version of Discoverer. To set up the User Edition, you must use the Web Discoverer version, with a few exceptions, which are noted accordingly.

Before you start, you must complete the following activities:

1. Install Oracle Discoverer Administration Edition.
   To access the Discoverer workbooks provided with Oracle Project Resource Management, install Oracle Discoverer.

2. Install Oracle Web Discoverer.

For installation instructions, refer to the Oracle Discoverer 3.1 Installation and Administration Guide.

Oracle Discoverer Postinstallation Tasks Checklist

The following tasks are covered in this section:

1. Create the End User Layer.
2. Modify the End User Layer Owner’s Indexes.
3. Copy files to Discoverer Administration Tier.
5. Import the End User Layer EEX File.
7. Refresh Business Areas.
9. Install the Reporting workbooks.

When you have completed these steps, verify that:

- The EUL owner (database user) id has a suffix corresponding to the end user language, for example:
  EUL_US

- The EUL owner has necessary privileges to FND objects.
Refer to the Oracle Discoverer 3.1 Administration Guide for details.

- An application mode EUL owner exists. When creating the EUL the /APPS_MODE parameter was added to the command line.
- The ICX profiles in Oracle Applications are correct, for example: ICX_DISCOVERER_LAUNCHER, ICX_DEFAULT_EUL, ICX_DEFAULT_WORKBOOK_OWN, and SESSION_COOKIE_NAME.

These profile options are part of the setup of Oracle Discoverer and the self-service environment for Oracle Project Resource Management. For more information on these and other required ICX profile options, refer to Oracle Discoverer 3.1 Administration Guide and the “Setting Up Your Self-Service Environment” in Chapter 9, “Defining the Project Environment” within this guide.

Create the End User Layer
Complete the following steps to create the End User Layer.

1. Create a database user that you want to designate as the End User Layer owner and grant database access to it.
2. Create the application mode EUL.

Creating the Database User Set the name of the end user layer owner (database user) to EUL_<language>, for example: EUL_US. Use the following script to perform this task:

```sql
create user eul_us
identified by eul
default tablespace user_data
temporary tablespace temp;
```

Creating the Applications Mode EUL

1. Issue a set of grants to allow the EUL owner select access to certain Applications Object Library tables. This step is necessary in order for Discoverer to support the structure of Applications user IDs and responsibilities. To do this, connect to the database using the account specified in the FNDNAM environment variable (typically “APPS”) and execute the following statements.

```sql
connect system/manager@<database>
grant connect, resource to &EULOWNER
```
connect apps/apps@<database>
grant select on FND_USER to &EULOWNER
grant select on FND_APPLICATION to &EULOWNER
grant select on FND_USER_RESP_GROUPS to &EULOWNER
grant select on FND_RESPONSIBILITY_VL to &EULOWNER
grant select on FND_ORACLE_USERID to &EULOWNER
grant select on FND_DATA_GROUP_UNITS to &EULOWNER
grant select on FND_PRODUCT_INSTALLATIONS to &EULOWNER
grant select on FND_SECURITY_GROUPS_VL to &EULOWNER
grant execute on FND_CLIENT_INFO to &EULOWNER

2. Create an Applications mode from the Discoverer Administration Edition.

An Applications mode EUL is one that can be administered using the Oracle Applications security model in place of the database security model. There are two ways of doing this, both invoking the Administration edition from the command line:

DIS31ADM.exe /APPS_MODE

Starts the Administration Edition in Applications mode. Any EULs created will by default be Applications mode EULs.

DIS31ADM.exe /APPS_MODE /CREATE_EUL /CONNECT eul_owner/password@database

This command creates an Applications mode EUL from the command line in batch mode.

3. Note that the EUL owner must be an Oracle database userid, not an Oracle Applications userid. The easiest way to create an EUL with a new database userid as the owner is to log onto the Discoverer Administration edition as the SYSTEM user, and in step two of the Create EUL Wizard choose “Create a new user.” It is recommended that you create the EUL in a separate schema from the APPS schema that contains the Oracle Applications tables and views. The primary reason for this is that by creating the EUL in a separate schema it is easier to migrate the EUL from test environment to production environment using database import/export.

4. Next you need to ensure that the EUL owner has select access to the appropriate Applications tables and views where the data is stored. If you are interested in creating Discoverer folders that span multiple tables you may want to grant select any table privilege to the EUL owner. Otherwise, grant select access to just the tables you wish to create Discoverer folders on.
**Modify the Indexes of the End User Layer Owner**

Complete the following steps from the R11 Admin tier to modify the maximum extents of the indexes in the End User Layer.

1. Connect to your database server using SQL/Plus as the End User Layer (for example, EUL_US) owner.
2. At the SQL prompt, enter
   
   `$BIS_TOP/admin/sql/BISALTIN.sql`

**Copy Files to Discoverer Administration Tier**

In order to access Discoverer-related files through the Discoverer Administration and End User Editions, they must be copied to the Discoverer Administration Tier. The file PAPRMEUL.eex is created in the $AU_TOP/discover/<language>/ directory when you install the Oracle Project Resource Management Reporting product.

1. Copy the file PAPRMEUL.eex from the $AU_TOP/discover/<language>/ directory to an appropriate directory from where it can be imported into the Discoverer Administration Edition.
2. Copy the sql script BISEULBA.sql from the $BIS_TOP/admin/sql/ directory into the same temporary directory you used in step 1. Optionally, mount the $AU_TOP/discover/<language>/ directory on to the Discovery Administration Tier.
3. Copy the Discoverer Workbooks from the $AU_TOP/discover/<language>/ directory to a new directory where they can be saved to the database using the Discoverer User Edition. The workbooks installed are:
   - PASCHRES.dis
   - PAAVLRES.dis
   - PAOVCRES.dis
   - PASALPIP.dis
   - PAREQPRJ.dis
Connect to Discoverer Administration Edition

1. Log in to the Discoverer Administration Edition in application mode, for example:
   
   D:\orant\DISCVR31\DIS31ADM.EXE /APPS_MODE

2. Connect to the database, for example:
   
   eul_us/eul@cus115

3. Select File > Set Default EUL.

Import the End User Layer EEX File

The Project Resource Management EEX file must be imported into the Discoverer End User Layer. Select the EUL for which you want the EEX file to be imported, for example, EUL_US.

**Note:** Before beginning the import process, increase the size of the Rollback Segments to a minimum of 10 megabytes. After the import has been completed, reset the Rollback Segments to their original sizes.

To import the EEX file, complete the following steps:

1. Open an MS-DOS command window and navigate to the directory in which the EEX file is located. Enter the following commands at the command prompt:
   
   start /wait <ORACLE_HOME>\discvr31\dis31adm /APPS_MODE
   /CONNECT <EUL_Owner>/EUL_Owner_password@<Connect_string>
   /IMPORT paprmeul.eex /eul<EUL_Owner_in_uppercase> /log eulimport.log

Where:

- `<ORACLE_HOME>` is the top directory for Oracle products installed on the NT server
- `<EUL Owner>` is the database user created above
- `<EUL Owner password>` is the database owner password
- `<Connect_string>` is SQL*Net database connect string
Oracle Discoverer 3i Postinstallation Tasks

- `<EUL_Owner_in_uppercase>`

  **Note:** Enter the EUL owner schema in uppercase after the key/EUL when invoking the second command. For example:

  ```
  start /wait d:\orant\discvr31\dis31amd /APPS_MODE
  /CONNECT eul_us/eul@apps /IMPORT PAPRMEUL.eex /eul EUL_US
  /log eulimport.log
  ```

  **Reminder:** If this responsibility is not a Self-Service responsibility, it cannot be accessed through the Self-Service logon.

2. Check on the progress of the import process by pointing to the Discoverer icon in the right lower corner of your toolbar.

   Inspect the eulimport.log file to ensure that the Project Resource Management EEX file was imported into the End User Layer successfully.

   Alternatively, you can log in to the Discoverer Administration Edition and select File > Import. Specify the location of the PAPRMEUL.eex file to complete the import.

**Set Up Access to Business Areas and End User Discoverer Edition**

You must grant users access to the Discoverer Administrator and User Editions in order for the users to open these applications. However, the users also need user and responsibility access to the Business Areas in order to perform any reporting activities on the Project Resource Management data.

To grant user access to Oracle Discover Administration and User Editions:

1. Log in to the Discoverer Administration Edition in application mode, for example:

   ```
   D:\orant\DISCVR31\DIS31ADM.EXE/APPS_MODE
   ```

2. Select Tools > Privileges.

3. Select the user/responsibility (role) to which you need to grant access, for example, Project Resource Management Super User.

4. Grant the responsibility either the User Edition or the Administration Edition access.
To grant user/responsibilities access to Business Areas:
1. Log in to the Discoverer Administration Edition in application mode, for example:
   D:\orant\DISCVR31\DIS31ADM.EXE/APPS_MODE
3. Select the user/responsibility (role) to which you need to grant access, for example, Project Resource Management Super User.
4. Select the business areas to which you want to grant this user/responsibility access.
5. Check the Allow Administration checkbox for the business areas if this responsibility needs administration access for tasks such as Refresh from the database.

Refresh Business Areas
The following steps synchronize the information in the Discoverer End User Layer and the underlying Oracle Applications data model.
1. Connect to Discoverer Administration Edition by invoking from the command line D:\orant\DISCVR31\DIS31ADM.EXE /APPS_MODE
2. Connect to the database as an application user, for example:
   SERVICES:Project Resource Management Super User:Standard/welcome@cus115
3. Set Default EUL.
4. Select all your business areas.
5. Select File > Refresh
6. Verify that the folders refresh is successful.

Connect to Discoverer User Edition
To invoke Discoverer User Edition:
1. Log in to the Discoverer User Edition in application mode, for example:
   \orant\DISCVR31\DIS31USR.EXE
2. Connect to the database, for example:

   SERVICES:Project Resource Management Super User:Standard/welcome@cus115

3. Select Tools > Options.

4. Select the EUL tab and check the default EUL, for example, EUL_US.

**Install the Project Resource Management Reporting Workbooks for Discoverer**

The following steps explain how to save the workbooks to your database so that users can access the workbooks through Oracle Web Discoverer.

1. Log in to the Discoverer User Edition in application mode, for example:

   D:\orant\DISCVR31\DIS31USR.EXE

   When asked for the login information, select Cancel.

2. While in Discoverer 3.1 User Edition, select Tools > Options and ensure that the checkbox labeled “Display warning when opening workbook saved in a different database account” is checked.


4. To save the Discoverer workbooks from the temporary staging area into the database, open an MS-DOS window and change directories to the staging area where the workbooks were saved. Refer to the section “To copy files to the Discoverer Administration Tier” for more information.

5. Execute the following command from the command prompt:

   ```
   start /wait for %%f in (*.dis) do
   <ORACLE_HOM>\discvr31\dis31usr /connect
   "<EUL_Owner>/EUL_Owner_password>@<Connect_string>
   /savedb %%f /batch
   ```

   For example:

   ```
   start /wait for %%f in (*.dis) do
   c:\orant\discvr31\dis31usr /connect
   "SERVICES:Project Resource Management Super User:Standard"/welcome@apps
   /savedb %%f /batch
   ```

   **Important:** Use quotation marks when you enter the EUL_Owner parameter in the command string.
Alternatively, log in to the Discoverer User Edition and select File > Open > My computer. Specify the location of the workbook file. After the workbook opens, select File > Save As > Database to save the workbook in the database. You must repeat this step for all workbooks.

Once the workbooks are saved in the database, change the EUL Owner (eul_us) End User Layer (eul) password from the default password to a new, secure password.

**Set Up Access to the Reporting Workbooks**

The following steps instruct you on how to set up access to Discoverer workbooks through the Discoverer User Edition.

1. Log in to the Discoverer User Edition in application mode, for example:
   
   D:\orant\DISCVR31\DIS31USR.EXE

2. Open the workbook to which you need to grant other users/responsibilities access.


4. Select User > Workbook tab.

5. Select the user/responsibility to grant access.

6. Select the workbooks you need to grant access to and move them to the Shared section of the Share workbook dialog box.

**Test Your Installation and Set Up**

Once you have finished installing the Oracle Project Resource Management Reporting and performing all the postinstallation tasks, you want to verify that the installation was successful. Check to see that you can access Discoverer Workbooks by selecting any workbook from the Self-Service Applications menu.

If you have any problems, review the installation steps to ensure that you have completed all of them correctly.
Overview of the Business Areas and Business Views

This section provides details on the Business Areas and Folders contained within the Oracle Project Resource Management Discoverer reporting solution in the following sections:

- List of Business Areas
- List of Staffing Business Area Folders
- List of Financial Business Area Folders
- List of Competence Business Area Folders

List of Business Areas

The predefined business areas are:

- Staffing
- Financial
- Competence

Staffing Business Area

The staffing business area provides general staffing information about resources, projects, and organizations. From a supply perspective, you can identify information regarding resource/organization capacity, availability, over-commitment and overall schedule through these folders. From a demand perspective, you can identify information regarding project/organization requirements.

Folders available within the Staffing business area are:

- Staffing Organization Rollup Groups
- Resource Managers
- Fiscal Years
- Fiscal Quarter Numbers
- Calendar Years
- Calendar Months
- Work Types
- Required Project Hours by GL Period
Overview of the Business Areas and Business Views

- Required Project Hours by GL Period: Team Role Detail
- Required Project Hours by PA Period
- Required Project Hours by PA Period: Team Role Detail
- Required Project Hours by Global Week
- Required Project Hours by Global Week: Team Role Detail
- Resource Capacity by GL Period
- Resource Capacity by PA Period
- Resource Capacity by Global Week
- Resource Schedule by GL Period
- Resource Schedule by GL Period: Team Role Detail
- Resource Schedule by PA Period
- Resource Schedule by PA Period: Team Role Detail
- Resource Schedule by Global Week
- Resource Schedule by Global Week: Team Role Detail
- Resource Schedule and Capacity by Global Week
- Available Resource Hours by Global Week
- Resource Overcommitment by Global Week

**Note:** The Team Role Detail folders are not used by the predefined workbooks. They are extra folders provided for your convenience.

Reports by global week display the end date of the week. Therefore, if the global week is defined to start on Monday, then the date for Sunday (the end of the week) is used as the week label.

If you are generating a global week report for a specific month, the totals for the weeks will only include the days for the specified month. For example, if the global week is defined to start on Monday and the month of November 2001 begins on Thursday, then the report will only include activity for Thursday through Sunday for the first week of November.
**Financial Business Area**

The financial business area provides information about the project pipeline. Folders available within the Financial business area are:

- Lookup for Class Categories
- Financial Organization Rollup Groups
- Project Managers
- Fiscal Years
- Fiscal Quarter Numbers
- Project Pipeline by GL Period
- Project Pipeline by PA Period
- Project Role Types
- Project Members

**Competence Business Area**

The Competence business area provides information about the competence of the resources. Folders available within the Competence business area are:

- Organization Competence Summary
- Resource Listing for Organization and Competence
- Resource Competence Details
- Organization Competence Details
- Project Resource Competencies
- Resource Projects
- Competence Organization Rollup Groups
- Competencies
- Include Sub Organizations
- Billable Job only
- Resources
- All Resource Managers
- Jobs
- Job Levels

**List of Staffing Business Area Folders**

This section provides descriptions for each of the folders within the Staffing business area.

**Staffing Organization Rollup Groups**

This folder provides a simplified view of the reporting hierarchy (the hierarchy specified as the default reporting hierarchy). The organizations are secured by operating unit.

Although the hierarchy may be n level, this folder flattens the hierarchy out into two levels. For example, if the original hierarchy is as follows:

Organization 1
  - Organization 2
  - Organization 4
Organization 3
  - Organization 5

it will be represented in this folder as follows:

Organization 1
  - Organization 2
  - Organization 3
  - Organization 4
  - Organization 5

This folder includes the items listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollup Organization</td>
<td>The name of the rollup organization</td>
</tr>
<tr>
<td>Suborganization</td>
<td>The name of the suborganization</td>
</tr>
</tbody>
</table>
Resource Managers
This folder provides all of the managers of people over whom the user has authority. In other words, a user can see all the managers that report to them (directly and indirectly) and, if they have resource authority over an organization, all the managers of people within that organization.

This folder includes the item listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Manager</td>
<td>The full name of the resource manager</td>
</tr>
</tbody>
</table>

Fiscal Years
This folder provides the Fiscal Years in the format YYYY ranging from five Fiscal Years in the past to five Fiscal Years in the future.

It includes the item listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fiscal Year</td>
<td>The fiscal year</td>
</tr>
</tbody>
</table>

Fiscal Quarter Numbers
This folder provides the Fiscal Quarter numbers.

It includes the item listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fiscal Quarter</td>
<td>The fiscal quarter</td>
</tr>
</tbody>
</table>

Calendar Years
This folder provides the calendar years in the format YYYY ranging from five years in the past to five years in the future.

It includes the item listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendar Year</td>
<td>The calendar year</td>
</tr>
</tbody>
</table>
Overview of the Business Areas and Business Views

Calendar Months
This folder provides the calendar month name and number for the twelve months of the year.

It includes the items listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendar Month Name</td>
<td>The name of the calendar month</td>
</tr>
<tr>
<td>Calendar Month Numbers</td>
<td>The number of the calendar month</td>
</tr>
</tbody>
</table>

Work Types
This folder provides information on work types used in the system.

It includes the items listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>User defined name of work type that uniquely identifies it.</td>
</tr>
</tbody>
</table>

Required Project Hours by GL Period
For each GL period, this folder contains the total number of hours that remain unfilled on requirements within Project Resource Management. Hours scheduled in a cancelled status are not included.

This folder includes the items listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fiscal Year</td>
<td>The fiscal year</td>
</tr>
<tr>
<td>Fiscal Quarter</td>
<td>The fiscal quarter</td>
</tr>
<tr>
<td>GL Period</td>
<td>The GL Period for which the requirement hours are calculated</td>
</tr>
<tr>
<td>Project Manager</td>
<td>The project manager as of the current date</td>
</tr>
<tr>
<td>Project Name (Number)</td>
<td>The project of the requirement</td>
</tr>
<tr>
<td>Team Role</td>
<td>The team role name of the requirement</td>
</tr>
<tr>
<td>Required Hours</td>
<td>The total schedule, in hours, for the GL Period of the requirement</td>
</tr>
</tbody>
</table>
Overview of the Business Areas and Business Views

Required Project Hours by GL Period: Team Role Detail
For each GL period, this folder contains the total number of hours that remain unfilled on requirements within Project Resource Management. This folder contains more detailed team role information. Hours scheduled in a cancelled status are not included.

This folder includes the items listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fiscal Year</td>
<td>The fiscal year</td>
</tr>
<tr>
<td>Fiscal Quarter</td>
<td>The fiscal quarter</td>
</tr>
<tr>
<td>GL Period</td>
<td>The GL Period for which the requirement hours are calculated</td>
</tr>
<tr>
<td>Project Manager</td>
<td>The project manager as of the current date</td>
</tr>
<tr>
<td>Project Name (Number)</td>
<td>The project of the requirement</td>
</tr>
<tr>
<td>Team Role</td>
<td>The team role name of the requirement</td>
</tr>
<tr>
<td>Probability</td>
<td>The probability of the project</td>
</tr>
<tr>
<td>Start Date</td>
<td>The start date of the requirement</td>
</tr>
<tr>
<td>End Date</td>
<td>The end date of the requirement</td>
</tr>
<tr>
<td>Minimum Job Level</td>
<td>The minimum job level of the requirement</td>
</tr>
<tr>
<td>Maximum Job Level</td>
<td>The maximum job level of the requirement</td>
</tr>
<tr>
<td>Required Hours</td>
<td>The total schedule, in hours, for the GL Period of the requirement</td>
</tr>
</tbody>
</table>

Required Project Hours by PA Period
For each PA period, this folder contains the total number of hours that remain unfilled on requirements within Project Resource Management. Hours scheduled in a cancelled status are not included.

This folder includes the items listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fiscal Year</td>
<td>The fiscal year</td>
</tr>
<tr>
<td>Fiscal Quarter</td>
<td>The fiscal quarter</td>
</tr>
<tr>
<td>PA Period</td>
<td>The PA Period for which the requirement hours are calculated</td>
</tr>
</tbody>
</table>
Required Project Hours by PA Period: Team Role Detail

For each PA period, this folder contains the total number of hours that remain unfilled on requirements within Project Resource Management. This folder contains more detailed team role information. Hours scheduled in a cancelled status are not included.

This folder includes the items listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fiscal Year</td>
<td>The fiscal year</td>
</tr>
<tr>
<td>Fiscal Quarter</td>
<td>The fiscal quarter</td>
</tr>
<tr>
<td>PA Period</td>
<td>The PA Period for which the requirement hours are calculated</td>
</tr>
<tr>
<td>Project Manager</td>
<td>The project manager as of the current date</td>
</tr>
<tr>
<td>Project Name (Number)</td>
<td>The project of the requirement</td>
</tr>
<tr>
<td>Team Role</td>
<td>The team role name of the requirement</td>
</tr>
<tr>
<td>Probability</td>
<td>The probability of the project</td>
</tr>
<tr>
<td>Start Date</td>
<td>The start date of the requirement</td>
</tr>
<tr>
<td>End Date</td>
<td>The end date of the requirement</td>
</tr>
<tr>
<td>Minimum Job Level</td>
<td>The minimum job level of the requirement</td>
</tr>
<tr>
<td>Maximum Job Level</td>
<td>The maximum job level of the requirement</td>
</tr>
<tr>
<td>Required Hours</td>
<td>The total schedule, in hours, for the GL Period of the requirement</td>
</tr>
</tbody>
</table>
Required Project Hours by Global Week
For each Global Week, this folder contains the total number of hours that remain unfilled on requirements within Project Resource Management. Hours scheduled in a cancelled status are not included.

This folder includes the items listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendar Year</td>
<td>The calendar year</td>
</tr>
<tr>
<td>Calendar Month</td>
<td>The calendar month</td>
</tr>
<tr>
<td>Global Week End Date</td>
<td>The Global Week for which the hours of the requirement are calculated (identified the end date of the requirement)</td>
</tr>
<tr>
<td>Day of Week</td>
<td>The name of the day for which the hours of the requirement are calculated</td>
</tr>
<tr>
<td>Date</td>
<td>The date for which the of the requirement are calculated</td>
</tr>
<tr>
<td>Project Manager</td>
<td>The project manager as of the current date</td>
</tr>
<tr>
<td>Project Name (Number)</td>
<td>The project of the requirement</td>
</tr>
<tr>
<td>Team Role</td>
<td>The team role name of the requirement</td>
</tr>
<tr>
<td>Required Hours</td>
<td>The total schedule, in hours, for the Global Week of the requirement</td>
</tr>
</tbody>
</table>

Required Project Hours by Global Week: Team Role Detail
For each Global Week, this folder contains the total number of hours that remain unfilled on requirements within Project Resource Management. This folder contains more detailed team role information. Hours scheduled in a cancelled status are not included.

This folder includes the items listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendar Year</td>
<td>The calendar year</td>
</tr>
<tr>
<td>Calendar Month</td>
<td>The calendar month</td>
</tr>
<tr>
<td>Global Week End Date</td>
<td>The Global Week for which the hours of the requirement are calculated (identified the end date of the requirement)</td>
</tr>
<tr>
<td>Day of Week</td>
<td>The name of the day for which the hours of the requirement are calculated</td>
</tr>
</tbody>
</table>
Resource Capacity by GL Period

For each GL period, this folder contains the total capacity, in hours, of each person. The capacity of a person is derived from their capacity calendar assignments. It is therefore calculated as, within each GL period, the number of potential working hours attributable to the person’s calendar work pattern minus any hours attributable to public holidays.

The resource information in the folder is derived for the GL period specified.

This folder includes the items listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>The date for which the requirement are calculated</td>
</tr>
<tr>
<td>Project Manager</td>
<td>The project manager as of the current date</td>
</tr>
<tr>
<td>Project Name (Number)</td>
<td>The project of the requirement</td>
</tr>
<tr>
<td>Team Role</td>
<td>The team role name of the requirement</td>
</tr>
<tr>
<td>Probability</td>
<td>The probability of the project</td>
</tr>
<tr>
<td>Start Date</td>
<td>The start date of the requirement</td>
</tr>
<tr>
<td>End Date</td>
<td>The end date of the requirement</td>
</tr>
<tr>
<td>Minimum Job Level</td>
<td>The minimum job level of the requirement</td>
</tr>
<tr>
<td>Maximum Job Level</td>
<td>The maximum job level of the requirement</td>
</tr>
<tr>
<td>Required Hours</td>
<td>The total schedule, in hours, for the Global Week of the requirement</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Manager</td>
<td>The resource manager of the person</td>
</tr>
<tr>
<td>Resource</td>
<td>The name of the person</td>
</tr>
<tr>
<td>Job Name</td>
<td>The job title of the person</td>
</tr>
<tr>
<td>Job Level</td>
<td>The job level of the person</td>
</tr>
<tr>
<td>Fiscal Year</td>
<td>The fiscal year in which the GL Period exists</td>
</tr>
<tr>
<td>Fiscal Quarter</td>
<td>The fiscal quarter in which the GL Period exists</td>
</tr>
<tr>
<td>GL Period</td>
<td>The GL Period for which the hours of the person are calculated</td>
</tr>
<tr>
<td>Capacity Hours</td>
<td>The capacity of the person, in hours, for the GL Period</td>
</tr>
</tbody>
</table>
Resource Capacity by PA Period
For each PA Period, this folder contains the total capacity, in hours, of each person. A person's capacity is derived from their capacity calendar assignments. It is therefore calculated as, within each PA Period, the number of potential working hours attributable to the person's calendar work pattern minus any hours attributable to public holidays.

The resource information in the folder is derived for the PA period specified.

This folder includes the items listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Manager</td>
<td>The resource manager of the person</td>
</tr>
<tr>
<td>Resource</td>
<td>The name of the person</td>
</tr>
<tr>
<td>Job Name</td>
<td>The job title of the person</td>
</tr>
<tr>
<td>Job Level</td>
<td>The job level of the person</td>
</tr>
<tr>
<td>Fiscal Year</td>
<td>The fiscal year in which the PA Period exists</td>
</tr>
<tr>
<td>Fiscal Quarter</td>
<td>The fiscal quarter in which the PA Period exists</td>
</tr>
<tr>
<td>PA Period</td>
<td>The PA Period for which the hours of the person are calculated</td>
</tr>
<tr>
<td>Capacity Hours</td>
<td>The capacity of the person, in hours, for the PA Period</td>
</tr>
</tbody>
</table>

Resource Capacity by Global Week
For each Global Week, this folder contains the total capacity, in hours, of each person. A person's capacity is derived from their capacity calendar assignments. It is therefore calculated as, within each Global Week, the number of potential working hours attributable to the person's calendar work pattern minus any hours attributable to public holidays.

The resource information in the folder is derived for the Global Week specified.

This folder includes the items listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource</td>
<td>The name of the person</td>
</tr>
<tr>
<td>Job Name</td>
<td>The job title of the person</td>
</tr>
</tbody>
</table>
Resource Schedule by GL Period

For each GL period, this folder contains the total number of hours each person is scheduled within Project Resource Management. No details of the actual assignments on which the people are scheduled are available in this folder - the lowest level of data is scheduled hours by person by GL period.

Hours scheduled on either delivery assignments and administrative assignments are included in these totals. Hours scheduled in a provisional status and hours scheduled in a confirmed status are totaled separately (hours scheduled in a cancelled status are not included).

Data is only available for people who have a current and valid employment record in Oracle Human Resources.

Historical data is available for either the previous two Fiscal Quarters or for the whole of the current Fiscal Year (whichever provides more data).

Future data is available from the current date until the end of the forecasting duration defined in the site level profile option PA: Availability Duration (the default duration is two years).

This folder includes the items listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GL Period</td>
<td>The GL Period for which the assignment hours are calculated</td>
</tr>
<tr>
<td>Total Hours</td>
<td>The total schedule hours of the person, including both provisional and confirmed, for the GL Period</td>
</tr>
</tbody>
</table>
Overview of the Business Areas and Business Views

Resource Schedule by GL Period: Team Role Detail

For each GL period, this folder contains the total number of hours each person is scheduled on each of their assignments within Project Resource Management. To view details of the actual assignments making up a person's schedule the user should query this folder - the lowest level of data is scheduled hours by assignment by GL period.

The scheduled hours of both delivery assignments and administrative assignments can be viewed. Hours scheduled in a provisional status and hours scheduled in a confirmed status are totaled separately (hours scheduled in a cancelled status are not included).

Data is only available for people who have a current and valid employment record in Oracle Human Resources.

Historical data is available for either the previous two Fiscal Quarters or for the whole of the current Fiscal Year (whichever provides more data).

Future data is available from the current date until the end of the forecasting duration defined in the site level profile option PA: Availability Duration (the default duration is two years).

This folder includes the items listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirmed Hours</td>
<td>The confirmed schedule hours of the person for the GL Period</td>
</tr>
<tr>
<td>Provisional Hours</td>
<td>The provisional schedule hours of the person for the GL Period</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GL Period</td>
<td>The GL Period for which the assignment hours are calculated</td>
</tr>
<tr>
<td>Project Name</td>
<td>The project to which the assignment belongs</td>
</tr>
<tr>
<td>Project Manager</td>
<td>The project manager as of the current date</td>
</tr>
<tr>
<td>Probability</td>
<td>The probability of the project</td>
</tr>
<tr>
<td>Team Role</td>
<td>The team role name of the assignment</td>
</tr>
<tr>
<td>Start Date</td>
<td>The start date of the assignment</td>
</tr>
<tr>
<td>End Date</td>
<td>The end date of the assignment</td>
</tr>
<tr>
<td>Total Hours</td>
<td>The total schedule hours of the person, including both provisional and confirmed, for the GL Period</td>
</tr>
</tbody>
</table>
Resource Schedule by PA Period

For each PA period, this folder contains the total number of hours each person is scheduled within Project Resource Management. No details of the actual assignments on which the people are scheduled are available in this folder - the lowest level of data is scheduled hours by person by PA period.

Hours scheduled on either delivery assignments and administrative assignments are included in these totals. Hours scheduled in a provisional status and hours scheduled in a confirmed status are totaled separately (hours scheduled in a cancelled status are not included).

Data is only available for people who have a current and valid employment record in Oracle Human Resources.

Historical data is available for either the previous two Fiscal Quarters or for the whole of the current Fiscal Year (whichever provides more data).

Future data is available from the current date until the end of the forecasting duration defined in the site level profile option PA: Availability Duration (the default duration is two years).

This folder includes the items listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PA Period</td>
<td>The GL Period for which the assignment hours are calculated</td>
</tr>
<tr>
<td>Total Hours</td>
<td>The total schedule hours of the person, including both provisional and confirmed, for the PA Period</td>
</tr>
<tr>
<td>Confirmed Hours</td>
<td>The confirmed schedule hours of the person for the PA Period</td>
</tr>
<tr>
<td>Provisional Hours</td>
<td>The provisional schedule hours of the person for the PA Period</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirmed Hours</td>
<td>The confirmed schedule hours of the person for the GL Period</td>
</tr>
<tr>
<td>Provisional Hours</td>
<td>The provisional schedule hours of the person for the GL Period</td>
</tr>
<tr>
<td>Assignment Work Type</td>
<td>The work type of the assignment</td>
</tr>
<tr>
<td>Resource Name</td>
<td>The name of the person</td>
</tr>
<tr>
<td>Project Type</td>
<td>The project type of the project to which the assignment belongs</td>
</tr>
<tr>
<td>Project Number</td>
<td>The project number to which the assignment belongs</td>
</tr>
</tbody>
</table>
Resource Schedule by PA Period: Team Role Detail

For each PA period, this folder contains the total number of hours each person is scheduled on each of their assignments within Project Resource Management. To view details of the actual assignments making up a person's schedule, the user should query this folder - the lowest level of data is scheduled hours by assignment by PA period.

The scheduled hours of both delivery assignments and administrative assignments can be viewed. Hours scheduled in a provisional status and hours scheduled in a confirmed status are totaled separately (hours scheduled in a cancelled status are not included).

Data is only available for people who have a current and valid employment record in Oracle Human Resources.

Historical data is available for either the previous two Fiscal Quarters or for the whole of the current Fiscal Year (whichever provides more data).

Future data is available from the current date until the end of the forecasting duration defined in the site level profile option PA: Availability Duration (the default duration is two years).

This folder includes the items listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PA Period</td>
<td>The PA Period for which the assignment hours are calculated</td>
</tr>
<tr>
<td>Project Name</td>
<td>The project to which the assignment belongs</td>
</tr>
<tr>
<td>Project Manager</td>
<td>The project manager as of the current date</td>
</tr>
<tr>
<td>Probability</td>
<td>The probability of the project</td>
</tr>
<tr>
<td>Team Role</td>
<td>The team role name of the assignment</td>
</tr>
<tr>
<td>Start Date</td>
<td>The start date of the assignment</td>
</tr>
<tr>
<td>End Date</td>
<td>The end date of the assignment</td>
</tr>
<tr>
<td>Total Hours</td>
<td>The total schedule hours of the person, including both provisional and confirmed, for the PA Period</td>
</tr>
<tr>
<td>Confirmed Hours</td>
<td>The confirmed schedule hours of the person for the PA Period</td>
</tr>
<tr>
<td>Provisional Hours</td>
<td>The provisional schedule hours of the person for the PA Period</td>
</tr>
<tr>
<td>Assignment Work Type</td>
<td>The work type of the assignment</td>
</tr>
</tbody>
</table>
Resource Schedule by Global Week

For each Global Week, this folder contains the total number of hours each person is scheduled within Project Resource Management. No details of the actual assignments on which the people are scheduled are available in this folder - the lowest level of data is scheduled hours by person by GL period.

Hours scheduled on either delivery assignments and administrative assignments are included in these totals. Hours scheduled in a provisional status and hours scheduled in a confirmed status are totaled separately (hours scheduled in a cancelled status are not included).

Data is only available for people who have a current and valid employment record in Oracle Human Resources.

Historical data is available for either the previous two Fiscal Quarters or for the whole of the current Fiscal Year (whichever provides more data).

Future data is available from the current date until the end of the forecasting duration defined in the site level profile option PA: Availability Duration (the default duration is two years).

This folder includes the items listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendar Year</td>
<td>The calendar year in which the Global Week exists</td>
</tr>
<tr>
<td>Calendar Month</td>
<td>The calendar month in which the Global Week exists</td>
</tr>
<tr>
<td>Global Week End Date</td>
<td>The end date of the Global Week for which the hours of the person are calculated</td>
</tr>
<tr>
<td>Global Week End Day</td>
<td>The week day name of the end date of the Global Week</td>
</tr>
<tr>
<td>Date</td>
<td>The date for which the hours of the person are calculated</td>
</tr>
</tbody>
</table>
Resource Schedule by Global Week: Team Role Detail

For each Global Week, this folder contains the total number of hours each person is scheduled on each of their assignments within Project Resource Management. To view details of the actual assignments making up a persons schedule the user should query this folder - the lowest level of data is scheduled hours by assignment by GL period.

The scheduled hours of both delivery assignments and administrative assignments can be viewed. Hours scheduled in a provisional status and hours scheduled in a confirmed status are totaled separately (hours scheduled in a cancelled status are not included).

Data is only available for people who have a current and valid employment record in Oracle Human Resources.

Historical data is available for either the previous two Fiscal Quarters or for the whole of the current Fiscal Year (whichever provides more data).

Future data is available from the current date until the end of the forecasting duration defined in the site level profile option PA: Availability Duration (the default duration is two years).

This folder includes the items listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Hours</td>
<td>The total schedule hours of the person, including both provisional and confirmed, for the Global Week</td>
</tr>
<tr>
<td>Confirmed Hours</td>
<td>The confirmed schedule hours of the person for the Global Week</td>
</tr>
<tr>
<td>Provisional Hours</td>
<td>The provisional schedule hours of the person for the Global Week</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendar Year</td>
<td>The calendar year in which the Global Week exists</td>
</tr>
<tr>
<td>Calendar Month</td>
<td>The calendar month in which the Global Week exists</td>
</tr>
<tr>
<td>Global Week End Date</td>
<td>The end date of the Global Week for which the hours of the person are calculated</td>
</tr>
<tr>
<td>Global Week End Day</td>
<td>The week day name of the end date of the Global Week</td>
</tr>
<tr>
<td>Date</td>
<td>The date for which the hours of the person are calculated</td>
</tr>
</tbody>
</table>
### Resource Schedule and Capacity by Global Week

For each Global Week, this folder contains the total number of hours each person is scheduled within Project Resource Management.

The resource information in the folder is derived for the Global Week specified.

Hours scheduled on either delivery assignments or administrative assignments are included in these totals. Hours scheduled in a provisional status and hours scheduled in a confirmed status are available separately. Hours scheduled in a cancelled status are not included.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Manager</td>
<td>The resource manager of the person</td>
</tr>
<tr>
<td>Resource Name</td>
<td>The name of the person</td>
</tr>
<tr>
<td>Job Name</td>
<td>The job title of the person</td>
</tr>
<tr>
<td>Resource Job Level</td>
<td>The job level of the person</td>
</tr>
</tbody>
</table>
Available Resource Hours by Global Week

For each Global Week, this folder contains the available hours, of each resource. A person's capacity is derived from their calendar.

The resource information in the folder is derived for the Global Week specified.

This folder includes the items listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Manager</td>
<td>The resource manager of the person</td>
</tr>
<tr>
<td>Resource Name</td>
<td>The name of the person</td>
</tr>
<tr>
<td>Job Name</td>
<td>The job title of the person</td>
</tr>
<tr>
<td>Resource Job Level</td>
<td>The global job level of the person</td>
</tr>
<tr>
<td>Year</td>
<td>The fiscal year in which the Global week exists</td>
</tr>
<tr>
<td>Month</td>
<td>The fiscal month in which the Global Week exists</td>
</tr>
<tr>
<td>Global Week End Date</td>
<td>The end date of Global Week for which the available hours of the person are calculated</td>
</tr>
<tr>
<td>Day of Week</td>
<td>The name of the day for which the available hours of the person are calculated</td>
</tr>
</tbody>
</table>
Overview of the Business Areas and Business Views

Resource Overcommitment by Global Week
This folder provides overcommited resources information. The resource information in the folder is derived for the Global Week specified.

This folder includes the items listed in the following table:
Overview of the Business Areas and Business Views

List of Financial Business Area Folders

This section provides descriptions for each of the folders within the Financial business area.

Financial Organization Rollup Groups

Shows a simplified view of the reporting hierarchy (the hierarchy specified as the default reporting hierarchy). The organizations are secured by operating unit and forecasting authority.

Although the hierarchy may be n level, this folder flattens the hierarchy out into just two levels. For example, if the original hierarchy is as follows:

Organization 1
   Organization 2
   Organization 4
Organization 3
   Organization 5

and the user does not have forecasting authority over organization 2 or 5, this folder will represent the following:

Organization 1
Organization 3
Organization 4

This folder includes the items listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollup Organization</td>
<td>The name of the rollup organization</td>
</tr>
<tr>
<td>Suborganization</td>
<td>The name of the suborganization</td>
</tr>
</tbody>
</table>

Project Managers

This folder provides all people who have or have had the role of a project manager.

It includes the item listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Manager</td>
<td>The full name of the project manager</td>
</tr>
</tbody>
</table>
Overview of the Business Areas and Business Views

Fiscal Years
This folder provides the Fiscal Years in the format YYYY ranging from five Fiscal Years in the past to five Fiscal Years in the future. It includes the item listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fiscal Year</td>
<td>The fiscal year</td>
</tr>
</tbody>
</table>

Fiscal Quarter Numbers
This folder provides the Fiscal Quarter numbers. It includes the item listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fiscal Quarter Number</td>
<td>The number of the fiscal quarter</td>
</tr>
</tbody>
</table>

Project Role Types
This folder provides the list of all Project Role Types.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Role Type</td>
<td>The name of the role on the project</td>
</tr>
</tbody>
</table>

Project Members
This folder provides a list of all resources that have a role on a project.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Name</td>
<td>The project name on which the resource (project member) is assigned</td>
</tr>
<tr>
<td>Member Name</td>
<td>The name of the project member</td>
</tr>
</tbody>
</table>

Sales Pipeline by GL Period
For each GL Period, this folder lists projects that are expecting approval and the values associated with them. Both total project value and discounted amount (total project value times project probability) are given.
Only projects with a status of unapproved or submitted and a probability of less than 100 are included in this folder.

This folder lists projects by classification category. Therefore, if a project is classified in two categories, it will appear twice in this folder. Therefore, to avoid double counting project values, it is recommended that queries on this folder should be performed for one classification category at a time.

Historical data is available for either the previous two Fiscal Quarters or for the whole of the current Fiscal Year (whichever provides more data).

Future data is available from the current date until the end of the forecasting duration defined in the site level profile option PA: Availability Duration (the default duration is two years).

This folder includes the items listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Classification Category</td>
<td>The category by which the project is classified</td>
</tr>
<tr>
<td>Classification Code</td>
<td>The code by which the project is classified</td>
</tr>
<tr>
<td>Project</td>
<td>The name of the project</td>
</tr>
<tr>
<td>Class Code Percentage</td>
<td>Percentage value of a classification code</td>
</tr>
<tr>
<td>Project Role Type</td>
<td>The name of a role on a project</td>
</tr>
<tr>
<td>Probability</td>
<td>The probability of the project</td>
</tr>
<tr>
<td>Type</td>
<td>The type of the project</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the project</td>
</tr>
<tr>
<td>Expected Approval Date</td>
<td>The expected approval date of the project</td>
</tr>
<tr>
<td>Fiscal Year</td>
<td>The Fiscal Year in which the GL Period exists</td>
</tr>
<tr>
<td>Fiscal Quarter</td>
<td>The Fiscal Quarter in which the GL Period exists</td>
</tr>
<tr>
<td>GL Period</td>
<td>The GL Period in which the project is expecting approval</td>
</tr>
<tr>
<td>Total Project Value</td>
<td>The total value of the project</td>
</tr>
<tr>
<td>Discounted Amount</td>
<td>The total project value multiplied by the probability of the project</td>
</tr>
<tr>
<td>Project Number</td>
<td>The number of the project</td>
</tr>
</tbody>
</table>
Sales Pipeline by PA Period

For each PA Period, this folder lists projects that are expecting approval and the values associated with them. Both total project value and discounted amount (total project value times project probability) are given.

Only projects with a status of unapproved or submitted and a probability of less than 100 are included in this folder.

This folder lists projects by classification category. Therefore, if a project is classified in two categories, it will appear twice in this folder. Therefore, to avoid double counting project values, it is recommended that queries on this folder should be performed for one classification category at a time.

Historical data is available for either the previous two Fiscal Quarters or for the whole of the current Fiscal Year (whichever provides more data).

Future data is available from the current date until the end of the forecasting duration defined in the site level profile option PA: Availability Duration (the default duration is two years).

This folder includes the items listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Classification Category</td>
<td>The category by which the project is classified</td>
</tr>
<tr>
<td>Classification Code</td>
<td>The code by which the project is classified</td>
</tr>
<tr>
<td>Project</td>
<td>The name of the project</td>
</tr>
<tr>
<td>Class Code Percentage</td>
<td>Percentage value of a classification code</td>
</tr>
<tr>
<td>Project Role Type</td>
<td>The name of a role on a project</td>
</tr>
<tr>
<td>Probability</td>
<td>The probability of the project</td>
</tr>
<tr>
<td>Type</td>
<td>The type of the project</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the project</td>
</tr>
<tr>
<td>Expected Approval Date</td>
<td>The expected approval date of the project</td>
</tr>
<tr>
<td>Fiscal Year</td>
<td>The Fiscal Year in which the PA Period exists</td>
</tr>
<tr>
<td>Fiscal Quarter</td>
<td>The Fiscal Quarter in which the PA Period exists</td>
</tr>
<tr>
<td>PA Period</td>
<td>The PA Period in which the project is expecting approval</td>
</tr>
<tr>
<td>Total Project Value</td>
<td>The total value of the project</td>
</tr>
</tbody>
</table>
Lookup for Class Categories
This folder provides all class categories currently available within the system. It includes the item listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Classification Category</td>
<td>The name of the classification category</td>
</tr>
</tbody>
</table>

List of Competence Business Area Folders
This section provides descriptions for each of the folders within the Competence business area.

Organization Competence Summary
This folder provides summary of competencies and number of resources per organization that have a particular competence.

It includes the items listed in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization Name</td>
<td>The name of the organization</td>
</tr>
<tr>
<td>Competence Name</td>
<td>The name of the competence</td>
</tr>
<tr>
<td>Competence Alias</td>
<td>The short name of the competence</td>
</tr>
<tr>
<td>Competence Description</td>
<td>The description of the competence</td>
</tr>
<tr>
<td>Resource Count</td>
<td>The number of resources who have the competence.</td>
</tr>
<tr>
<td>View Resources</td>
<td>The link to view list of resources</td>
</tr>
<tr>
<td>Business Group</td>
<td>The business group name of the competence</td>
</tr>
<tr>
<td>Segment 1-30</td>
<td>Key FlexField segments of the competence</td>
</tr>
</tbody>
</table>
Resource Listing for Organization and Competence
This folder provides detail of the people per organization and their competence profile.

It includes the items listed in the following table.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization Name</td>
<td>The name of the organization</td>
</tr>
<tr>
<td>Competence Name</td>
<td>The name of the competence</td>
</tr>
<tr>
<td>Person Name</td>
<td>The name of the resource</td>
</tr>
<tr>
<td>Proficiency Level</td>
<td>The proficiency level of the competence</td>
</tr>
<tr>
<td>Manager Name</td>
<td>The manager of the resource</td>
</tr>
<tr>
<td>Job Name</td>
<td>The job name of the resource</td>
</tr>
<tr>
<td>Project Job Level</td>
<td>The job level of the resource</td>
</tr>
<tr>
<td>Project Job Code</td>
<td>The job code of the resource</td>
</tr>
<tr>
<td>Location</td>
<td>The primary location of the resource</td>
</tr>
<tr>
<td>View Competence Details</td>
<td>The link to view competence profile of the resource</td>
</tr>
</tbody>
</table>

Resource Competence Details
This folder provides detailed competence information of a resource.

It includes the items listed in the following table.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Name</td>
<td>The name of the person</td>
</tr>
<tr>
<td>Competence Name</td>
<td>The name of the competence of the resource</td>
</tr>
<tr>
<td>Competence Alias</td>
<td>The short name of the competence</td>
</tr>
<tr>
<td>Business Group Name</td>
<td>The business group name of the competence</td>
</tr>
<tr>
<td>Proficiency Level</td>
<td>The proficiency level of the competence</td>
</tr>
<tr>
<td>Last Updated Date</td>
<td>The last date the competence was updated</td>
</tr>
<tr>
<td>Segment 1-30</td>
<td>Key Flexfield segments of the competence</td>
</tr>
</tbody>
</table>
Organization Resource Competencies

This folder provides competence information about all resources for an organization.

It includes the items listed in the following table.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization Name</td>
<td>The name of the organization</td>
</tr>
<tr>
<td>Resource Name</td>
<td>the name of the person</td>
</tr>
<tr>
<td>Resource Competencies</td>
<td>A listing of all the competence aliases of the resource, prefixed by the proficiency level of the competence. If the competence does not have a alias the the competence name is used.</td>
</tr>
<tr>
<td>Resource Competence Count</td>
<td>The number of competencies of the resource</td>
</tr>
<tr>
<td>Last Updated</td>
<td>The last date the competence profile was updated. This is the latest date when any one of the resource competence was updated.</td>
</tr>
<tr>
<td>Manager Name</td>
<td>The name of the manager of the resource</td>
</tr>
<tr>
<td>Job Name</td>
<td>The job name of the resource</td>
</tr>
<tr>
<td>Job Level</td>
<td>The job level of the resource</td>
</tr>
<tr>
<td>Job Code</td>
<td>The job code of the resource</td>
</tr>
<tr>
<td>View Competence Details</td>
<td>The link to view competence profile of the resource</td>
</tr>
<tr>
<td>Billable Flag</td>
<td>The flag indicating if the job of the resource is billable</td>
</tr>
</tbody>
</table>

Project Resource Competencies

This folder provides information about all resources for a project, and their competencies and proficiency levels.

It includes the items listed in the following table.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Name</td>
<td>The name of the project that has the resource assignment</td>
</tr>
<tr>
<td>Project Number</td>
<td>The project number of the project that has the resource assignment</td>
</tr>
<tr>
<td>Resource Name</td>
<td>The name of the person</td>
</tr>
</tbody>
</table>
Resource Projects

This folder provides information about all projects that have a resource assigned to it.

It includes the items listed in the following table.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Id</td>
<td>System Identification number of the project</td>
</tr>
<tr>
<td>Name Number</td>
<td>The project name and project number that has resource assignment</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the project</td>
</tr>
<tr>
<td>Number</td>
<td>The number of the project</td>
</tr>
</tbody>
</table>

Competence Organization Rollup Groups

This folder provides information about all organizations in the reporting organization hierarchy.
It includes the items listed in the following table.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Organization Name</td>
<td>The name of the parent organization</td>
</tr>
<tr>
<td>Child Organization Name</td>
<td>The name of the child organization</td>
</tr>
<tr>
<td>Include Sub Organization</td>
<td>Yes/No: Select whether to include sub-organizations of the selected organization in the result.</td>
</tr>
</tbody>
</table>

**Competencies**

This folder provides information about all competence names.

It includes the items listed in the following fields.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Competence Name</td>
<td>The name of the competence</td>
</tr>
</tbody>
</table>

**Include Sub Organizations**

The folder provides information whether to include or exclude sub organization.

It includes the items listed in the following table.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meaning</td>
<td>Yes/No: Used for selecting the sub organization in the list of values</td>
</tr>
</tbody>
</table>

**Billable Job Only**

The folder provides information whether the job is a billable job or not.

It includes the items listed in the following table.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meaning</td>
<td>Yes/No: Used for selecting whether the job is billable or not.</td>
</tr>
</tbody>
</table>

**Resources**

The folder shows information about all current and future resources with their resource manager.
It includes the items listed in the following table.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Name</td>
<td>The name of the person</td>
</tr>
</tbody>
</table>

**All Resource Managers**
The folder shows information about all current and future resource managers.
It includes the items listed in the following table.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the resource manager</td>
</tr>
</tbody>
</table>

**Jobs**
The folder shows information about all job names across business groups.
It includes the items listed in the following table.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the job</td>
</tr>
</tbody>
</table>

**Job Levels**
The folder shows information about all job levels across business groups.
It includes the items listed in the following table.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the job level</td>
</tr>
</tbody>
</table>
List of Business Views

Each folder within the EUL maps to a business view on the database. If you need direct access to these views, the following table provides view and folder mapping:

<table>
<thead>
<tr>
<th>View Name</th>
<th>Folder Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>pa_rep_proj_reQhrs_gl_v</td>
<td>Required Project Hours by GL Period</td>
</tr>
<tr>
<td>pa_rep_proj_reQhrs_gld_v</td>
<td>Required Project Hours by GL Period: Team Role Detail</td>
</tr>
<tr>
<td>pa_rep_proj_reQhrs_pa_v</td>
<td>Required Project Hours by PA Period</td>
</tr>
<tr>
<td>pa_rep_proj_reQhrs_pad_v</td>
<td>Required Project Hours by PA Period: Team Role Detail</td>
</tr>
<tr>
<td>pa_rep_proj_reQhrs_wk_v</td>
<td>Required Project Hours by Global Week</td>
</tr>
<tr>
<td>pa_rep_proj_reQhrs_wkd_v</td>
<td>Required Project Hours by Global Week: Team Role Detail</td>
</tr>
<tr>
<td>pa_rep_res_cap_gl_v</td>
<td>Resource Capacity by GL Period</td>
</tr>
<tr>
<td>pa_rep_res_cap_pa_v</td>
<td>Resource Capacity by PA Period</td>
</tr>
<tr>
<td>pa_rep_res_cap_wkd_v</td>
<td>Resource Capacity by Global Week</td>
</tr>
<tr>
<td>pa_rep_res_schhrs_gl_v</td>
<td>Resource Schedule by GL Period</td>
</tr>
<tr>
<td>pa_rep_res_schhrs_gld_v</td>
<td>Resource Schedule by GL Period: Team Role Detail</td>
</tr>
<tr>
<td>pa_rep_res_schhrs_pa_v</td>
<td>Resource Schedule by PA Period</td>
</tr>
<tr>
<td>pa_rep_res_schhrs_pad_v</td>
<td>Resource Schedule by PA Period: Team Role Detail</td>
</tr>
<tr>
<td>pa_rep_res_schhrs_wk_v</td>
<td>Resource Schedule by Global Week</td>
</tr>
<tr>
<td>pa_rep_res_schhrs_wkd_v</td>
<td>Resource Schedule by Global Week: Team Role Detail</td>
</tr>
<tr>
<td>pa_rep_proj_sp_gl_v</td>
<td>Project Pipeline by GL Period</td>
</tr>
<tr>
<td>pa_rep_proj_sp_pa_v</td>
<td>Project Pipeline by PA Period</td>
</tr>
<tr>
<td>pa_rep_all_rep_org_v</td>
<td>Staffing Organization Rollup Groups</td>
</tr>
<tr>
<td>pa_rep_forecast_org_v</td>
<td>Financial Organization Rollup Groups</td>
</tr>
<tr>
<td>pa_proj_manager_v</td>
<td>Project Managers</td>
</tr>
<tr>
<td>pa_rep_all_mgr_v</td>
<td>Resource Managers</td>
</tr>
<tr>
<td>pa_rep_year_gl_v</td>
<td>Fiscal Years</td>
</tr>
<tr>
<td>pa_rep_quarter_gl_v</td>
<td>Fiscal Quarter Numbers</td>
</tr>
<tr>
<td>pa_rep_year_cal_v</td>
<td>Calendar Years</td>
</tr>
<tr>
<td>pa_rep_month_v</td>
<td>Calendar Months</td>
</tr>
</tbody>
</table>
### Overview of the Business Areas and Business Views

#### Setting Up for Reporting Capabilities

<table>
<thead>
<tr>
<th>View Name</th>
<th>Folder Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>pa_rep_proj_sp_cc_v</td>
<td>Lookup for Class Categories</td>
</tr>
<tr>
<td>pa_rep_org_comp_sum_v</td>
<td>Organization Competence Summary</td>
</tr>
<tr>
<td>pa_rep_org_comp_res_lst_v</td>
<td>Resource Listing for Organization and Competence</td>
</tr>
<tr>
<td>pa_rep_res_comp_dts_v</td>
<td>Resource Competence Details</td>
</tr>
<tr>
<td>pa_rep_org_res_comp_v</td>
<td>Organization Resource Competencies</td>
</tr>
<tr>
<td>pa_rep_proj_res_comp_v</td>
<td>Project Resource Competencies</td>
</tr>
<tr>
<td>pa_rep_res_projects_v</td>
<td>Resource Projects</td>
</tr>
<tr>
<td>pa_rep_comp_rep_org_v</td>
<td>Competence Organization Rollup Groups</td>
</tr>
<tr>
<td>pa_rep_all_comp_v</td>
<td>Competencies</td>
</tr>
<tr>
<td>pa_rep_yes_no_v</td>
<td>Include Sub-Organizations</td>
</tr>
<tr>
<td>pa_rep_resources_v</td>
<td>Resources</td>
</tr>
<tr>
<td>pa_rep_managers_v</td>
<td>All Resource Managers</td>
</tr>
<tr>
<td>pa_rep_all_jobs_v</td>
<td>Jobs</td>
</tr>
<tr>
<td>pa_setup_job_levels_v</td>
<td>Job Levels</td>
</tr>
<tr>
<td>pa_rep_proj_sts_v</td>
<td>Project Statuses</td>
</tr>
<tr>
<td>pa_project_role_types_vl</td>
<td>Project Role Types</td>
</tr>
<tr>
<td>pa.proj_members_view</td>
<td>Project Members</td>
</tr>
<tr>
<td>pa_rep_res_cap_wkd_v</td>
<td>Resource Schedule and Capacity by Global Week</td>
</tr>
<tr>
<td>pa_rep_res_ovc wk_v</td>
<td>Resource Overcommitment by Global Week</td>
</tr>
<tr>
<td>pa_rep_res_avl wk_v</td>
<td>Available Resource Hours by Global Week</td>
</tr>
<tr>
<td>pa_work_types_vl</td>
<td>Work Types</td>
</tr>
<tr>
<td>pa_rep_proj_sp_gl_v</td>
<td>Sales Pipeline by GL Period</td>
</tr>
<tr>
<td>pa_rep_proj_sp_pa_v</td>
<td>Sales Pipeline by PA Period</td>
</tr>
</tbody>
</table>
Security Overview

Security is handled using the standard Oracle Applications security model meaning that security is tied to the Applications responsibility that the user selects at login. The user can then only view data and run reports as designated by the profile options, reports, menus, and organizations the responsibility has assigned to it.

Organization Security
A user will only be able to run financial workbooks for organizations that they have forecast authority over.

Resource Manager Security
A user will only be able to run staffing workbooks for resource managers that either report to them or manage people that they have resource authority over.

Discoverer Workbooks
This chapter contains descriptive information for the following predefined Discoverer workbooks included in the Project Resource Management reporting solution:

- Required Project Hours (PAREQPRJ)
- Scheduled Resource Hours (PASCHRES)
- Available Resource Hours (PAAVLRES)
- Overcommitted Resource Hours (PAOVCRES)
- Project Pipeline Workbook (PASALPIP)
- Organization Competence Summary Workbook (PA_PRM_ORG_COMP_SUM)
- Resource Competencies Workbook (PA_PRM_RES_COMP)

Note: The first five workbooks can be run on both Discoverer 3i and 4i. The last two workbooks can be run only on Discoverer 4i.
You may find references to the following Discoverer features:

- **Null Data Display**
  Discoverer displays a blank in a dropdown selection box when the field on which the selection is made contains null values. To select a null value, click on the blank in the same way that you select other, non-null values.

- **Optional Parameters**
  As is noted below, worksheet parameters can be switched on or off by the user at runtime. For example, to run a report that has a resource manager parameter for all resource managers, the resource manager parameter can be switched off.

  **Note:** While using such parameters is common practice, you should note that your system may experience a decrease in performance when certain parameters are removed from a worksheet.

**Global Week Reports**
Reports by global week display the end date of the week. Therefore, if the global week is defined to start on Monday, then the date for Sunday (the end of the week) is used as the week label.

If you are generating a global week report for a specific month, the totals for the weeks will only include the days for the specified month. For example, if the global week is defined to start on Monday and the month of November 2001 begins on Thursday, then the report will only include activity for Thursday through Sunday for the first week of November.

**Required Project Hours (PAREQPRJ)**
The required project hours workbook allows you to evaluate the number of hours currently required within Project Resource Management by project. You can view this information by Organization and Project Manager.

Worksheets included in this workbook are:
- Required Project Hours by GL Period
- Required Project Hours by PA Period
- Required Project Hours by Global Week
Security
When selecting an organization, the user will be restricted to those within the reporting hierarchy of the operating unit associated with their responsibility.
When selecting a project manager, the user will be restricted to people who are currently managing projects within Project Resource Management.

Required Project Hours by GL Period
Some of the business questions answered by this worksheet are:

■ What is the total number of hours of work that I need to find resources to fill in my organization by GL period?
■ What does the spread of required hours per GL period look like over time?
■ What does the spread of required hours per GL period look like over organizations?

The Required Project Hours by GL Period worksheet helps you answer these questions by letting you analyze and manipulate scheduling information by Organization and Project Manager. Additionally, you can roll the data up to Fiscal Quarter and year.

Parameter Page
Parameters are predefined conditions that you can leave on or switch off by selecting the Conditions dialogue under the Tools menu.

■ Organization - You can choose only one organization but the worksheet will then run for the organization chosen and any below it in the reporting hierarchy.
■ Project Manager - You can choose one or more Project Managers for whom you want to view data.
■ Fiscal Year - You can choose only one year.
■ Fiscal Quarter Number - You can choose only one quarter number for the year you have specified.

Conditions
Conditions are filters in the worksheet that you can turn on or off.

There are no conditions (other than those defined for the parameters listed above) predefined on this worksheet.
Column Dimensions
- Fiscal Year - the name of a Fiscal Year
- Fiscal Quarter - the name of a Fiscal Quarter
- GL Period - the name of a GL period
- Required Hours - number of hours required

Row Dimensions
- Organization - the name of an organization.
- Project - the name of a project.
- Team Role - the team role name of the requirement.

Additional Information
If the worksheet returns a value that requires further investigation the user should create a more detailed worksheet based on the folder Required Project Hours by GL Period: Team Role Detail. Using this folder more detailed information about the requirement can be found. The data you can view includes:
- Probability - the probability of the project.
- Start Date - the start date of the assignment.
- End Date - the end date of the assignment.
- Minimum Job Level - the minimum job level of the requirement.
- Maximum Job Level - the maximum job level of the requirement.

Required Project Hours by PA Period
Some of the business questions answered by this worksheet are:
- What is the total number of hours of work that I need to find resources to fill in my organization by PA period?
- What does the spread of required hours per PA period look like over time?
- What does the spread of required hours per PA period look like over organizations?

The Required Project Hours by PA Period worksheet helps you answer these questions by letting you analyze and manipulate scheduling information by
Organization and Project Manager. Additionally, you can roll the data up to Fiscal Quarter and year.

Parameter Page
Parameters are predefined conditions that you can leave on or switch off by selecting the Conditions dialogue under the Tools menu.

- Organization - You can choose only one organization but the worksheet will then run for the organization chosen and any below it in the reporting hierarchy.
- Project Manager - You can choose one or more Project Managers for whom you want to view data.
- Fiscal Year - You can choose only one year.
- Fiscal Quarter Number - You can choose only one quarter number for the year you have specified.

Conditions
Conditions are filters in the worksheet that you can turn on or off.

There are no conditions (other than those defined for the parameters listed above) predefined on this worksheet.

Column Dimensions
- Fiscal Year - the name of a Fiscal Year
- Fiscal Quarter - the name of a Fiscal Quarter
- PA Period - the name of a PA period
- Required Hours - number of hours required

Row Dimensions
- Organization - the name of an organization.
- Project - the name of a project.
- Team Role - the team role name of the requirement.

Additional Information
If the worksheet returns a value that requires further investigation the user should create a more detailed worksheet based on the folder Required Project Hours by PA
Period: Team Role Detail. Using this folder more detailed information about the requirement can be found. The data you can view includes:

- Probability - the probability of the project.
- Start Date - the start date of the assignment.
- End Date - the end date of the assignment.
- Minimum Job Level - the minimum job level of the requirement.
- Maximum Job Level - the maximum job level of the requirement.

**Required Project Hours by Global Week**

Some of the business questions answered by this worksheet are:

- What is the total number of hours of work that I need to find resources to fill in my organization by Global Week?
- What does the spread of required hours per Global Week look like over time?
- What does the spread of required hours per Global Week period look like over organizations?

The Required Project Hours by Global Week worksheet helps you answer these questions by letting you analyze and manipulate scheduling information by Organization and Project Manager.

**Parameter Page**

Parameters are predefined conditions that you can leave on or switch off by selecting the Conditions dialogue under the Tools menu.

- Organization - You can choose only one organization but the worksheet will then run for the organization chosen and any below it in the reporting hierarchy.
- Project Manager - You can choose one or more Project Managers for whom you want to view data.
- Calendar Year - You can choose only one year.
- Calendar Month - You can choose only one calendar month for the year you have specified.
Conditions
Conditions are filters in the worksheet that you can turn on or off. There are no conditions (other than those defined for the parameters listed above) predefined on this worksheet.

Column Dimensions
- Calendar Year - the name of a calendar year
- Calendar Month - the name of a calendar month
- Global Week - the name of a global week
- Day - the name of a day
- Required Hours - number of hours required

Row Dimensions
- Organization - the name of an organization.
- Project - the name of a project.
- Team Role - the team role name of the requirement.

Additional Information
If the worksheet returns a value that requires further investigation the user should create a more detailed worksheet based on the folder Required Project Hours by Global Week: Team Role Detail. Using this folder, you can find more detailed information about the requirement. The data you can view includes:
- Probability - the probability of the project.
- Start Date - the start date of the assignment.
- End Date - the end date of the assignment.
- Minimum Job Level - the minimum job level of the requirement.
- Maximum Job Level - the maximum job level of the requirement.
Scheduled Resource Hours (PASCHRES)

The scheduled resource hours workbook allows you to evaluate the number of hours currently scheduled within Project Resource Management by person. You can view this information by Organization and Resource Manager.

Worksheets included in this workbook are:

- Scheduled Resource Hours by GL Period
- Scheduled Resource Hours by PA Period
- Scheduled Resource Hours by Global Week

Restrictions

- When selecting an organization, the user is restricted to those within the reporting hierarchy of the operating unit associated with their responsibility.
- When selecting a resource manager, the user is restricted to those individuals that report to them or manage people they have resource authority over.

Scheduled Resource Hours by GL Period

This worksheet addresses business questions such as:

- What is the total number of hours scheduled for the people in my organization per GL period?
- What are the total number of hours scheduled for individuals in my organization per GL period?
- What does the spread of scheduled hours per GL period look like over time?
- If there is an issue with a persons scheduled hours, what projects are they assigned to?

The Scheduled Resource Hours by GL Period worksheet helps you answer these questions by letting you analyze and manipulate scheduling information by Organization, Resource Manager and Person. Additionally, you can roll the data up to Fiscal Quarter and year.

Parameter Page

Parameters are predefined conditions that you can leave on or switch off by selecting the Conditions dialogue under the Tools menu.
Organization - You can choose only one organization but the worksheet will then run for the organization chosen and any below it in the reporting hierarchy.

Resource Manager - You can choose one or more Resource Managers for whom you want to view data.

Fiscal Year - You can choose only one year.

Fiscal Quarter Number - You can choose only one quarter number for the year you have specified.

**Conditions**

Conditions are filters in the worksheet that you can turn on or off.

There are no conditions (other than those defined for the parameters listed above) predefined on this worksheet.

**Column Dimensions**

- Fiscal Year - the name of a Fiscal Year
- Fiscal Quarter - the name of a Fiscal Quarter
- GL Period - the name of a GL period
- Capacity Hours - number of hours available to work
- Total Hours - number of hours scheduled in either a provisional or confirmed status for all work types.
- Provisional Hours - number of hours scheduled in a provisional status

**Row Dimensions**

- Organization - the name of an organization.
- Resource Manager - the name of a resource manager.
- Person - the name of a person.
- Job Name - the title of the job of the person.
- Job Level - the global job level of the person.
Additional Information

The following table lists items that can be added to the Scheduled Resource Hours by GL Period worksheet:

<table>
<thead>
<tr>
<th>Business Area</th>
<th>Folder</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Staffing</td>
<td>Resource Schedule by GL Period</td>
<td>Confirmed Hours</td>
</tr>
</tbody>
</table>

**Suggestion:** A useful addition to this worksheet is a user-defined exception highlighting people whose percentage overcommitment is over a certain threshold.

It is common practice for the cells of data points meeting the exception criteria to be shown in red.

If the worksheet returns a value that requires further investigation, you should create a more detailed worksheet based on the folder Resource Schedule by GL Period: Team Role Detail. Using this folder, the actual assignments on which a given person is scheduled can be examined and manipulated. The data you can view includes:

- Project - the name of a project
- Project Manager - the name of the current project manager
- Probability - the probability of the project
- Team Role - the team role name of the assignment
- Start Date - the start date of the assignment
- End Date - the end date of the assignment
- Capacity Hours - number of hours available to work
- Total Hours - number of hours scheduled in either a provisional or confirmed status
- Provisional Hours - number of hours scheduled in a provisional status
Scheduled Resource Hours by PA Period
This worksheet addresses business questions such as:

■ What is the total number of hours scheduled for the people in my organization per PA period?
■ What are the total number of hours scheduled for individuals in my organization per PA period?
■ What does the spread of scheduled hours per PA period look like over time?
■ If there is an issue with a person's scheduled hours, what projects are they assigned to?

The Scheduled Resource Hours by PA Period worksheet helps you answer these questions by letting you analyze and manipulate scheduling information by Organization, Resource Manager and Person. Additionally, you can roll the data up to Fiscal Quarter and year.

Parameter Page
Parameters are predefined conditions that you can leave on or switch off by selecting the Conditions dialogue under the Tools menu.

■ Organization - You can choose only one organization but the worksheet will then run for the organization chosen and any below it in the reporting hierarchy.
■ Resource Manager - You can choose one or more Resource Managers for whom you want to view data.
■ Fiscal Year - You can choose only one year.
■ Fiscal Quarter Number - You can choose only one quarter number for the year you have specified.

Conditions
Conditions are filters in the worksheet that you can turn on or off.
There are no conditions (other than those defined for the parameters listed above) predefined on this worksheet.

Column Dimensions
■ Fiscal Year - the name of a Fiscal Year
■ Fiscal Quarter - the name of a Fiscal Quarter
■ PA Period - the name of a PA period
■ Capacity Hours - number of hours available to work
■ Total Hours - number of hours scheduled in either a provisional or confirmed status for all work types.
■ Provisional Hours - number of hours scheduled in a provisional status

Row Dimensions
■ Organization - the name of an organization.
■ Resource Manager - the name of a resource manager.
■ Person - the name of a person.
■ Job Name - the title of the job of the person.
■ Job Level - the global job level of the person.

Additional Information
The following table lists items that can be added to the Scheduled Resource Hours by PA Period worksheet:

<table>
<thead>
<tr>
<th>Business Area</th>
<th>Folder</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Staffing</td>
<td>Resource Schedule by PA Period</td>
<td>Confirmed Hours</td>
</tr>
</tbody>
</table>

**Suggestion:** A useful addition to this worksheet is a user-defined exception highlighting people whose percentage over-commitment is over a certain threshold.

It is common practice for the cells of data points meeting the exception criteria to be shown in red.

If the worksheet returns a value that requires further investigation, you should create a more detailed worksheet based on the folder Resource Schedule by PA Period: Team Role Detail. Using this folder, the actual assignments on which a given person is scheduled can be examined and manipulated. The data you can view includes:

■ Project - the name of a project.
■ Project Manager - the name of the current project manager.
■ Probability - the probability of the project.
■ Team Role - the team role name of the assignment.
■ Start Date - the start date of the assignment.
■ End Date - the end date of the assignment.
■ Capacity Hours - number of hours available to work
■ Total Hours - number of hours scheduled in either a provisional or confirmed status
■ Provisional Hours - number of hours scheduled in a provisional status

**Scheduled Resource Hours by Global Week**

This worksheet addresses business questions such as:

■ What is the total number of hours scheduled for the people in my organization per Global Week?
■ What are the total number of hours scheduled for individuals in my organization per Global Week?
■ What does the spread of scheduled hours per Global Week look like over time?
■ If there is an issue with a person's scheduled hours, what projects are they assigned to?

The Scheduled Resource Hours by Global Week worksheet helps you answer these questions by letting you analyze and manipulate scheduling information by Organization, Resource Manager and Person. Additionally, you can drill down to view the data by day (to view the hours per day).

**Parameter Page**

Parameters are predefined conditions that you can leave on or switch off by selecting the Conditions dialogue under the Tools menu.

■ Organization - You can choose only one organization but the worksheet will then run for the organization chosen and any below it in the reporting hierarchy.
■ Resource Manager - You can choose one or more Resource Managers for whom you want to view data.
■ Calendar Year - You can choose only one year.
- Calendar Month - You can choose only one calendar month for the year you have specified.

**Conditions**
Conditions are filters in the worksheet that you can turn on or off.

There are no conditions (other than those defined for the parameters listed above) predefined on this worksheet.

**Column Dimensions**
- Calendar Year - the name of a calendar year
- Calendar Month - the name of a calendar month
- Global Week - the name of a global week
- Day - the name of a day
- Capacity Hours - number of hours available to work
- Total Hours - number of hours scheduled in either a provisional or confirmed status for all work types.
- Provisional Hours - number of hours scheduled in a provisional status

**Row Dimensions**
- Organization - the name of an organization.
- Resource Manager - the name of a resource manager.
- Person - the name of a person.
- Job Name - the title of the job of the person.
- Job Level - the global job level of the person.

**Additional Information**
The following table lists items that can be added to the Scheduled Resource Hours by Global Week worksheet:

<table>
<thead>
<tr>
<th>Business Area</th>
<th>Folder</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Staffing</td>
<td>Resource Schedule and Capacity by Global Week</td>
<td>Confirmed Hours</td>
</tr>
</tbody>
</table>
It is common practice for the cells of data points meeting the exception criteria to be shown in red.

If the worksheet returns a value that requires further investigation, you should create a more detailed worksheet based on the folder Resource Schedule by Global Week: Team Role Detail. Using this folder, the actual assignments on which a given person is scheduled can be examined and manipulated. The data you can view includes:

- **Project** - the name of a project
- **Project Manager** - the name of the current project manager
- **Probability** - the probability of the project
- **Team Role** - the team role name of the assignment
- **Start Date** - the start date of the assignment
- **End Date** - the end date of the assignment
- **Capacity Hours** - number of hours available to work
- **Total Hours** - number of hours scheduled in either a provisional or confirmed status for all work types.
- **Provisional Hours** - number of hours scheduled in a provisional status

### Available Resource Hours (PAAVLRES)

The Available Resource Hours workbook allows you to evaluate the number of capacity hours that are currently not scheduled within Project Resource Management. You can view this information by Organization and/or Resource Manager.

Worksheets included in this workbook are:

- Available Resource Hours by GL Period
- Available Resource Hours by PA Period
- Available Resource Hours by Global Week

---

**Suggestion:** A useful addition to this worksheet is a user-defined exception highlighting people whose percentage overcommitment is over a certain threshold.
Restrictions

■ When selecting an organization, the user will be restricted to those within the reporting hierarchy of the operating unit associated with their responsibility.

■ When selecting a resource manager, the user will be restricted to those that report to them or manage people they have resource authority over.

Available Resource Hours by GL Period

This worksheet addresses business questions such as:

■ What is the total number of hours, per GL period, that people in my organization are available to work but are not scheduled?

■ What are the total number of hours, per GL period, that people who report to me are available to work but are not scheduled?

■ What does the spread of availability look like over time?

The Available Resource Hours by GL Period worksheet helps you answer these questions by letting you analyze and manipulate availability information by Organization, Resource Manager and Person. Additionally, you can roll the data up to Fiscal Quarter and year.

Parameter Page

Parameters are predefined conditions that you can leave on or switch off by selecting the Conditions dialogue under the Tools menu.

■ Organization - You can choose only one organization but the worksheet will then run for the organization chosen and any below it in the reporting hierarchy.

■ Resource Manager - You can choose one or more Resource Managers for whom you want to view data.

■ Fiscal Year - You can choose only one year.

■ Fiscal Quarter Number - You can choose only one quarter number for the year you have specified.

Conditions

Conditions are filters in the worksheet that you can turn on or off.

There are no conditions (other than those defined for the parameters listed above) predefined on this worksheet.
Column Dimensions
- Fiscal Year - the name of a Fiscal Year
- Fiscal Quarter - the name of a Fiscal Quarter
- GL Period - the name of a GL period
- Available Hours (Potential) - the number of hours unscheduled. It is equal to (Capacity Hours- Confirmed Hours- Provisional Hours).
- Available Hours (Definite) - the number of hours unscheduled or scheduled in a provisional status. It is equal to (Capacity Hours- Confirmed Hours).
- Availability % (Potential) - the number of hours unscheduled divided by the capacity. It is equal to (Capacity Hours- Confirmed Hours- Provisional Hours)/Capacity*100.
- Availability % (Definite) - the number of hours unscheduled or schedules in a provisional status divided by the capacity. It is equal to (Capacity Hours-Confirmed Hours)/Capacity*100.

Row Dimensions
- Organization - the name of an organization.
- Resource Manager - the name of a resource manager.
- Person - the name of a person.
- Job Name - the title of the job of the person.
- Job Level - the global job level of the person.

Additional Information
The following table lists items that can be added to the Available Resource Hours by GL Period worksheet:

<table>
<thead>
<tr>
<th>Business Area</th>
<th>Folder</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Staffing</td>
<td>Resource Schedule by GL Period</td>
<td>Confirmed Hours</td>
</tr>
<tr>
<td>Staffing</td>
<td>Resource Schedule by GL Period</td>
<td>Provisional Hours</td>
</tr>
<tr>
<td>Staffing</td>
<td>Resource Schedule by GL Period</td>
<td>Total Hours</td>
</tr>
</tbody>
</table>
Available Resource Hours by PA Period
This worksheet addresses business questions such as:

- What is the total number of hours, per PA period, that people in my organization are available to work but are not scheduled?
- What are the total number of hours, per PA period, that people who report to me are available to work but are not scheduled?
- What does the spread of availability look like over time?

The Available Resource Hours by PA Period worksheet helps you answer these questions by letting you analyze and manipulate availability information by Organization, Resource Manager and Person. Additionally, you can roll the data up to Fiscal Quarter and year.

Parameter Page
Parameters are predefined conditions that you can leave on or switch off by selecting the Conditions dialogue under the Tools menu.

- Organization - You can choose only one organization but the worksheet will then run for the organization chosen and any below it in the reporting hierarchy.
- Resource Manager - You can choose one or more Resource Managers for whom you want to view data.
- Fiscal Year - You can choose only one year.
- Fiscal Quarter Number - You can choose only one quarter number for the year you have specified.

Conditions
Conditions are filters in the worksheet that you can turn on or off.

There are no conditions (other than those defined for the parameters listed above) predefined on this worksheet.
Column Dimensions

- Fiscal Year - the name of a Fiscal Year
- Fiscal Quarter - the name of a Fiscal Quarter
- PA Period - the name of a PA period
- Available Hours (Potential) - the number of hours unscheduled. It is equal to (Capacity Hours- Confirmed Hours- Provisional Hours).
- Available Hours (Definite) - the number of hours unscheduled or scheduled in a provisional status. It is equal to (Capacity Hours- Confirmed Hours).
- Availability % (Potential) - the number of hours unscheduled divided by the capacity. It is equal to (Capacity Hours- Confirmed Hours- Provisional Hours)/Capacity*100.
- Availability % (Definite) - the number of hours unscheduled or schedules in a provisional status divided by the capacity. It is equal to (Capacity Hours-Confirmed Hours)/Capacity*100.

Row Dimensions

- Organization - the name of an organization.
- Resource Manager - the name of a resource manager.
- Person - the name of a person.
- Job Name - the title of the job of the person.
- Job Level - the global job level of the person.

Additional Information

The following table lists items that can be added to the Available Resource Hours by PA Period worksheet:

<table>
<thead>
<tr>
<th>Business Area</th>
<th>Folder</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Staffing</td>
<td>Resource Schedule by PA Period</td>
<td>Confirmed Hours</td>
</tr>
<tr>
<td>Staffing</td>
<td>Resource Schedule by PA Period</td>
<td>Provisional Hours</td>
</tr>
<tr>
<td>Staffing</td>
<td>Resource Schedule by PA Period</td>
<td>Total Hours</td>
</tr>
</tbody>
</table>
Available Resource Hours by Global Week

Some of the business questions answered by this worksheet are:

- What is the total number of hours, per Global Week, that people in my organization are available to work but are not scheduled?
- What are the total number of hours, per Global Week, that people who report to me are available to work but are not scheduled?
- What does the spread of availability look like over time?

The Available Resource Hours by Global Week worksheet helps you answer these questions by letting you analyze and manipulate availability information by Organization, Resource Manager and Person. Additionally, you can drill down to view availability by day.

Parameter Page

Parameters are predefined conditions that you can leave on or switch off by selecting the Conditions dialogue under the Tools menu.

- Organization - You can choose only one organization but the worksheet will then run for the organization chosen and any below it in the reporting hierarchy.
- Resource Manager - You can choose one or more Resource Managers for whom you want to view data.
- Calendar Year - You can choose only one year.
- Calendar Month - You can choose only one month for the year you have specified.

Conditions

Conditions are filters in the worksheet that you can turn on or off.

There are no conditions (other than those defined for the parameters listed above) predefined on this worksheet.
Column Dimensions
- Calendar Year - the name of a calendar year
- Calendar Month - the name of a Fiscal Quarter
- Global Week - the name of a Global Week
- Day - the name of a day
- Available Hours (Potential) - the number of hours unscheduled. It is equal to (Capacity Hours - Confirmed Hours - Provisional Hours).
- Available Hours (Definite) - the number of hours unscheduled or scheduled in a provisional status. It is equal to (Capacity Hours - Confirmed Hours).
- Availability % (Potential) - the number of hours unscheduled divided by the capacity. It is equal to (Capacity Hours - Confirmed Hours - Provisional Hours)/Capacity*100.
- Availability % (Definite) - the number of hours unscheduled or schedules in a provisional status divided by the capacity. It is equal to (Capacity Hours - Confirmed Hours)/Capacity*100.

Row Dimensions
- Organization - the name of an organization
- Resource Manager - the name of a resource manager
- Person - the name of a person
- Job Name - the title of the job of the person
- Job Level - the global job level of the person

Additional Information
The following table lists items that can be added to the Available Resource Hours by Global Week worksheet in the Staffing business area:

<table>
<thead>
<tr>
<th>Business Area</th>
<th>Folder</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Staffing</td>
<td>Resource Schedule by Global Week</td>
<td>Confirmed Hours</td>
</tr>
<tr>
<td>Staffing</td>
<td>Resource Schedule by Global Week</td>
<td>Provisional Hours</td>
</tr>
<tr>
<td>Staffing</td>
<td>Resource Schedule by Global Week</td>
<td>Total Hours</td>
</tr>
<tr>
<td>Staffing</td>
<td>Resource Capacity by Global Week</td>
<td>Capacity Hours</td>
</tr>
</tbody>
</table>
Overcommitted Resource Hours (PAOVCRE)

The overcommitted resource hours workbook allows you to evaluate the number of hours people are currently scheduled over their capacity. You can view this information by Organization and Resource Manager.

Worksheets included in this workbook are:
- Overcommitted Resource Hours by GL Period
- Overcommitted Resource Hours by PA Period
- Overcommitted Resource Hours by Global Week

Restrictions
- When selecting an organization, the user will be restricted to those within the reporting hierarchy of the operating unit associated with their responsibility.
- When selecting a resource manager, the user will be restricted to those that report to them or manage people they have resource authority over.

Overcommitted Resource Hours by GL Period
This worksheet addresses business questions such as:
- What is the total number of overcommitted hours for the people in my organization per GL period?
- What are the total number of overcommitted hours for individuals in my organization per GL period?
- What does the spread of overcommitted hours per GL period look like over time?
- If a person is overcommitted, what assignments have caused this?

The Overcommitted Resource Hours by GL Period worksheet helps you answer these questions by letting you analyze and manipulate capacity and overcommitment information by Organization, Resource Manager and Person. Additionally, you can roll the data up to Fiscal Quarter and year.

Parameter Page
Parameters are predefined conditions that you can leave on or switch off by selecting the Conditions dialogue under the Tools menu.
Discoverer Workbooks

- Organization - You can choose only one organization but the worksheet will then run for the organization chosen and any below it in the reporting hierarchy.
- Resource Manager - You can choose one or more Resource Managers for whom you want to view data.
- Fiscal Year - You can choose only one year.
- Fiscal Quarter Number - You can choose only one quarter number for the year you have specified.

Conditions

Conditions are filters in the worksheet that you can turn on or off.

There are no conditions (other than those defined for the parameters listed above) predefined on this worksheet.

Column Dimensions

- Fiscal Year - the name of a Fiscal Year
- Fiscal Quarter - the name of a Fiscal Quarter
- GL Period - the name of a GL period
- Capacity Hours - number of hours available to work
- Confirmed Hours - number of hours scheduled with a confirmed status
- Overcommitted Hours - number of hours scheduled with a confirmed status minus capacity
- Overcommitted percentage - number of over-committed hours divided by capacity

Row Dimensions

- Organization - the name of an organization.
- Resource Manager - the name of a resource manager.
- Person - the name of a person.
- Job Name - the title of the job of the person.
- Job Level - the global job level of the person.
Additional Information

The table that follows lists items that can be added to the Scheduled Resource Hours by GL Period worksheet in the Staffing business area:

<table>
<thead>
<tr>
<th>Business Area</th>
<th>Folder</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Staffing</td>
<td>Resource Schedule by GL Period</td>
<td>Total Hours</td>
</tr>
<tr>
<td>Staffing</td>
<td>Resource Schedule by GL Period</td>
<td>Provisional Hours</td>
</tr>
</tbody>
</table>

**Suggestion:** A useful addition to this worksheet is a user-defined exception highlighting people whose percentage overcommitment is over a certain threshold.

It is common practice for the cells of data points meeting the exception criteria to be shown in red.

If the worksheet returns a value that requires further investigation, you should create a more detailed worksheet based on the folder Resource Schedule by GL Period: Team Role Detail. Using this folder, the actual assignments on which a given person is scheduled can be examined and manipulated. The data you can view includes:

- Project - the name of a project.
- Project Manager - the name of the current project manager
- Probability - the probability of the project
- Team Role - the team role name of the assignment
- Start Date - the start date of the assignment
- End Date - the end date of the assignment
- Confirmed Hours - number of hours scheduled in a confirmed status

**Overcommitted Resource Hours by PA Period**

This worksheet addresses business questions such as:

- What is the total number of overcommitted hours for the people in my organization per PA period?
What are the total number of overcommitted hours for individuals in my organization per PA period?

What does the spread of overcommitted hours per PA period look like over time?

If a person is overcommitted, what assignments have caused this?

The Resource Hours by PA Period worksheet helps you answer these questions by letting you analyze and manipulate capacity and overcommitment information by Organization, Resource Manager and Person. Additionally, you can roll the data up to Fiscal Quarter and year.

**Parameter Page**
Parameters are predefined conditions that you can leave on or switch off by selecting the Conditions dialogue under the Tools menu.

- **Organization** - You can choose only one organization but the worksheet will then run for the organization chosen and any below it in the reporting hierarchy.
- **Resource Manager** - You can choose one or more Resource Managers for whom you want to view data.
- **Fiscal Year** - You can choose only one year.
- **Fiscal Quarter Number** - You can choose only one quarter number for the year you have specified.

**Conditions**
Conditions are filters in the worksheet that you can turn on or off. There are no conditions (other than those defined for the parameters listed above) predefined on this worksheet.

**Column Dimensions**
- **Fiscal Year** - the name of a Fiscal Year
- **Fiscal Quarter** - the name of a Fiscal Quarter
- **PA Period** - the name of a PA period
- **Capacity Hours** - number of hours available to work
- **Confirmed Hours** - number of hours scheduled with a confirmed status
- Overcommitted Hours - number of hours scheduled with a confirmed status minus capacity
- Overcommitted percentage - number of overcommitted hours divided by capacity

**Row Dimensions**
- Organization - the name of an organization
- Resource Manager - the name of a resource manager
- Person - the name of a person
- Job Name - the title of the job of the person
- Job Level - the global job level of the person

**Additional Information**
The following table lists items that can be added to the Overcommitted Resource Hours by PA Period worksheet in the Staffing business area:

<table>
<thead>
<tr>
<th>Business Area</th>
<th>Folder</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Staffing</td>
<td>Resource Schedule by GL Period</td>
<td>Total Hours</td>
</tr>
<tr>
<td>Staffing</td>
<td>Resource Schedule by GL Period</td>
<td>Provisional Hours</td>
</tr>
</tbody>
</table>

**Suggestion:** A useful addition to this worksheet is a user-defined exception highlighting people whose percentage over-commitment is over a certain threshold.

It is common practice for the cells of data points meeting the exception criteria to be shown in red.

If the worksheet returns a value that requires further investigation, you should create a more detailed worksheet based on the folder Resource Schedule by PA Period: Team Role Detail. Using this folder, the actual assignments on which a given person is scheduled can be examined and manipulated. The data you can view includes:

- Project - the name of a project
- Project Manager - the name of the current project manager
■ Probability - the probability of the project
■ Team Role - the team role name of the assignment
■ Start Date - the start date of the assignment
■ End Date - the end date of the assignment
■ Confirmed Hours - number of hours scheduled in a confirmed status

Overcommitted Resource Hours by Global Week
This worksheet addresses business questions such as:
■ What is the total number of overcommitted hours for the people in my organization per Global Week or Day?
■ What are the total number of overcommitted hours for individuals in my organization per Global Week or Day?
■ What does the spread of overcommitted hours per Global Week or Day look like over time?
■ If a person is overcommitted, what assignments have caused this?

The Overcommitted Resource Hours by Global Week worksheet helps you answer these questions by letting you analyze and manipulate capacity and overcommitment information by Organization, Resource Manager and Person. Additionally, you can drill down to view the data by day (to view the hours per day).

Parameter Page
Parameters are predefined conditions that you can leave on or switch off by selecting the Conditions dialogue under the Tools menu.
■ Organization - You can choose only one organization but the worksheet will then run for the organization chosen and any below it in the reporting hierarchy.
■ Resource Manager - You can choose one or more Resource Managers for whom you want to view data.
■ Calendar Year - You can choose only one year.
■ Calendar Month - You can choose only one calendar month for the year you have specified.
Conditions
Conditions are filters in the worksheet that you can turn on or off.

There are no conditions (other than those defined for the parameters listed above) predefined on this worksheet.

Column Dimensions
■ Calendar Year - the name of a calendar year
■ Calendar Month - the name of a calendar month
■ Global Week - the name of a global week
■ Day - the name of a day
■ Capacity Hours - number of hours available to work
■ Confirmed Hours - number of hours scheduled with a confirmed status
■ Overcommitted Hours - number of hours scheduled with a confirmed status minus capacity
■ Overcommitted percentage - number of over-committed hours divided by capacity

Row Dimensions
■ Organization - the name of an organization.
■ Resource Manager - the name of a resource manager.
■ Person - the name of a person.
■ Job Name - the title of the job of the person.
■ Job Level - the global job level of the person.

Additional Information
The following table lists items that you can add to the Overcommitted Resource Hours by Global Week worksheet in the Staffing business area:

<table>
<thead>
<tr>
<th>Business Area</th>
<th>Folder</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Staffing</td>
<td>Resource Schedule by GL Period</td>
<td>Total Hours</td>
</tr>
<tr>
<td>Staffing</td>
<td>Resource Schedule by GL Period</td>
<td>Provisional Hours</td>
</tr>
</tbody>
</table>
It is common practice for the cells of data points meeting the exception criteria to be shown in red.

If the worksheet returns a value that requires further investigation, you should create a more detailed spreadsheet based on the folder Resource Schedule by Global Week: Team Role Detail. Using this folder, the actual assignments on which a given person is scheduled can be examined and manipulated. The data you can view includes:

- Project - the name of a project
- Project Manager - the name of the current project manager
- Probability - the probability of the project
- Team Role - the team role name of the assignment
- Start Date - the start date of the assignment
- End Date - the end date of the assignment
- Confirmed Hours - number of hours scheduled in a confirmed status

**Project Pipeline Workbook (PASALPIP)**

The Project Pipeline workbook allows you to view the value of projects currently within your pipeline. You can view this information by Organization and/or Resource Manager. Thus, you can now track potential revenue attributable to different classification codes with varying percentages.

You can run the report to view all projects that have a selected project role. The report shows projects that have one or more classification category defined with a single or multiple class codes. If the project has classification category with percentage values for each class code then the various values in the report re-split according to the specified percentage.

Worksheets included in this workbook are:

- **Project Pipeline by Fiscal Year**
- **Project Pipeline by Fiscal Quarter**

**Suggestion:** A useful addition to this worksheet is a user-defined exception highlighting people whose percentage over-commitment is over a certain threshold.
■ Project Pipeline by GL Period
■ Project Pipeline by PA Period

In all worksheets, null values are displayed as 0.

Restrictions
■ When selecting an organization, the user is restricted to those they have forecasting authority over and that are also within the reporting hierarchy of the operating unit associated with their responsibility.

Project Pipeline by Fiscal Year
This worksheet addresses business questions such as:
■ What is my organization’s total/discounted Project Pipeline up to and including a particular Fiscal Year?
■ What is the total/discounted project pipeline of project’s I will manage up to and including a particular Fiscal Year?
■ How is the project pipeline spread across all industries up to and including a particular Fiscal Year?

The Project Pipeline by Fiscal Year worksheet helps you answer these questions by letting you analyze and manipulate project value and probability information by Class Category, Organization and/or Project Manager.

Parameter Page
Parameters are predefined conditions that you can leave on or switch off by selecting the Conditions dialogue under the Tools menu.
■ Organization - You can choose only one organization but the worksheet will then run for the organization chosen and any below it in the reporting hierarchy.
■ Classification Category - You can choose only one classification category. Your project pipeline will then be displayed by the classification codes within the category chosen. The list of Class Categories parameter shows all categories and not just the categories with one class code defined.
■ Fiscal Year - You can choose only one year but the worksheet will also include any projects still in the pipeline that have expected approval dates prior to the year specified.
■ Project Manager - You can choose one or more project managers. Project Pipeline will only be shown for projects managed by the project managers selected.

■ Include Values Over - a currency value that the total project pipeline figure must be greater than in order for the project to be displayed.

■ Project Role: You can choose a project role to view the pipeline projects that have the specified project role.

■ Project Member: You can choose a resource to view the pipeline projects that have the resource.

■ Project Status: You can choose the project status parameter to include the projects with all project statuses. By default, the value of Project Status parameter is Unapproved.

---

**Note:** The Project Status parameter is available when using Discoverer 4i only.

---

**Conditions**

Conditions are filters in the worksheet that you can turn on or off.

■ Include Probabilities Under - a numeric value that the project probability must be less than in order for the project to be displayed. Defaults to 100.

**Column Dimensions**

■ Fiscal Year - the name of the Fiscal Year

■ Total Value - the total project value

■ Discounted Value - the total project value multiplied by the probability of the project.

■ Class Code: the class code defined for the classification category.

**Row Dimensions**

■ Organization - the name of an organization.

■ Classification Code - the classification code within the classification category.

■ Project - the name of a project.

■ Primary Customer Name - the name of the primary customer.
■ Project Probability - the current project probability.
■ Type - the name of the project type on which the project is based.
■ Status - the status of the project
■ Expected Approval Date - the date on which the project approval is expected

**Project Pipeline by Fiscal Quarter**

This worksheet addresses business questions such as:

■ What is my organization’s total/discounted Project Pipeline up to and including a particular Fiscal Quarter?
■ What is the total/discounted Project Pipeline of project’s I will up to and including a particular Fiscal Quarter?
■ How is the project pipeline spread across all industries up to and including a particular Fiscal Quarter?

The Project Pipeline by Fiscal Quarter worksheet helps you answer these questions by letting you analyze and manipulate project value and probability information by Class Category, Organization and/or Project Manager.

**Parameter Page**

Parameters are predefined conditions that you can leave on or switch off by selecting the Conditions dialogue under the Tools menu.

■ Organization - You can choose only one organization but the worksheet will then run for the organization chosen and any below it in the reporting hierarchy.

■ Classification Category - You can choose only one classification category. Your project pipeline will then be displayed by the classification codes within the category chosen. The list of Class Categories parameter shows all categories and not just the categories with one class code defined.

■ Fiscal Year - You can choose only one year but the worksheet will also include any projects still in the pipeline that have expected approval dates prior to the year specified.

■ Fiscal Quarter Number - You can choose only one quarter number but the worksheet will also include any projects still in the pipeline that have expected approval dates prior to the quarter specified.
Project Manager - You can choose one or more project managers. Project pipeline will only be shown for projects managed by the project managers selected.

Include Values Over - a currency value that the total project pipeline figure must be greater than in order for the project to be displayed.

Project Role: You can choose a project role to view the pipeline projects that have the specified project role.

Project Member: You can choose a resource to view the pipeline projects that have the resource.

Project Status: You can choose the project status parameter to include the projects with all project statuses. You can choose the project status parameter to include the projects with all project statuses. By default, the value of Project Status parameter is Unapproved.

Note: The Project Status parameter is available when using Discoverer 4i only.

Conditions
Conditions are filters in the worksheet that you can turn on or off.

Include Probabilities Under - a numeric value that the project probability must be less than in order for the project to be displayed. Defaults to 100.

Column Dimensions
- Fiscal Year - the name of the Fiscal Year
- Fiscal Quarter - the name of the Fiscal Quarter
- Total Value - the total project value
- Discounted Value - the total project value multiplied by the probability of the project.
- Class Code: the class code defined for the classification category.

Row Dimensions
- Organization - the name of an organization.
- Classification Code - the classification code within the classification category.
- Project - the name of a project.
■ Primary Customer Name- the name of the primary customer.
■ Project Probability - the current project probability.
■ Type - the name of the project type on which the project is based.
■ Status - the status of the project

Project Pipeline by GL Period
This worksheet addresses business questions such as:
■ What is my organization’s total/discounted Project Pipeline up to and including a particular GL period?
■ What is the total/discounted Project Pipeline of project’s I will manage up to and including a particular GL period?
■ How is the project pipeline spread across all industries up to and including a particular GL period?

The Project Pipeline by GL period worksheet helps you answer these questions by letting you analyze and manipulate project value and probability information by Class Category, Organization and/or Project Manager.

Parameter Page
Parameters are predefined conditions that you can leave on or switch off by selecting the Conditions dialogue under the Tools menu.
■ Organization - You can choose only one organization but the worksheet will then run for the organization chosen and any below it in the reporting hierarchy.
■ Classification Category - You can choose only one classification category. Your project pipeline will then be displayed by the classification codes within the category chosen. The list of Class Categories parameter shows all categories and not just the categories with one class code defined.
■ Fiscal Year - You can choose only one year but the worksheet will also include any projects still in the pipeline that have expected approval dates prior to the year specified.
■ Fiscal Quarter Number - You can choose only one quarter number but the worksheet will also include any projects still in the pipeline that have expected approval dates prior to the quarter specified.
Discoverer Workbooks

- Project Manager - You can choose one or more project managers. Project pipeline will only be shown for projects managed by the project managers selected.
- Include Values Over - a currency value that the total project pipeline figure must be greater than in order for the project to be displayed.
- Project Role: You can choose a project role to view the pipeline projects that have the specified project role.
- Project Member: You can choose a resource to view the pipeline projects that have the resource.
- Project Status: You can choose the project status parameter to include the projects with all project statuses. By default, the value of Project Status parameter is Unapproved.

Note: The Project Status parameter is available when using Discoverer 4i only.

Conditions
Conditions are filters in the worksheet that you can turn on or off.
- Include Probabilities Under - a numeric value that the project probability must be less than in order for the project to be displayed. Defaults to 100.

Column Dimensions
- Fiscal Year - the name of the Fiscal Year
- Fiscal Quarter - the name of the Fiscal Quarter
- GL Period - the name of the GL period
- Total Value - the total project value
- Discounted Value - the total project value multiplied by the probability of the project.
- Class Code: the class code defined for the classification category.

Row Dimensions
- Organization - the name of an organization.
- Classification Code - the classification code within the classification category.
■ Project - the name of a project.
■ Primary Customer - the name of the primary customer.
■ Project Probability - the current project probability.
■ Type - the name of the project type on which the project is based.
■ Status - the status of the project

**Project Pipeline by PA Period**

This worksheet addresses business questions such as:

■ What is my organization’s total/discounted Project Pipeline up to and including a particular PA period?
■ What is the total/discounted Project Pipeline of project’s I will manage up to and including a particular PA period?
■ How is the project pipeline spread across all industries up to and including a particular PA period?

The Project Pipeline by PA period worksheet helps you answer these questions by letting you analyze and manipulate project value and probability information by Class Category, Organization and Project Manager.

**Parameter Page**

Parameters are predefined conditions that you can leave on or switch off by selecting the Conditions dialog under the Tools menu.

■ Organization - You can choose only one organization but the worksheet will then run for the organization chosen and any below it in the reporting hierarchy.
■ Classification Category - You can choose only one classification category. Your project pipeline will then be displayed by the classification codes within the category chosen. The list of Class Categories parameter shows all categories and not just the categories with one class code defined.
■ Fiscal Year - You can choose only one year but the worksheet will also include any projects still in the pipeline that have expected approval dates prior to the year specified.
■ Fiscal Quarter Number - You can choose only one quarter number but the worksheet will also include any projects still in the pipeline that have expected approval dates prior to the quarter specified.
Project Manager - You can choose one or more project managers. Project pipeline will only be shown for projects managed by the project managers selected.

Include Values Over - a currency value that the total project pipeline figure must be greater than in order for the project to be displayed.

Project Role: You can choose a project role to view the pipeline projects that have the specified project role.

Project Member: You can choose a resource to view the pipeline projects that have the resource.

Project Status: You can choose the project status parameter to include the projects with all project statuses. By default, the value of Project Status parameter is Unapproved.

Note: The Project Status parameter is available when using Discoverer 4i only.

Conditions
Conditions are filters in the worksheet that you can turn on or off.

Include Probabilities Under - a numeric value that the project probability must be less than in order for the project to be displayed. Defaults to 100.

Column Dimensions
- Fiscal Year - the name of the Fiscal Year
- Fiscal Quarter - the name of the Fiscal Quarter
- PA Period - the name of the PA period
- Total Value - the total project value
- Discounted Value - the total project value multiplied by the probability of the project.
- Class Code: the class code defined for the classification category.

Row Dimensions
- Organization - the name of an organization
- Classification Code - the classification code within the classification category
Discoverer Workbooks

Setting Up for Reporting Capabilities

- Project - the name of a project
- Primary Customer - the name of the primary customer.
- Project Probability - the current project probability
- Type - the name of the project type on which the project is based
- Status - the status of the project
- Expected Approval Date - the date on which the project approval is expected

**Organization Competence Summary Workbook (PA_PRM_ORG_COMP_SUM)**

The organization competence summary workbook enables you to view a summary of your resources’ competencies in your organization.

---

**Note:** This workbook is built on Discoverer 4i only

---

Worksheets included in this workbook are:

- Organization Competence Summary
- Resource Listing for Organization and Competence

In all worksheets, null values are displayed as 0.

**Restrictions**

You can view the resources that you have organization authority or are a Resource Manager.

**Organization Competence Summary Worksheet**

This worksheet addresses business questions such as:

- What is the spread of competencies across the resources in my organization?
- Where am I low in resources having certain competencies?
- What resource skills need to be improved?

The Organization Competence Summary worksheet helps you answer these questions by letting you review and analyze the competencies of your resources within your organization and enable you to drill down to another report for further information.
The worksheet displays only resources who have current or future assignments that belong to the selected organization.

**Parameter Page**
Parameters are enabled predefined conditions that you can disable by selecting the Conditions dialogue under the Tools menu.

- **Organization** - You can select an organization that the resource belongs to.
- **Include Sub-Organizations** - You can choose to include sub-organizations within the organization hierarchy. The hierarchy used for sub-organizations is the Reporting Hierarchy from the starting organization selected above.
- **Competence Name** - You can select to view resources with a particular competence across all business groups.

**Conditions**
Conditions are filters in the worksheet that you enable or disable.

No conditions, other than those defined for the parameters listed above, exist for this worksheet.

**Column Dimensions**
- **Alias** - a short name for the competence
- **Description** - the description of the competence
- **Resource Count** - the total number of resources who have the competence
- **View Resources** - the link to the list of resources who have the competence

**Row Dimensions**
- **Organization** - Organization of the resource
- **Competence Name** - the name of the competence

**Additional Information**
The following table lists items that can be added to the Organization Competence Summary Worksheet in the Staffing business area:

<table>
<thead>
<tr>
<th>Business Area</th>
<th>Folder</th>
<th>Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Competencies</td>
<td>Organization Competence Summary</td>
<td>Segments 1...20, Business Group</td>
</tr>
</tbody>
</table>
Resource Listing for Organization and Competence Worksheet

This worksheet addresses business questions such as:

- Who are the resources that have a particular competence?
- Which resource skills need to be updated?

The Resource Listing for Organization and Competence worksheet helps you answer these questions by showing you details of all resources within an organization who have a particular competence and their respective proficiency level.

Parameter Page

Parameters are enabled predefined conditions that you can disable by selecting the Conditions dialogue under the Tools menu.

- Organization - You can select an organization. The worksheet shows the organization chosen and any below it in the reporting hierarchy.
- Competence Name- You can select a particular competence across all business groups.

Conditions

Conditions are filters in the worksheet that you enable or disable.

No conditions, other than those defined for the parameters listed above, exist for this worksheet.

Column Dimensions

- Proficiency Level- the proficiency level of the competence of the resource
- Manager- the name of the manager of the resource
- Job Name- the job of the resource
- Project Job Level- the global job level of the resource
- Project Job Code- the project code of the job
- Location- the primary address of the resource
- View Competence Details- the link to the competence details of the resource.

Row Dimensions

- Person- the full name of the resource
Resource Competencies Workbook (PA_PRM_RES_COMP)

The Resource Competencies workbook enables you to view a complete listing of the competencies for all the resources, by organization. For each resource, you can drill down to the Resource Competencies Details page to view the competencies of the resource.

---

**Note**: This workbook is built on Discoverer 4i only

Worksheets included in this workbook are:

- Organization Resource Competencies
- Project Resource Competencies
- Resource Competence Details

**Restrictions**

You can view the resources that you have organization authority for or are a Resource Manager.

**Organization Resource Competencies**

This worksheet addresses business questions such as:

- What competencies do resources in my organization have?
- What is the proficiency level of the competencies?

The Organization Resource Competencies worksheet helps you answer these questions by showing you all resources for an organization or group of organizations, the competencies of each resource and the proficiency level of those competencies. You can also view the competence spread by jobs and job levels.

**Parameter Page**

Parameters are enabled predefined conditions that you can disable by selecting the Conditions dialogue under the Tools menu.

- Organization - You can select an organization.
- Include Sub-Organizations - You can choose to include sub-organizations within the organization hierarchy. The hierarchy used for sub-organizations is the Reporting Hierarchy from the starting organization selected above.
Manager- You can choose a Resource Manager to limit the resources in the report to the ones who report to the selected Resource Manager.

Resource- You can choose only one resource name.

Job- You can choose the job name of the resource. All jobs across business groups are shown.

Job Level- You can choose the global job level of the resource. All levels across business groups are shown.

Billable Job Only- You can choose to include only resources that have a billable job.

Conditions

Conditions are filters in the worksheet that you enable or disable.

No conditions, other than those defined for the parameters listed above, exist for this worksheet.

Column Dimensions

- Competencies - a listing of all the competence aliases of the resource, prefixed by the proficiency level of the competence. If the competence does not have a alias than the competence name is used.
- Competence Count- the total number of competencies of the resource
- Manager- the name of the manager of the resource
- Last Updated- the latest date the competence profile of resource was updated
- Job- the job of the resource
- Project Job Level- the global job level of the resource
- Job Code- the job code of the resource
- View Competencies Details- the link to view the detail competencies of the resource

Row Dimensions

- Organization - The organization of the resource
- Person- the name of the resource
Project Resource Competencies
This worksheet addresses business questions such as:
■ What competencies do my project’s resources have?
■ What is the proficiency of the competencies?

The Project Resource Competencies worksheet helps you answer these questions by showing you all resources in each project, the competencies for each resource and the proficiency level of those competencies.

Parameter Page
Parameters are enabled predefined conditions that you can disable by selecting the Conditions dialogue under the Tools menu.
■ Project Name- You can choose the name of the project that has resource assignments.
■ Manager- You can choose a Resource Manager to limit the resources in the report to the ones who report to the selected Resource Manager.
■ Resource- You can choose a resource name.
■ Job- You can choose the job name of the resource. All jobs across business groups are shown.
■ Job Level- You can choose the global job level of the resource. All levels across business groups are shown.
■ Billable Job Only- You can choose to include only resources that have a billable job.

Conditions
Conditions are filters in the worksheet that you enable or disable.
No conditions, other than those defined for the parameters listed above, exist for this worksheet.

Column Dimensions
■ Competencies - a listing of all the competence aliases of the resource, prefixed by the proficiency level of the competence. If the competence does not have a alias than the competence name is used.
■ Competence Count- the total number of competencies of the resource
■ Manager- the name of the resource manager
Discoverer Workbooks

- Last Updated- the latest date the competence was updated
- Job- the job of the resource
- Project Job Level- the global job level of the resource
- Job Code- the job code of the resource
- View Competencies Details- the link to view the detail competencies of the resource

Row Dimensions
- Project Name- the name of the project that has the resource assignment
- Project Number- the number of the project that has the resource assignment
- Person- the name of the resource

Resource Competence Details
This worksheet addresses business questions such as:
- What is each individual’s competence?
- What business group do they belong to?
- What is the proficiency level of their competencies?
- When were their competencies last updated?

The Resource Competence Details worksheet helps you answer these questions by showing you details of each resource competence and the proficiency level of the competencies.

Parameter Page
Parameters are enabled predefined conditions that you can disable by selecting the Conditions dialogue under the Tools menu.
- Resource- You can choose any resource who has a current or future assignment that belongs to an organization in the reporting organization hierarchy.

Conditions
Conditions are filters in the worksheet that you enable or disable.

No conditions, other than those defined for the parameters listed above, exist for this worksheet.
Column Dimensions
- Competence Alias - the short name for the competence
- Business Group Name - the name of business group to which the resource belongs
- Proficiency Level - the proficiency level of the competence of the resource
- Last Updated - the latest date the competence profile of resource was updated.

Row Dimensions
- Competence Name - the name of the competence of the resource

Additional Information
The following table lists items that can be added to the Resource Competence Details Worksheet in the Staffing business area.

<table>
<thead>
<tr>
<th>Business Area</th>
<th>Folders</th>
<th>Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Competencies</td>
<td>Resource Competence Details</td>
<td>Segments 1...20</td>
</tr>
</tbody>
</table>
Discoverer Query Tips

The following suggestions provide you with guidance while you are performing reporting activities.

Avoid Blind Queries
A blind query is a query that selects most or all of the items from a business view folder without specifying any conditions.

Why avoid Blind Queries? Since no condition is specified in a blind query, the query is not able to efficiently use the indexes created for the underlying tables. You may encounter poor query performance if your database contains a large amount of data.

Capacity, Schedule and Project Pipeline Views
When you create a workbook using any of the folders listed below, we suggest that you create the conditions outlined below. In particular, by restricting the time period for which the workbook is run it’s performance will be improved.

Project Pipeline Folders
  ■ Always join to the Classification Categories folder and specify one particular category
  ■ Always specify a period of time (such as a quarter, period, or month)

Resource Schedule Folders
  ■ Always specify a period of time (such as a quarter, period, or month)
  Use the OR statement in your condition rather than the IN statement. For example, you should use:

    Period Name = Feb-99 OR Period Name = Mar-99

instead of:

    Period Name IN (Feb-99, Mar-99)
As your data increases and changes to meet the demands of your projects, maintaining data integrity becomes more imperative. In order to ensure the accuracy of your data as changes are made, you should understand how additions and changes affect the overall structure of your data.

**Note:** If you make changes to information through Oracle forms that you want reflected in a poplist, you must stop and restart the Web server.

This chapter discusses the impact of specific data modifications. It also describes the built-in administrative processes that when run ensure that these changes are reflected throughout the application. In order to run any of the processes described in this chapter, you must have Project Super User responsibility.

The covered topics are:

- Understanding Data Processing
- Understanding the Impact of Changes to HRMS-Based Information
- Maintaining Schedules
- Maintaining Utilization Values
- Maintaining Forecast Information
Understanding Data Processing

Oracle Project Resource Management uses deferred workflow processes and administrative processes to manage changes to your data. You must configure and manage the engines for both types of processes in order to handle the volume of changes happening within your system. For more information on these technologies, refer to:

- Oracle Workflow Guide
- Oracle Application Object Library User Guide

Most of the changes you make to your data automatically update related information within the application. These changes occur without any intervention on your part. However, some changes require the use of administrative processes to ensure that the change is reflected accurately. In particular, two situations require this level of maintenance:

- If the automatic processes encounter errors due to missing or invalid setup information, or due to technical failures
  
  In this case, an administrative user is notified of the problem, and advised to run an administrative process to complete the changes.

- If the changed information is not expected to be done frequently enough to warrant an automatic process
  
  For example, if a change is made to a calendar, you must run the Create Calendar Schedules process to reflect the calendar change throughout the system.

Note: Assign at least one user to the seeded application user Projects Application Administrator. This user receives notifications regarding any encountered workflow processing errors. This user should also have the appropriate authority to run the administrative processes which assist in the correction of some of the errors.
Understanding the Impact of Changes to HRMS-Based Information

You will modify various setup and transaction data during the course of using the Oracle Project Resource Management application. Other changes may also occur to your employee data in Oracle HRMS. The system records the changes discussed in this section in a holding place until the deferred workflow process item type called HR Related Updates Workflow is run. This deferred workflow process synchronizes the HRMS data with the Projects data.

**Note:** The changes against the HR tables are recorded only if:

- the profile option PA: Licensed to Use Project Resource management is set to Yes, or
- actual utilization is implemented for at least one of the operating units

For more information on the deferred workflow processes, see "Initiating Deferred Workflow Processes" in Chapter 14, "Overview of the Predefined Workflows".

Changing Job Information

Changing job information such as job levels, billability, or utilization can have a direct impact on utilization reporting and forecast results.

**Job Levels**

Job levels determine the experience level of a particular job. For example, you can have three engineers with varying levels of experience and skill. You can change job levels by:

- changing the sequence (level) associated with the grade
- assigning a new grade to a job
- mapping a job to a new master job with a higher sequence

As you have the ability to search for resources by job levels, the job levels must be reflected accurately on the resources. Therefore, the system migrates any changes you make to the job levels to the job levels assigned to the resources.
Job Billability
Oracle Project Resource Management uses the HR jobs entities to indicate whether or not jobs are billable. This billable status also determines the billability of resources based on their assignments. Therefore, project forecasting is affected by changes to the billability status of a job.

Utilization Calculation
You can indicate whether or not to include a resource during the calculation of utilization by selecting a check box called Include in Utilization during the job setup. If you change the value of this check box, the utilization totals will reflect your change the next time the utilization totals are recalculated.

Changing Organization Information
The default operating unit (OU) and the default calendar are stored at the organization level. All resources, as well as their assignments, inherit these defaults. Therefore, if the default operating unit of the organization changes during the active period of an assignment, the assignment inherits the new operating unit for the entire assignment period.

Note: Only resources belonging to organizations identified as Expenditure organizations inherit the default operating unit from the organization.

Changing Organizational Hierarchy Information
Oracle Project Resource Management stores organizations in the reporting hierarchy to facilitate searching for resources by organizations. Therefore, changes to the organization hierarchy impact resource searches. An end date is entered on a resource if the organization to which the resource belongs is removed from the expenditure hierarchy. As a result, the resource is neither accessible for searches nor accessible for viewing through the Resource List page.
Changing Resource Information

Oracle Project Resource Management acquires information from the HRMS people tables for resources assigned to Project Expenditure organizations and all people acting as team members on a project. This acquisition occurs automatically whenever changes are made to the resource name or address. It also occurs when a person that exists in the HRMS system is not yet established as a resource and this person is being added as a project member on a project within Project Resource Management.

Changing an Assignment

Oracle Project Resource Management stores only the HR primary assignment information. Information changes on this assignment, such as the effective dates, organization, job, or supervisor changes, trigger the deferred workflow process to synchronize the Oracle HRMS data with the Oracle Project Resource Management data.
Maintaining Schedules

Every resource, requirement, and assignment has a schedule. The schedules are comprised of work patterns that include working hours and exceptions, such as vacation days. Each schedule is based on the calendar for the organization or an individually assigned calendar.

Changes to these calendars impact the schedules of the resources, requirements, and assignments differently. Oracle Project Resource Management provides the following two administrative processes to help manage these changes and to maintain consistent schedule information throughout the application:

- PRC: Generate Calendar Schedules
- PRC: Rebuild Resource Timeline

These processes update the schedules and timelines tables with changes to the calendars. For more information on setting up calendars and schedules, see Chapter 8, "Defining Calendars and Schedules".

Updating Schedules with Calendar Changes

Changes to the calendar appear on the schedules and timelines of the resources, new requirements, and new assignments only after you run a process called PRC: Generate Calendar Schedules.

Existing requirements and scheduled assignments on resource calendars are not impacted by changes. For example, if you add a holiday to the organization calendar and run the PRC: Generate Calendar Schedules process, you will not see this new holiday reflected on any existing requirements or assignment schedules. However, the availability of a person is reduced by the number of hours in the holiday period because availability is regenerated every time the process is run.

You can run the PRC: Generate Calendar Schedules process for a single calendar or a range of calendars. You should run this process each time one or more of the following events occur:

- a new calendar is created
- the work pattern for an existing calendar has changed, such as different working days or hours
- new exceptions have been applied to an existing calendar, such as the addition or deletion of a public holiday

To run this process, complete the following steps:
1. Navigate to the Submit Request screen.
2. Choose Submit and select either PRC: Generate Calendar Schedule for a Single Calendar or PRC: Generate Calendar Schedule for a Range of Calendars.
3. Enter the calendar name. If you are running the process for a range of calendars, enter the starting and ending calendar names, or leave blank to process all calendars.
4. Click Submit.

**Updating Schedules and Timelines to Reflect a New Calendar**

Availability data is transformed schedule data. This schedule data is used for displaying graphical schedule timelines. It is also used for searches, calculating utilization, and viewing non-graphical availability and overcommitment information.

When the calendar for a resource changes, you need to run two processes to update the availability data. You must first run the PRC: Generate Calendar Schedules administrative process in order to reflect the new calendar in the schedules of the resources, requirements, and assignments as is appropriate. Then, you can run a process called PRC: Rebuild Resource Timeline to reflect the change in calendar and resource availability in the timeline. This process rebuilds the availability data of one or more resources incorporating changes made to the calendar or schedule.

To run this process, complete the following steps:

1. Navigate to the Submit Request screen.
2. Choose Submit and select either PRC: Rebuild Resource Timeline for a Single Resource or PRC: Rebuild Timeline for a Range of Resources.
3. Enter the resource name. If you want to run the process for a range of resources, enter the starting and ending resource names, or leave the fields blank to run the process for all resources.
4. Click Submit.
Maintaining Utilization Values

The utilization screens provide totals on your resource utilization hours. In order to view updated totals, you must run a batch process called PRC: Generate Utilization on a regular basis. This request contains processes which create summary amounts for both forecast and actual utilization. The forecast totals are derived from the resource schedules. The actual totals are derived from actual submitted timecards.

To run this process, complete the following steps:

1. Navigate to the Submit Request screen.
2. Choose Submit > Request Set > PRC: Generate Utilization.
3. Enter the desired Actuals date range.

   A default value for the Actuals From Date is entered. This default value is the start date of the first period of the year in which the system date belongs. You can change this date as appropriate for your needs.

4. Enter the desired Forecast date range.

   A default value for the Forecast From Date is entered. This default value is the start date of the first period of the year in which the system date belongs. You can change this date as appropriate for your needs.

5. Enter the desired summary method for your organization.

   The summary method offers two choices: Incremental or Refresh. The Incremental method updates existing totals. The Refresh method deletes the organization summary totals and re-calculates the new organization summary totals. Incremental is the default value.

   **Note:** If you have made any changes to the default reporting organization hierarchy, you should select Refresh.

6. Click Submit.
Maintaining Forecast Information

Oracle Project Resource Management creates forecast information based on assignments and requirements every time the schedule is created. Each day of an assignment is treated as a potential forecast transaction and is considered for forecast calculation based on the defined calculation period such as GL Period or PA Period. An error is generated for each assignment that does not have a defined calculation period.

These transactions are excluded from the project forecast values during the forecast generation process. You can review and correct these forecast exceptions through the following two processes:

- PRC: List Forecast Exceptions
- PRC: Process Forecast Exceptions

Running a List of Forecast Exceptions

The PRC: List Forecast Exceptions process produces a report listing all requirement and assignment forecast items that are excluded from the project forecast. The requirement and assignment forecast items appearing on this report have either experienced a processing error or determined not to be valid items for the project forecast.

To run this process, complete the following steps:

1. Navigate to the Submit Request screen.
2. Choose Submit > PRC: List Forecast Exceptions.
3. Enter the desired organization.
4. Enter the desired forecast date range.
5. Click Submit.
Reprocess Forecast Exceptions

After you run your list of exceptions and make the appropriate corrections, you want to update your forecast amounts to include the corrected transactions. A process called PRC: Process Forecast Exceptions evaluates eligible forecast items and recreates the item for inclusion in the project forecast. Eligibility criteria for forecast items are as follows:

- forecast item date is between the specified forecast from and to date parameters

If the forecast item is not included in the current project forecast, a new forecast item is created for that period. If the forecast item has been previously summarized, the item is reversed and the rate is recalculated.

To run this process, complete the following steps:

1. Navigate to the Submit Request screen.
3. Enter the desired organization.
4. Enter the desired forecast date range.
5. Click Submit.
With Oracle Workflow, you can set up automated approval and notification processes. The workflow processes depend on actions, such as a status change to trigger the steps of the process. You can customize the messages and approval system using the Oracle Workflow Builder.

The implementation of Oracle Project Resource Management includes default workflow processes. Most of these workflow processes are used for updating information and are invisible to your users. Others are specifically for providing communication among your users, and you can modify them as appropriate for your business.

This chapter explains the following workflow processes:

- Initiating Deferred Workflow Processes
- Assignment Approval Workflow Process
- Candidate Workflow Processes

For more information on defining and modifying workflow processes and modifying client extensions, refer to the following sources:

- Chapter 13, "Integration with Other Oracle Applications," in the Oracle Projects User Guide
- Chapter 19, "Client Extensions," in the Oracle Projects User Guide
- Oracle Workflow Guide, Release 2.5.2
Initiating Deferred Workflow Processes

Deferred workflow processes handle time-consuming tasks that can be automated and placed in the background so that users can continue working in the application without waiting for the requested task to complete online. For example, applying the requirements of a team template to a project uses a deferred workflow process and when the task is completed, a notification is sent to the user who initiated the action.

These deferred workflow processes need at least one background engine to monitor background activities in order to ensure consistent processing. Therefore, you must submit a request to enable a concurrent program for workflow background processing. Only a user with system administrator responsibilities can run the Workflow Background Process.

Available Item Types

The following item types exist in the Workflow Background Process for Project Resource Management:

- **PA Project Assignment**: This process controls the routing of project assignment approvals.
- **PA Apply Team Template**: This process handles the task of applying a team template to a project.
- **PA Candidate Notification Process**: This process notifies candidates when they are nominated or withdrawn.
- **PA Mass Assignment Transaction Workflow**: This process handles the creation of assignments when a mass assignment request is submitted.
- **PA Overcommitment Notification Processes**: This process notifies users when assignments cause overcommitments.
- **PA Project Forecasting Workflow**: This process generates the forecast for a project.
- **PA HR Related Updates Workflow**: This process synchronizes Oracle HRMS data with Project Resource Management data.
- **PA Mass Assignment Approval**: This process handles the routing of approvals for mass assignments.
- **PA Advertisements Workflow**: This process sends out the advertisement notifications and e-mails.
Recommended Process Scheduling Parameters

You can schedule concurrent processes either for all item types included in the Workflow Background Process in a single request submission, or schedule each item type in individual requests. For a single request submission, leave the Item Type parameter blank. However, if you leave this parameter blank, the Workflow Background Process will run for all item types across all Oracle applications and may affect performance of the process.

The following table lists the recommended configuration for scheduling the Workflow Background Process for the Project Resource Management item types:

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Request 1</th>
<th>Request 2</th>
<th>Request 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repeat Every</td>
<td>10 minutes</td>
<td>24 hours</td>
<td>3 days</td>
</tr>
<tr>
<td>Minimum Threshold</td>
<td>Leave blank</td>
<td>Leave blank</td>
<td>Leave blank</td>
</tr>
<tr>
<td>Maximum Threshold</td>
<td>Leave blank</td>
<td>Leave blank</td>
<td>Leave blank</td>
</tr>
<tr>
<td>Process Deferred</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Process Timeout</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Process Stuck</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Apply the Interval</td>
<td>From the completion of the prior run</td>
<td>From the completion of the prior run</td>
<td>From the completion of the prior run</td>
</tr>
<tr>
<td>Increment Date</td>
<td>Leave blank</td>
<td>Leave blank</td>
<td>Leave blank</td>
</tr>
</tbody>
</table>

This configuration demonstrates three concurrently scheduled requests of the Workflow Background Process.

To submit a request, complete the following steps:

1. Navigate to the Submit Requests form.
2. Submit the Workflow Background Process concurrent program as a request.
3. Specify the item type and other parameters as appropriate.
4. Schedule the process to repeat itself at appropriate intervals.

For more information on submitting and scheduling the workflow processes, see:

- "Submitting a Request" in the Oracle Applications Users Guide
- "Setting Up Oracle Workflow" in the Oracle Workflow Guide
Assignment Approval Workflow Process

This workflow process begins when an assignment is created for a resource and is submitted for approval by a person that does not have the authority to approve the resource assignment. This workflow process progresses as the status of the assignment changes. The approvers for this process can include the staffing manager and the resource manager. Upon approval or rejection, FYI notifications are sent to the resource, the resource manager, staffing manager, and the project manager.

The predefined status flows for assignment approval are:

- Working -> Submitted -> Approved
- Working -> Submitted -> Rejected -> Requires Resubmission -> Submitted -> Approved

Actions invoke changes in the assignment approval status. The following table describes how the default assignment approval workflow changes the status based on actions:

<table>
<thead>
<tr>
<th>Action</th>
<th>Status Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment is created</td>
<td>Working</td>
</tr>
<tr>
<td>Assignment is submitted for approval</td>
<td>Submitted</td>
</tr>
<tr>
<td>Assignment is approved</td>
<td>Approved</td>
</tr>
<tr>
<td>Assignment is cancelled</td>
<td>Cancelled</td>
</tr>
<tr>
<td>Assignment is rejected</td>
<td>Rejected</td>
</tr>
<tr>
<td>Assignment is changed</td>
<td>Working</td>
</tr>
<tr>
<td>Assignment is resubmitted and the changes do not require approval</td>
<td>Approved</td>
</tr>
<tr>
<td>Assignment is resubmitted and the changes require approval</td>
<td>Submitted</td>
</tr>
<tr>
<td>Rejected assignment is changed</td>
<td>Requires Resubmission</td>
</tr>
</tbody>
</table>

The following changes on an assignment require an approval:

- a change in duration because it affects the schedule and availability of the resource, such as any extension, shortening or moving the start dates forward
- a change in work type because it affects billability or utilization percentage
You can change the order of the status flow for your business using these predefined statuses and creating your own processes. For more information, see "Assignment Approval Workflow Item Type and Processes" later in this chapter.

The automated Oracle Workflow-based approval process is enabled if the assignment approval status Submitted has been workflow-enabled. Oracle Workflow FYI notifications for Approved and Rejected statuses are enabled if Workflow is enabled for the assignment approval status of Approved or Rejected.

If you do not enable the workflow-based approval process, assignments retain the Submitted status until a user with authority over the resources manually logs in and approves or rejects each assignment. Due to the enforcement of project security, the person logging in should also have authority over the project in order to approve or reject a given assignment. The approver can only be the primary contact or the resource manager.

Assignment Approval Workflow Item Type and Processes

The assignment approval workflow process includes one predefined workflow item type: PA: Project Assignments. This item type includes the following workflow processes:

- PA: Project Assignment Approval - main approval process
- PA: Assignment Approval Notification - approval notification process
- PA: Assignment Rejection Notification - rejected notification process
- PA: Assignment Cancellation Notification - cancelled notification process

These processes activate based on the status of the assignment. The following table provides the default workflow setup of these statuses:

<table>
<thead>
<tr>
<th>Status</th>
<th>Enable Workflow</th>
<th>Workflow Process</th>
<th>Workflow Success Status</th>
<th>Workflow Failure Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working</td>
<td>N</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Submitted</td>
<td>Y</td>
<td>PA: Project Assignment Approval</td>
<td>Approved</td>
<td>Rejected</td>
</tr>
<tr>
<td>Approved</td>
<td>Y</td>
<td>PA: Assignment Approval Notification</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Cancelled</td>
<td>Y</td>
<td>PA: Assignment Cancellation Notification</td>
<td>None</td>
<td>None</td>
</tr>
</tbody>
</table>
Assignment Approval Workflow Process

You can view or modify these statuses through the Define Statuses form. You can create your own workflow processes to override these default processes or modify the workflow setup. If you choose to create your own workflow processes, you must specify the item type and process name against the appropriate predefined assignment approval statuses provided in the table above.

### Assignment Approval Workflow Notification Messages

The following table displays the notification messages used by the workflow processes. You can modify these messages as appropriate for your business approval processes.

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
<th>Type</th>
<th>Recipients</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notify Approval required</td>
<td>Notifies the recipient to approve the approval request with links to the assignment details and the schedule of the resource</td>
<td>Response required</td>
<td>All chosen approvers</td>
<td>None</td>
</tr>
<tr>
<td>Notification of assignment approval</td>
<td>Notifies the recipient that the approval request has been approved</td>
<td>FYI only</td>
<td>Resource</td>
<td>Any comments by the approvers are suppressed in the notification to the resource.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Resource Manager</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Staffing Manager</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Project Manager</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status</th>
<th>Enable Workflow</th>
<th>Workflow Process</th>
<th>Workflow Success Status</th>
<th>Workflow Failure Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rejected</td>
<td>Y</td>
<td>PA: Assignment Rejection Notification</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Requires Resubmission</td>
<td>N</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
</tbody>
</table>
For more information on defining notification messages, refer to the Oracle Workflow Guide.

**Assignment Schedule Statuses**

Requirement and assignment statuses are referred to as assignment schedule statuses because they reflect the status of the schedule for particular days. The following table provides the default settings for these statuses:

<table>
<thead>
<tr>
<th>User Status</th>
<th>System Status</th>
<th>Success Status</th>
<th>Failure Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proposed</td>
<td>Provisional</td>
<td>Confirmed</td>
<td>Rejected</td>
</tr>
<tr>
<td>Provisional</td>
<td>Provisional</td>
<td>Confirmed</td>
<td>Rejected</td>
</tr>
<tr>
<td>Confirmed</td>
<td>Confirmed</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Cancelled</td>
<td>Cancelled</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Rejected</td>
<td>Cancelled</td>
<td>None</td>
<td>None</td>
</tr>
</tbody>
</table>

Using the default settings, when a provisional assignment is approved, the status on the assignment is changed to Confirmed. If the provisional assignment is rejected, then the status of the assignment is changed to Rejected.

Assignment schedule statuses do not launch the approval workflow and you cannot enable workflow processes on these statuses. However, you can change the default workflow success and failure statuses for each provisional assignment schedule status.
Assignment Approval Workflow Process

Note: You cannot define these settings for any cancelled system statuses.

The schedules and timelines reflect all Confirmed and Provisional assignments. Therefore, the provisional assignment schedule status must be set to a confirmed status upon the completion of an approval process whether manual or automated through Oracle Workflow. Since all assignment schedule statuses are user-defined, you must specify the success and failure statuses for each user-defined Provisional status.

Assignment Approval Workflow Extensions

Client extensions relating to the approval of assignments are as follows:

■ Assignment Approval Changes Extension
■ Assignment Approval Notification Extensions

This section covers each extension providing detail on the package and related functions and procedures. For more information on client extensions, see Chapter 19, "Client Extensions," in the Oracle Projects User Guide.

Assignment Approval Changes Extension

This client extension enforces the following conditions to determine whether or not an approval is required for an assignment:

■ Change in Duration
  
  Any extension, shortening, or changing the dates of an assignment requires approval as it effects the schedule and availability of the resource.

■ Change in Work Type
  
  Any change in the work type on an assignment can have an effect on the billability and utilization percentage of the resource and therefore, requires approval.

Oracle Project Resource Management provides a template package called PA_CLIENT_EXTN_ASGNMT_APPRL. If you choose to write your own extensions, print out the following files first. These files are located in the Oracle Project Resource Management admin/sql directory:

■ PARAAPCB.pls
This file contains the procedures that you can modify to implement the extension.

- **PARAAPCS.pls**

  This file contains the specifications of the extension package. If you create procedures outside of the predefined procedure within the `PA_CLIENT_EXTN_ASGNMT_APPRVL` package, you must also modify this file to include those new procedures.

This package has a function called `IS_ASGMT_APPR_ITEMS_CHANGED`. This function can return a `VARCHAR2` value of either Y or N. The description of the data type for this function are listed in the following table:

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Data Type</th>
<th>Description</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>P_ASSIGNMENT_ID</td>
<td>NUMBER</td>
<td>The identifier of the assignment</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Assignment Approval Notification Extensions**

The circulation of notifications is controlled by the predefined workflow processes. These processes use workflow extensions to provide the lists of contacts for each notification. The client extensions obtain the list of default contacts (recipients) from the workflow process and makes any modifications to the list that the user may have specified through the Oracle Project Resource Management application. The end result is a customized list of recipients for the notification or approval request which the workflow process uses.

Oracle Project Resource Management provides a template package called `PA_CLIENT_EXTN_ASGNMT_WF`. If you choose to write your own extensions, print out the following files first. The files are located in the Oracle Project Resource Management admin/sql directory:

- **PARAWFCB.pls**

  This file contains the procedures that you can modify to implement the extension.

- **PARAWFCS.pls**

  This file contains the specifications of the extension package. If you create procedures outside of the predefined procedure within the `PA_CLIENT_EXTN_ASGNMT_WF` package, you must also modify this file to include those new procedures.
The description of the USERS_LIST_TBLTYP parameters for this package are listed in the following table:

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Data Type</th>
<th>Description</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>USER_NAME</td>
<td>VARCHAR2</td>
<td>The workflow user name of the approver</td>
<td>Yes</td>
</tr>
<tr>
<td>PERSON_ID</td>
<td>NUMBER</td>
<td>The person ID of the approver</td>
<td>Yes</td>
</tr>
<tr>
<td>TYPE</td>
<td>VARCHAR2</td>
<td>The type of user, such as RESOURCE_MANAGER or PRIMARY_CONTACT</td>
<td>Yes</td>
</tr>
<tr>
<td>ROUTING_ORDER</td>
<td>NUMBER</td>
<td>The order in which the approvals should be submitted</td>
<td>No</td>
</tr>
</tbody>
</table>

For FYI notification recipients, this value is ignored since such notifications are sent to all recipients at the same time.

You can modify the following package procedures as appropriate for your business approval processes:

- **Generate_Assignment_Approvers**

  This procedure generates a list of approvers for the assignment. Oracle Project Resource Management sends the list of default approvers to this procedure. The procedure then makes any user-requested changes and provides a modified list accordingly. If no user-requested changes exist, then the default list of approvers is used by the workflow process.

  Approvers added through this process are not visible on the Assignment Approver page. However, users can see the name of the current approver on the Assignment Details page.

  The following table provides a list of the parameters for this procedure and the details for each parameter:

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Type</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>P_ASSIGNMENT_ID</td>
<td>IN</td>
<td>NUMBER</td>
<td>The unique identifier of the assignment</td>
</tr>
</tbody>
</table>
Generate_NF_Recipients

This client extension procedure generates a list of recipients for the various notifications. Oracle Project Resource Management sends the list of default approvers to this procedure. The procedure then makes any user-requested changes and provides a modified list accordingly. If no user-requested changes exist, then the default list of recipients is used by the workflow process. This client extension procedure is used by the following FYI notifications:

- Assignment Approval Notification
- Assignment Rejection Notification
- Assignment Cancellation Notification

The following table provides a list of the parameters for this procedure and the details for each parameter:

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Type</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>P_PROJECT_ID</td>
<td>IN</td>
<td>NUMBER</td>
<td>The unique identifier of the project</td>
</tr>
<tr>
<td>P_IN_LIST_OF_RECIPIENTS</td>
<td>IN</td>
<td>USERS_LIST_TBLTYP</td>
<td>Input list of notification recipients</td>
</tr>
<tr>
<td>X_OUT_LIST_OF_RECIPIENTS</td>
<td>OUT</td>
<td>USERS_LIST_TBLTYP</td>
<td>Output list of notification recipients</td>
</tr>
<tr>
<td>X_NUMBER_OF_RECIPIENTS</td>
<td>OUT</td>
<td>NUMBER</td>
<td>Number of recipients</td>
</tr>
</tbody>
</table>
Set_Timeout_And_Reminders

This client extension procedure provides the reminder parameters, such as the waiting period between reminders and the number of reminders before the workflow process is cancelled.

The following table provides a list of the parameters for this procedure and the details for each parameter:

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Type</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>P_ASSIGNMENT_ID</td>
<td>IN</td>
<td>NUMBER</td>
<td>The unique identifier of the assignment</td>
</tr>
<tr>
<td>P_PROJECT_ID</td>
<td>IN</td>
<td>NUMBER</td>
<td>The unique identifier of the project</td>
</tr>
<tr>
<td>X_WAITING_TIMES</td>
<td>OUT</td>
<td>NUMBER</td>
<td>The maximum amount of time to wait before sending a reminder</td>
</tr>
<tr>
<td>X_NUMBER_OF_REMINDERS</td>
<td>OUT</td>
<td>NUMBER</td>
<td>The maximum number of reminders to send before aborting the process</td>
</tr>
</tbody>
</table>
Candidate Workflow Processes

Oracle Project Resource Management has two predefined notification workflow processes relating to a status change on candidates. These optional processes are:

- **New Candidate**

  As a candidate is nominated for a requirement, the candidate is initially given a status of Pending Review. This status invokes a notification process. This process notifies the resource, the manager of the resource, and their staffing manager of the nomination. The person that nominated the candidate does not receive a notification. Therefore, if the nomination was made by the resource, resource manager, or staffing manager, then that person is excluded from the notification process.

- **Candidate Declined**

  When a resource is declined as a candidate on a project, the status of the candidate is changed to any user status with a system status of Declined. This status initiates a notification process. This process notifies the candidate, the manager of the resource, and their staffing manager of the change in status. However, a notification is not sent to the person who declined the candidate, if that person is one of these individuals.

  An active candidate nomination of a resource on a requirement is automatically declined and the candidate status is set to a Declined status if either one of the following scenarios occurs:

  - A requirement is cancelled.
  - If the resource is no longer a valid Projects resource due to reasons such as HR termination, transfer to a non-expenditure project organization, or the resource’s organization is no longer a valid project expenditure organization.

  If the workflow PA: HR Related Updates Workflow is enabled, a notification is sent to the resource and the resource manager informing them about the declined candidate nomination.

Candidate Notification Workflow Extension

The candidate workflow processes use a template package called PA_CLIENT_EXTN_CAND_WF. If you choose to write your own extensions, print out the following files first. The files are located in the Oracle Project Resource Management admin/sql directory:
Candidate Workflow Processes

- **PARCWFCB.pls**
  This file contains the procedures that you can modify to implement the extension.

- **PARCWFCS.pls**
  This file contains the specifications of the extension package. If you create procedures outside of the predefined procedure within the PA_CLIENT_EXTN_CAND_WF package, you must also modify this file to include those new procedures.

The description of the USERS_LIST_TBLTYP parameters for this package are listed in the following table:

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Data Type</th>
<th>Description</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>USER_NAME</td>
<td>VARCHAR2</td>
<td>The workflow user name of the approver</td>
<td>Yes</td>
</tr>
<tr>
<td>PERSON_ID</td>
<td>NUMBER</td>
<td>The person ID of the approver</td>
<td>Yes</td>
</tr>
<tr>
<td>TYPE</td>
<td>VARCHAR2</td>
<td>The type of user, such as RESOURCE_MANAGER or PRIMARY_CONTACT</td>
<td>Yes</td>
</tr>
<tr>
<td>ROUTING_ORDER</td>
<td>NUMBER</td>
<td>The order in which the approvals should be submitted</td>
<td>No</td>
</tr>
</tbody>
</table>

For FYI notification recipients, this value is ignored since such notifications are sent to all recipients at the same time.

This package contains one procedure. You can modify the following package procedure as appropriate for your business notification processes:

- **Generate_NF_Recipients**
  This client extension procedure generates a list of recipients for the various notifications. Oracle Project Resource Management sends the list of default approvers to this procedure. The procedure then makes any user-requested changes and provides a modified list accordingly. If no user-requested changes exist, then the default list of recipients is used by the workflow process. This client extension procedure is used by the following FYI notifications:
  - Candidate Nominated Notification
- Candidate Declined Notification

The following table provides a list of the parameters for this procedure and the details for each parameter:

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Type</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>P_PROJECT_ID</td>
<td>IN</td>
<td>NUMBER</td>
<td>The unique identifier of the project</td>
</tr>
<tr>
<td>P_ASSIGNMENT_ID</td>
<td>IN</td>
<td>NUMBER</td>
<td>The unique identifier of the assignment</td>
</tr>
<tr>
<td>P_CANDIDATE_NUMBER</td>
<td>IN</td>
<td>NUMBER</td>
<td>The unique identifier of the candidate</td>
</tr>
<tr>
<td>P_NOTIFICATION_TYPE</td>
<td>IN</td>
<td>VARCHAR2</td>
<td>Type of notification; valid values are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ PENDING_REVIEW_FYI</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ DECLINED_FYI</td>
</tr>
<tr>
<td>P_IN_LIST_OF_RECIPIENTS</td>
<td>IN</td>
<td>USERS_LIST_TBLTYP</td>
<td>Input list of notification recipients</td>
</tr>
<tr>
<td>X_OUT_LIST_OF_RECIPIENTS</td>
<td>OUT</td>
<td>USERS_LIST_TBLTYP</td>
<td>Output list of notification recipients</td>
</tr>
<tr>
<td>X_NUMBER_OF_RECIPIENTS</td>
<td>OUT</td>
<td>NUMBER</td>
<td>Number of recipients</td>
</tr>
</tbody>
</table>
The Oracle Projects products include Oracle Projects Costing, Oracle Projects Billing, and Oracle Project Resource Management. Each of these products require a set of implementation steps, some of which are optional. Since these products share functionality and data, this appendix provides checklists that include all the tasks to complete the implementation of all three products.

This appendix covers the following topics:

- Overview of the Implementation Environment
- Implementation Considerations
- Overview of the Oracle Projects Implementation Checklists
- Oracle Projects Implementation Checklist
- Oracle Applications Implementation Checklist for Oracle Projects Integration
Overview of the Implementation Environment

Prior to beginning the implementation process, you should define Oracle Applications responsibilities and users for the implementation. Oracle Projects provides a predefined super user responsibility for each of the three related applications as follows:

- Projects Costing Super User
- Projects Billing Super User
- Project Resource Management Super User

You can assign this responsibility to users as appropriate for your implementation needs. For more information, see "Defining a Responsibility" in the Oracle Applications System Administrator’s Guide.

Oracle Applications Implementation Wizard

If you are implementing more than one Oracle Applications product, you can use the Oracle Applications Implementation Wizard to coordinate your setup activities. The Implementation Wizard guides you through the setup steps for the applications you have installed, suggesting a logical sequence that satisfies cross-product implementation dependencies and reduces redundant setup steps. The wizard also identifies steps that can be completed independently, by several teams working in parallel, to help you manage your implementation process most efficiently.

You can use the implementation wizard as a resource center to see a graphical overview of setup steps, read online help for a setup activity, and to open the appropriate setup window. You can also document your implementation for future reference or review using the wizard to record your comments for each step.

For more information, refer to the Oracle Applications Implementation Wizard User’s Guide.

Setting Up Underlying Oracle Applications Technology

The setup steps in the Oracle Projects Implementation Checklist guide you through implementing the parts of Oracle Applications specific to the Oracle Projects products. The Oracle Applications Implementation Wizard guides you through the entire Oracle Applications setup, including system administration. However, if you do not use the Wizard, you must complete several other setup steps, including:

- performing system-wide setup tasks such as configuring concurrent managers and printers
• managing data security, which includes setting up responsibilities to allow access to a specific set of business data and complete a specific set of transactions, and assigning individual users to one or more of these responsibilities.

For more information, see Oracle Applications System Administrator’s Guide.

Also, if your implementation uses Oracle Workflow to manage data changes, you must set up Oracle Workflow processes. For more information, refer to the Oracle Workflow User’s Guide. For information relating to the deferred or approval processes in Project Resource Management, refer to Chapter 8, "Defining the Project Environment”.

Implementation Considerations

As you determine your implementation data, you should consider the AutoAccounting feature if you are implementing Oracle Project Costing or Oracle Project Billing. The AutoAccounting feature in Oracle Projects derives values for account combinations based on project information for all accounting transactions in Oracle Projects. Consequently, the way you organize your chart of accounts affects your implementation data. For example, if you charge several expense accounts for varied expenditures such as meals, travel and lodging, and airfare, then you need to implement an expenditure type that corresponds to each expense account. You can use most of the implementation data that you define for Oracle Projects as inputs to the Auto Accounting rules that you define.

After you complete most implementation steps, you can submit reports to review your work and confirm that you have successfully completed the step. For example, after you complete entering Agreement types, you can submit the Agreement Types Listing. See "Implementation Listings" in the Oracle Projects User Guide for more information.

To aid you with your implementation of either Projects Costing or Projects Billing, you can refer to "About Fremont Corporation: An Example of Setting Up Oracle Projects" in Chapter 17 of the Oracle Project User Guide.

**Note:** Fremont Corporation may not have implemented all the features available in the current release of Oracle Projects.
Overview of the Oracle Projects Implementation Checklists

Two checklists are provided for your implementation:

■ Oracle Projects Implementation Checklist
■ Oracle Applications Implementation Checklist for Oracle Projects Integration

Each checklist indicates, for each step, whether it is required, optional, or conditional. Required indicates that the step is necessary for the implementation of the product to be successful. Optional indicates that you can determine whether or not the step applies to your particular implementation. Conditional indicates that the step is required to use a feature of the product, and the related feature is provided in the step description.

The implementation checklists summarize the steps for implementing products in the Oracle Projects suite. You can implement any of the Projects products individually. However, the following products are dependent on Oracle Projects Costing:

■ Oracle Projects Billing
■ Oracle Activity Management Gateway
■ Oracle Project Connect

The checklists include setup steps for data that may be shared with other Oracle Applications, but are required by the Oracle Projects products. If you have already defined this information when setting up other Oracle Applications, you can skip those steps. This shared data includes:

■ Set of Books
■ Employees and Organizations
■ Customers

Since some implementation steps build upon information you define in other implementation steps, you should perform the steps in the order listed.
Oracle Projects Implementation Checklist

The following table provides the Oracle Projects implementation checklist:

<table>
<thead>
<tr>
<th>Step Number</th>
<th>Step Description</th>
<th>Project Costing</th>
<th>Project Billing</th>
<th>Project Resource Management</th>
</tr>
</thead>
<tbody>
<tr>
<td>Licensing</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.</td>
<td>Set the profile option PA: Licensed to Use Project Billing. See: PA: Licensed to Use Project Billing (Oracle Projects User Guide)</td>
<td>n/a</td>
<td>Required</td>
<td>n/a</td>
</tr>
<tr>
<td>2.</td>
<td>Set the profile option PA: Licensed to Use Project Resource Management.</td>
<td>n/a</td>
<td>n/a</td>
<td>Required</td>
</tr>
<tr>
<td>3.</td>
<td>Specify additional profile option values. See: Profile Options (in Chapter 17 of the Oracle Projects User Guide)</td>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>Set of Books and Currencies</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.</td>
<td>Enable additional currencies that you plan to use. See Currencies Window (Oracle General Ledger User Guide)</td>
<td>Conditional</td>
<td>Conditional</td>
<td>Conditional</td>
</tr>
<tr>
<td></td>
<td>Required to use multiple currencies.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human Resources – Work Structures</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Required to use Cross Business Group Access.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9.</td>
<td>Define default operating unit for the project and expenditure organizations. See Chapter 3, &quot;Establishing Your Enterprise Structure&quot;.</td>
<td>Conditional</td>
<td>Conditional</td>
<td>Required</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>12.</td>
<td>Define job groups. See: &quot;Define Job Groups&quot; (Oracle Projects IIi Release 11.5.3/Mini Pack B User Guide Supplement) and &quot;Define Job Groups&quot; in Implementing Oracle HRMS. Required to process labor.</td>
<td>Conditional</td>
<td>Conditional</td>
<td>Required</td>
</tr>
<tr>
<td>14.</td>
<td>Define job levels. See: &quot;Defining Job Levels&quot; (Implementing Oracle HRMS).</td>
<td>n/a</td>
<td>n/a</td>
<td>Required</td>
</tr>
<tr>
<td>16.</td>
<td>Define competencies. See: Competencies (Oracle Human Resources Documentation Update for Patch Numbers 1383905 and 1377992 Global Competencies).</td>
<td>n/a</td>
<td>n/a</td>
<td>Required</td>
</tr>
<tr>
<td>17.</td>
<td>Define rating scales. See: &quot;Define Rating Scales&quot; (Implementing Oracle HRMS).</td>
<td>n/a</td>
<td>n/a</td>
<td>Required</td>
</tr>
<tr>
<td>18.</td>
<td>Assign competencies to resources. See: &quot;Assigning Competencies&quot; in Chapter 4, &quot;Defining Your People&quot;.</td>
<td>n/a</td>
<td>n/a</td>
<td>Required</td>
</tr>
</tbody>
</table>

Calendars for Schedule and Capacity Management

<table>
<thead>
<tr>
<th></th>
<th>Define calendar types. See: &quot;Defining Calendar Types&quot; in Chapter 8, &quot;Defining Calendars and Schedules&quot;.</th>
<th>Conditional</th>
<th>Conditional</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>20.</td>
<td>Define calendar shift and shift patterns. See: &quot;Defining Shift and Shift Patterns&quot; in Chapter 8, &quot;Defining Calendars and Schedules&quot;.</td>
<td>Conditional</td>
<td>Conditional</td>
<td>Required</td>
</tr>
<tr>
<td>Step</td>
<td>Task Description</td>
<td>Required Conditions</td>
<td>Conditional Conditions</td>
<td>Required Conditions</td>
</tr>
<tr>
<td>------</td>
<td>------------------</td>
<td>---------------------</td>
<td>------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>22.</td>
<td>Define calendars. See: &quot;Creating a Calendar&quot; in Chapter 8, &quot;Defining Calendars and Schedules&quot;.</td>
<td>Conditional</td>
<td>Conditional</td>
<td>Required</td>
</tr>
<tr>
<td>23.</td>
<td>Assign calendar shifts. See: &quot;Assigning Shifts and Exceptions to Calendar&quot; in Chapter 8, &quot;Defining Calendars and Schedules&quot;.</td>
<td>Conditional</td>
<td>Conditional</td>
<td>Required</td>
</tr>
</tbody>
</table>
| 24.  | Set the following profile options:  
- PA: Default Calendar  
- PA: Global Week Start Day  
- PA: Availability Calculation Period  
- PA: Percentage of Resource’s Capacity  
- PA: Availability Duration  
See: Chapter 8, "Defining Calendars and Schedules". | Conditional | Conditional | Required |
| 25.  | Run calendar generation process PRC: Generate Calendar Schedule for a Range of Calendars. See Chapter 8, "Defining Calendars and Schedules". | Conditional | Conditional | Required |
| 26.  | Define default calendar for the project and expenditure organizations. See Chapter 3, "Establishing Your Enterprise Structure". | Conditional | Conditional | Required |
|      | **Employees** | | | |
| 27.  | Define employees, including address, assignment, job, and supervisor. See: Chapter 4, "Defining Your People" and "Employees" and "Employee Assignments" (in Chapter 17 of the Oracle Projects User Guide) | Required | Required | Required |
| 28.  | Run project resource process PRC: Maintain Project Resources. See: Chapter 4, "Defining Your People" and "Understanding the Candidate Score and the Automated Nomination Process" in Chapter 7, "Setting Up Staffing Capabilities". | Conditional | Conditional | Required |
| 29.  | Initiate deferred workflow processes. See: Chapter 13, "Maintaining Your Data".  
The HR related updates performed by the workflow processes are required for Actual Utilization. | Conditional | Conditional | Required |
### Implementation Options and Accounting Periods

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>Required/Conditional</th>
<th>Required/Conditional</th>
<th>Required/Conditional</th>
</tr>
</thead>
<tbody>
<tr>
<td>32.</td>
<td><strong>Define PA periods.</strong> See: PA Periods (Oracle Projects User Guide).</td>
<td>Required</td>
<td>Required</td>
<td>Required</td>
</tr>
</tbody>
</table>

### Expenditure Setup

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>Required/Conditional</th>
<th>Required/Conditional</th>
<th>Required/Conditional</th>
</tr>
</thead>
<tbody>
<tr>
<td>34.</td>
<td><strong>Set the profile option PA: AP Discount Interface Start Date.</strong> See: AP Discount Interface Enhancement Setup and Implementation (Oracle Projects 11i Family Pack I (Release 11i.PJ_PF.I) Documentation Supplement).</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>37.</td>
<td><strong>Define units.</strong> See: Units (Oracle Projects User Guide.)</td>
<td>Required</td>
<td>Required</td>
<td>n/a</td>
</tr>
<tr>
<td>38.</td>
<td><strong>Define expenditure types.</strong> See: Expenditure Types (Oracle Projects User Guide). Required to use financial forecasting.</td>
<td>Required</td>
<td>Required</td>
<td>Conditional</td>
</tr>
<tr>
<td>39.</td>
<td><strong>Define non-labor resources.</strong> See: Non-Labor Resources (Oracle Projects User Guide). Required to use Usages.</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>40.</td>
<td><strong>Define transaction sources.</strong> See: Transaction Sources (Oracle Projects User Guide). Required to use Transaction Import.</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
</tbody>
</table>
### Oracle Projects Implementation Checklist

<table>
<thead>
<tr>
<th></th>
<th>Step Description</th>
<th>Optional</th>
<th>Optional</th>
<th>n/a</th>
</tr>
</thead>
<tbody>
<tr>
<td>41.</td>
<td>Implement transaction control extension. See: Transaction Control Extensions (Oracle Projects User Guide).</td>
<td>Optional</td>
<td>Optional</td>
<td>n/a</td>
</tr>
<tr>
<td>42.</td>
<td>Implement AutoApproval extension. See: AutoApproval Extension (Oracle Projects User Guide).</td>
<td>Optional</td>
<td>Optional</td>
<td>n/a</td>
</tr>
</tbody>
</table>

**Non-Labor Costing Setup**

<table>
<thead>
<tr>
<th></th>
<th>Step Description</th>
<th>Optional</th>
<th>Optional</th>
<th>n/a</th>
</tr>
</thead>
<tbody>
<tr>
<td>43.</td>
<td>Define cost rates for expenditure types. See: Cost Rates for Expenditure Types (Oracle Projects User Guide).</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>44.</td>
<td>Define usage cost rate overrides. See: Usage Cost Rate Overrides (Oracle Projects User Guide).</td>
<td>Optional</td>
<td>Optional</td>
<td>n/a</td>
</tr>
</tbody>
</table>

**Labor Costing Setup**

<table>
<thead>
<tr>
<th></th>
<th>Step Description</th>
<th>Conditional</th>
<th>Conditional</th>
<th>Conditional</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Required to process labor.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Required to process labor.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>47.</td>
<td>Define labor cost multipliers. See: Labor Cost Multipliers (Oracle Projects User Guide).</td>
<td>Optional</td>
<td>Optional</td>
<td>n/a</td>
</tr>
<tr>
<td>49.</td>
<td>Implement labor transaction extension (advanced implementation step). See: Labor Transaction Extensions (Oracle Projects User Guide).</td>
<td>Optional</td>
<td>Optional</td>
<td>n/a</td>
</tr>
<tr>
<td>50.</td>
<td>Implement overtime processing (advanced implementation step). See: Overview of Implementing Overtime (Oracle Projects User Guide).</td>
<td>Optional</td>
<td>Optional</td>
<td>n/a</td>
</tr>
<tr>
<td>51.</td>
<td>Implement the overtime calculation extension. See: Overtime Calculation Extension (Oracle Projects User Guide).</td>
<td>Optional</td>
<td>Optional</td>
<td>n/a</td>
</tr>
</tbody>
</table>

**Budget Setup**

<table>
<thead>
<tr>
<th></th>
<th>Step Description</th>
<th>Conditional</th>
<th>Conditional</th>
<th>n/a</th>
</tr>
</thead>
<tbody>
<tr>
<td>52.</td>
<td>Define additional budget types. See: Budget Types (Oracle Projects User Guide).</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>Required to use budgeting.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>53.</strong> Define budget entry methods. See: Budget Entry Methods (<em>Oracle Projects User Guide</em>). Required to use budgeting.</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>---</td>
<td>-------------------------------------------------------------------------------------------------</td>
<td>-------------</td>
<td>-------------</td>
<td>-----</td>
</tr>
<tr>
<td></td>
<td><strong>54.</strong> Define budget change reasons. See: Budget Change Reasons (<em>Oracle Projects User Guide</em>).</td>
<td>Optional</td>
<td>Optional</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td><strong>55.</strong> Define resource lists. See: Resources and Resource Lists (<em>Oracle Projects User Guide</em>). Required to use budgeting.</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td><strong>56.</strong> Implement budget calculation extension. See: Budget Calculation Extensions (<em>Oracle Projects User Guide</em>).</td>
<td>Optional</td>
<td>Optional</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td><strong>57.</strong> Implement budget verification extension. See: Budget Verification Extension (<em>Oracle Projects User Guide</em>).</td>
<td>Optional</td>
<td>Optional</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td><strong>58.</strong> Implement budget workflow extension. See: Budget Workflow Extension (<em>Oracle Projects User Guide</em>).</td>
<td>Optional</td>
<td>Optional</td>
<td>n/a</td>
</tr>
</tbody>
</table>

**Burden Costing Setup**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>60.</strong> Define burden cost codes. See: Burden Cost Codes (<em>Oracle Projects User Guide</em>). Required to use burdening.</td>
<td>Conditional</td>
<td>Conditional</td>
<td>Conditional</td>
</tr>
<tr>
<td></td>
<td><strong>63.</strong> Implement the Burden Costing extension. See: Burden Costing Extension (<em>Oracle Projects User Guide</em>).</td>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
</tr>
</tbody>
</table>

**Project Billing Setup**
<table>
<thead>
<tr>
<th></th>
<th>Oracle Projects Implementation Checklist</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Specify Receivables System Options.</strong> See: Specifying System Options (Oracle Projects User Guide).</td>
</tr>
<tr>
<td></td>
<td><strong>Set up output tax codes for customer invoices.</strong> See: Setting Up Invoice Line Tax Codes (Oracle Projects User Guide).</td>
</tr>
<tr>
<td></td>
<td><strong>Define billing cycles.</strong> See: Billing Cycles (Oracle Projects User Guide).</td>
</tr>
<tr>
<td></td>
<td><strong>Implement billing cycle extension</strong> (advanced implementation step). See: Billing Cycle Extension (Oracle Projects User Guide).</td>
</tr>
<tr>
<td></td>
<td><strong>Define payment terms.</strong> See: Payment Terms (Oracle Projects User Guide).</td>
</tr>
<tr>
<td></td>
<td><strong>Define agreement types.</strong> See: Agreement Types (Oracle Projects User Guide).</td>
</tr>
<tr>
<td></td>
<td><strong>Define bill rate schedules.</strong> See: Bill Rate Schedules (Oracle Projects User Guide). Required if your Transfer Price Schedules or Project Billing setup are based on Rates.</td>
</tr>
<tr>
<td></td>
<td><strong>Define invoice formats.</strong> See: Invoice Formats (Oracle Projects User Guide).</td>
</tr>
<tr>
<td></td>
<td><strong>Define credit types.</strong> See: Transfer Pricing (Oracle Projects User Guide).</td>
</tr>
<tr>
<td></td>
<td><strong>Define event types.</strong> See: Event Types (Oracle Projects User Guide).</td>
</tr>
<tr>
<td></td>
<td><strong>Assign event types for cost-to-cost revenue.</strong> See: Assigning Event Types for Cost-to-Cost Revenue (Oracle Projects User Guide).</td>
</tr>
<tr>
<td></td>
<td><strong>Define customers.</strong> See: Customers (Oracle Projects User Guide).</td>
</tr>
<tr>
<td></td>
<td><strong>Implement Percent Complete Revenue Accrual and Invoicing.</strong> See: Setup Requirements for Percent Complete Revenue and Invoicing (Oracle Projects User Guide).</td>
</tr>
<tr>
<td></td>
<td><strong>Implement labor billing extension.</strong> See: Labor Billing Extensions (Oracle Projects User Guide).</td>
</tr>
<tr>
<td></td>
<td><strong>Implement billing extensions.</strong> See: Billing Extensions (Oracle Projects User Guide).</td>
</tr>
</tbody>
</table>
### Oracle Projects Implementation Checklist

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>n/a</td>
</tr>
<tr>
<td>79</td>
<td>Optional</td>
</tr>
<tr>
<td></td>
<td>n/a</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Implement AR transaction type extension. See: AR Transaction Type Extension (<em>Oracle Projects User Guide</em>).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>n/a</td>
</tr>
<tr>
<td>80</td>
<td>Optional</td>
</tr>
<tr>
<td></td>
<td>n/a</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Implement the output tax extension. See: Output Tax Extension (<em>Oracle Projects User Guide</em>).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>n/a</td>
</tr>
<tr>
<td>81</td>
<td>Optional</td>
</tr>
<tr>
<td></td>
<td>n/a</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Implement Revenue-Based Cost Accrual extension. See: Revenue-Based Cost Accrual (<em>Oracle Projects User Guide</em>).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>n/a</td>
</tr>
<tr>
<td>82</td>
<td>Optional</td>
</tr>
<tr>
<td></td>
<td>n/a</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>n/a</td>
</tr>
<tr>
<td>83</td>
<td>Optional</td>
</tr>
<tr>
<td></td>
<td>n/a</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Implement customer invoice printing strategy. See: Determining Your Invoice Printing Method (<em>Oracle Projects User Guide</em>).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>n/a</td>
</tr>
<tr>
<td>84</td>
<td>Optional</td>
</tr>
<tr>
<td></td>
<td>n/a</td>
</tr>
</tbody>
</table>

### Role Setup

<table>
<thead>
<tr>
<th></th>
<th>Define role lists. See: Chapter 6, &quot;Defining Project Roles&quot;.</th>
</tr>
</thead>
<tbody>
<tr>
<td>85</td>
<td>Optional</td>
</tr>
<tr>
<td></td>
<td>Optional</td>
</tr>
<tr>
<td></td>
<td>Required</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Define roles and role types. See: Chapter 6, &quot;Defining Project Roles&quot; and &quot;Project Roles&quot; in the <em>Oracle Projects User Guide</em>.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Optional</td>
</tr>
<tr>
<td>86</td>
<td>Optional</td>
</tr>
<tr>
<td></td>
<td>Required</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Define project roles for organizations. See: Project Organization Roles (<em>Oracle Projects Documentation Update Notes, Family Pack J (11i.PJ_PFJ)</em>).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Optional</td>
</tr>
<tr>
<td>87</td>
<td>Optional</td>
</tr>
<tr>
<td></td>
<td>Optional</td>
</tr>
</tbody>
</table>

### Project Staffing

<table>
<thead>
<tr>
<th></th>
<th>Define requirement, candidate, assignment approval, and assignment scheduling statuses. See: &quot;Setting Up Staffing Capabilities&quot;.</th>
</tr>
</thead>
<tbody>
<tr>
<td>88</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>Required</td>
</tr>
</tbody>
</table>
89. **Set the following profile options:**  
   - PA: Starting Requirement Status  
   - PA: Starting Assignment Status  
   - PA: Default Filled Requirement Status  
   - PA: Default Starting Candidate Status  
   - PA: Cancelled Requirement's Candidate Status  
   - PA: Invalid Resource Candidate Status  
   See: Chapter 7, "Setting Up Staffing Capabilities".

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>n/a</td>
<td>n/a</td>
<td></td>
</tr>
</tbody>
</table>

90. **Define advertisement rules and run the PRC:**  
   Perform Action Rules concurrent process.  
   See: Chapter 7, "Setting Up Staffing Capabilities".

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>n/a</td>
<td>n/a</td>
<td></td>
</tr>
</tbody>
</table>

91. **Run the PRC: Automated Candidate Search process for automated candidate nomination.**  
   See: Chapter 13, "Maintaining Your Data".

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>n/a</td>
<td>n/a</td>
<td></td>
</tr>
</tbody>
</table>

92. **Setup Discoverer reporting.**  
   See: Chapter 12,  
   "Setting Up for Reporting Capabilities".

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>n/a</td>
<td>n/a</td>
<td></td>
</tr>
</tbody>
</table>

93. **Define team templates.**  
   See: "Creating and Applying Team Templates" in Oracle Project Resource Management online help.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>n/a</td>
<td>n/a</td>
<td></td>
</tr>
</tbody>
</table>

94. **Define staffing priority codes.**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>n/a</td>
<td>n/a</td>
<td></td>
</tr>
</tbody>
</table>

---

### Project Setup

95. **Define project statuses.**  
   See: "Setting Up the Predefined Project Status Controls" in Chapter 9,  
   "Defining the Project Environment" and "Statuses" in  
   the Oracle Projects User Guide.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
</tr>
</tbody>
</table>

96. **Define additional class categories and class codes.**  

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
</tr>
</tbody>
</table>

97. **Define service types.**  
   See: Service Types (Oracle Projects User Guide).

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Required</td>
<td>Required</td>
<td>Required</td>
</tr>
</tbody>
</table>

98. **Define project customer relationships.**  

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td>Required</td>
<td>Optional</td>
</tr>
</tbody>
</table>

99. **Define contact types.**  
   See: Contact Types (Oracle Projects User Guide).

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>Number</td>
<td>Step Description</td>
<td>Reference</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------</td>
<td>-----------</td>
</tr>
<tr>
<td>100.</td>
<td>Define probability lists. See: &quot;Establishing Probability Information&quot; in Chapter 9, &quot;Defining the Project Environment&quot; and &quot;Probability Lists&quot; in the Oracle Projects User Guide.</td>
<td>Optional</td>
</tr>
<tr>
<td>101.</td>
<td>Define project types. See: Project Types (Oracle Projects User Guide).</td>
<td>Required</td>
</tr>
<tr>
<td>102.</td>
<td>Define project templates. See: Project Templates (Oracle Projects User Guide).</td>
<td>Required</td>
</tr>
<tr>
<td>103.</td>
<td>Create project list views. See: Customizable Project List (Oracle Projects 11i Family Pack I (Release 11i.PJ_PF.I) Documentation Supplement).</td>
<td>n/a</td>
</tr>
<tr>
<td>104.</td>
<td>Implement project verification extension. See: Project Verification Extension (Oracle Projects User Guide).</td>
<td>Optional</td>
</tr>
<tr>
<td>107.</td>
<td>Configure a project home page. See: Configurable Project Home (Oracle Projects 11i Family Pack I (Release 11i.PJ_PF.I) Documentation Supplement). This step includes defining a shortcut menu, creating a project home page layout, and associating the project home page layout with a project. This step is optional because a default shortcut menu and layout are provided.</td>
<td>n/a</td>
</tr>
</tbody>
</table>

**Project and Organizational Security**

<table>
<thead>
<tr>
<th>Number</th>
<th>Step Description</th>
<th>Reference</th>
<th>Optional</th>
<th>Required</th>
<th>Conditional</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Step Description</td>
<td>Condition</td>
<td>Required</td>
<td>Available</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------</td>
<td>-----------</td>
<td>------------</td>
<td></td>
</tr>
<tr>
<td>110.</td>
<td>Define role-based security. See: “Understanding Role-Based Security” in Chapter 5, “Configuring Your Organization Security”.</td>
<td>n/a</td>
<td>n/a</td>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td><strong>Inter-Project Billing: Global Setup</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>112.</td>
<td>In Oracle Payables, define suppliers for the provider operating units.</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
<td></td>
</tr>
<tr>
<td>113.</td>
<td>Define expenditure types for inter-project Payables invoices. See Setup for Inter-Project Billing (Oracle Projects User Guide). Optional if you have completed project costing setup.</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
<td></td>
</tr>
<tr>
<td>114.</td>
<td>Define customers in Oracle Receivables for the receiver operating units. See Oracle Receivables User Guide. Required to use inter-project billing.</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
<td></td>
</tr>
<tr>
<td>115.</td>
<td>Define inter-project agreement types. See: Setup for Inter-Project Billing (Oracle Projects User Guide). Optional if you have completed project billing setup.</td>
<td>n/a</td>
<td>Optional</td>
<td>n/a</td>
<td></td>
</tr>
<tr>
<td>116.</td>
<td>Define inter-project billing cycles. See: Billing Cycles (Oracle Projects User Guide). Optional if you have completed project billing setup.</td>
<td>n/a</td>
<td>Optional</td>
<td>n/a</td>
<td></td>
</tr>
<tr>
<td>117.</td>
<td>Define inter-project invoice formats. See: Invoice Formats (Oracle Projects User Guide). Optional if you have completed project billing setup.</td>
<td>n/a</td>
<td>Optional</td>
<td>n/a</td>
<td></td>
</tr>
<tr>
<td>118.</td>
<td>Customize the Payables Open Interface Workflow so that you can override the default attributes for currency conversion. See: Customizing the Payables Open Interface Workflow (Oracle Projects User Guide).</td>
<td>n/a</td>
<td>Optional</td>
<td>n/a</td>
<td></td>
</tr>
<tr>
<td>119.</td>
<td>Define inter-project supplier types. See: Setup for Inter-Project Billing (Oracle Projects User Guide).</td>
<td>n/a</td>
<td>Optional</td>
<td>n/a</td>
<td></td>
</tr>
<tr>
<td><strong>Inter-Project Billing: Operating Unit Setup</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Oracle Projects Implementation Checklist

<table>
<thead>
<tr>
<th></th>
<th>Definition</th>
<th>Status</th>
<th>Condition</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>120.</td>
<td>Define internal billing implementation options. See: Setup for Inter-Project Billing (Oracle Projects User Guide). Required to use inter-project billing.</td>
<td>n/a</td>
<td>Conditional</td>
<td>Optional</td>
</tr>
<tr>
<td>121.</td>
<td>Define supplier sites for internal suppliers. See: Setup for Inter-Project Billing (Oracle Projects User Guide). Required for each receiver operating unit, if you are using inter-project billing.</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>122.</td>
<td>Define customer bill and ship sites for internal customers. See: Defining Customer Bill and Ship Sites for Internal Customers (Oracle Projects User Guide). Required for each receiver operating unit, if you are using inter-project billing.</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>123.</td>
<td>Define provider and receiver controls. See: Setup for Inter-Project Billing (Oracle Projects User Guide). Required to use inter-project billing.</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>124.</td>
<td>In Oracle Receivables, define tax account codes for the tax amounts on internal Receivables invoices. See: Defining Automatic Accounting in Oracle Receivables (Oracle Projects User Guide). Required for each receiver operating unit, if you are using inter-project billing.</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>125.</td>
<td>Define tax codes for internal Payables invoices. See: Setup for Inter-Project Billing (Oracle Projects User Guide). Required for each receiver operating unit, if you are using inter-project billing.</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>126.</td>
<td>Verify that Receivables and Payables share the same tax codes. See: Setup for Inter-Project Billing (Oracle Projects User Guide). Required for each provider and receiver operating unit pair, if you are using inter-project billing.</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>127.</td>
<td>Modify the Supplier Invoice Charge Account process. See: Setup for Inter-Project Billing (Oracle Projects User Guide). Required for each receiver operating unit, if you are using inter-project billing.</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>Define receiver projects. See: Setup for Inter-Project Billing (<em>Oracle Projects User Guide</em>). Required to use inter-project billing.</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td>Define provider projects. See: Setup for Inter-Project Billing (<em>Oracle Projects User Guide</em>). Required to use inter-project billing.</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td><strong>Cross Charge - Borrowed and Lent</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Define transfer price rules. See: Defining Transfer Price Rules (<em>Oracle Projects User Guide</em>). Required to use borrowed and lent processing.</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>Define transfer price schedules. See: Defining Transfer Price Schedules (<em>Oracle Projects User Guide</em>). Required to use borrowed and lent processing.</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>Define cross charge implementation options for all operating units using borrowed and lent processing. See: Defining Cross Charge Implementation Options (<em>Oracle Projects User Guide</em>).</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>Define additional expenditure types for borrowed and lent processing. See: Expenditure Types (<em>Oracle Projects User Guide</em>).</td>
<td>Optional</td>
<td>Optional</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>Define transaction sources for borrowed and lent processing. See: Defining Transaction Sources for Cross Charge Processing (<em>Oracle Projects User Guide</em>).</td>
<td>Optional</td>
<td>Optional</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>Define provider and receiver controls. See: Defining Provider and Receiver Controls (<em>Oracle Projects User Guide</em>).</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>Implement the cross charge client extensions. See: Cross Charge Client Extensions (<em>Oracle Projects User Guide</em>).</td>
<td>Optional</td>
<td>Optional</td>
<td>n/a</td>
</tr>
<tr>
<td><strong>Cross Charge - Intercompany Billing</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Define transfer price rules. See: Defining Transfer Price Rules (<em>Oracle Projects User Guide</em>). Required to use cross charge processing.</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>Define transfer price schedules. See: Defining Transfer Price Schedules (<em>Oracle Projects User Guide</em>). Required to use cross charge processing.</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>Define inter-company supplier types. See: Defining Cross Charge Implementation Options (Oracle Projects User Guide).</td>
<td>n/a</td>
<td>Optional</td>
<td>n/a</td>
</tr>
<tr>
<td>---</td>
<td>----------------------------------------------------------------------------------------------------------------</td>
<td>-----</td>
<td>----------</td>
<td>-----</td>
</tr>
<tr>
<td>140.</td>
<td>In Oracle Payables, define suppliers for the provider operating units. Required to use intercompany billing.</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>141.</td>
<td>Define supplier sites for internal suppliers. See: Defining Supplier Sites for Internal Suppliers (Oracle Projects User Guide).</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>142.</td>
<td>Define customers in Oracle Receivables for the receiver operating units. See: Oracle Receivables User Guide.</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>143.</td>
<td>Define customer bill and ship sites for internal customers. See: Defining Customer Bill and Ship Sites for Internal Customers (Oracle Projects User Guide). Required for each receiver operating unit, if you are using intercompany billing.</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>144.</td>
<td>Define intercompany billing expenditure types. See: Defining Expenditure Types for Cross Charge Processing (Oracle Projects User Guide). Optional if you have completed project billing setup.</td>
<td>n/a</td>
<td>Optional</td>
<td>n/a</td>
</tr>
<tr>
<td>145.</td>
<td>Define intercompany billing invoice formats. See: Invoice Formats and About Invoice Formats for Intercompany Billing (Oracle Projects User Guide). Optional if you have completed project billing setup.</td>
<td>n/a</td>
<td>Optional</td>
<td>n/a</td>
</tr>
<tr>
<td>146.</td>
<td>Define intercompany billing cycles. See: Billing Cycles (Oracle Projects User Guide). Optional if you have completed project billing setup.</td>
<td>n/a</td>
<td>Optional</td>
<td>n/a</td>
</tr>
<tr>
<td>147.</td>
<td>Define agreement types for cross charge processing. See: Defining Agreement Types for Cross Charge Processing (Oracle Projects User Guide). Optional if you have completed project billing setup.</td>
<td>n/a</td>
<td>Optional</td>
<td>n/a</td>
</tr>
<tr>
<td>148.</td>
<td>Define internal transaction sources. See: Defining Transaction Sources for Cross Charge Processing (Oracle Projects User Guide).</td>
<td>n/a</td>
<td>Optional</td>
<td>n/a</td>
</tr>
<tr>
<td>149.</td>
<td>Customize the Payables Open Interface Workflow. See: Customizing the Payables Open Interface Workflow (Oracle Projects User Guide).</td>
<td>Conditional</td>
<td>Conditional</td>
<td>Conditional</td>
</tr>
<tr>
<td></td>
<td>Implement the cross charge client extensions. See: Cross Charge Client Extensions (<em>Oracle Projects User Guide</em>).</td>
<td>n/a</td>
<td>Optional</td>
<td>n/a</td>
</tr>
<tr>
<td>---</td>
<td>----------------------------------------------------------------------------------------------------------------</td>
<td>-----</td>
<td>----------</td>
<td>-----</td>
</tr>
<tr>
<td></td>
<td>Cross Charge - Intercompany Billing: Operating Unit Setup</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>150.</td>
<td>Define internal billing implementation options. See: Defining Internal Billing Implementation Options (<em>Oracle Projects User Guide</em>). Required to use intercompany billing.</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>151.</td>
<td>Define a project type for intercompany billing projects. See: Defining a Project Type for Intercompany Billing Projects (<em>Oracle Projects User Guide</em>). Required for each provider operating unit, if you are using intercompany billing.</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>152.</td>
<td>Define project templates for intercompany billing projects. See: Defining Project Templates for Intercompany Billing Projects (<em>Oracle Projects User Guide</em>).</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>153.</td>
<td>Define intercompany billing projects. See: Defining Intercompany Billing Projects (<em>Oracle Projects User Guide</em>). Required for each provider operating unit, if you are using intercompany billing.</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>154.</td>
<td>Define agreements for intercompany billing projects. See: Defining Agreements for Intercompany Billing Projects (<em>Oracle Projects User Guide</em>). Required for each provider operating unit, if you are using intercompany billing.</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>155.</td>
<td>Define provider and receiver controls. See: Defining Provider and Receiver Controls (<em>Oracle Projects User Guide</em>). Required to use intercompany billing.</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>156.</td>
<td>Define tax account codes for internal Receivables invoices. See: Defining Tax Codes for Internal Receivables Invoices (<em>Oracle Projects User Guide</em>). Required for each provider operating unit, if you are using intercompany billing.</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
</tbody>
</table>
### Oracle Projects Implementation Checklist

<table>
<thead>
<tr>
<th></th>
<th>Define Payables tax codes to apply separate tax distributions on internal Payables invoices. See: Defining Tax Codes for Internal Payables Invoices (Oracle Projects User Guide). Required for each provider operating unit, if you are using intercompany billing.</th>
<th>n/a</th>
<th>Conditional</th>
<th>n/a</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Verify that Receivables and Payables share the same tax codes for internal invoices. See: Verify the Receivables and Payables Share the Same Tax Codes (Oracle Projects User Guide). Required for each provider operating unit, if you are using intercompany billing.</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>Modify the Supplier Invoice Charge Account process. See: Modifying the Supplier Invoice Charge Account Process (Oracle Projects User Guide). Required for each provider operating unit, if you are using intercompany billing.</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>Define cross charge setup information for projects and tasks. See: Defining Cross Charge Setup (Oracle Projects User Guide).</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td><strong>Allocations Setup</strong></td>
<td>Define allocation rules. See: Defining Allocation Rules (Oracle Projects User Guide). Required to use allocations.</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td><strong>AutoAllocations Setup</strong></td>
<td>Create AutoAllocation sets. See: Creating AutoAllocation Sets (Oracle Projects User Guide). Required to use AutoAllocations.</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>Set up Workflow for Allocations. See: Setting Up Workflow for Step-Down AutoAllocations (Oracle Projects User Guide). Required to use AutoAllocations.</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>Implement the Allocation Extensions. See: Allocation Extensions (Oracle Projects User Guide). Optional</td>
<td>Optional</td>
<td>Optional</td>
<td>n/a</td>
</tr>
<tr>
<td><strong>Utilization</strong></td>
<td>Classify jobs with &quot;Utilizable&quot; flag. See Chapter 11, &quot;Implementing Resource Utilization&quot;.</td>
<td>Required</td>
<td>Required</td>
<td>Required</td>
</tr>
<tr>
<td>Step</td>
<td>Task Description</td>
<td>Required Status</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>----------------------------------------------------------------------------------</td>
<td>--------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>167.</td>
<td>Define utilization categories. See Chapter 11, &quot;Implementing Resource Utilization&quot;.</td>
<td>Required Required Required</td>
<td></td>
<td></td>
</tr>
<tr>
<td>168.</td>
<td>Define work types. See Chapter 11, &quot;Implementing Resource Utilization&quot;.</td>
<td>Required Required Required</td>
<td></td>
<td></td>
</tr>
<tr>
<td>169.</td>
<td>Define utilization options and choose your reporting period. See Chapter 11, &quot;Implementing Resource Utilization&quot;.</td>
<td>Required Required Required</td>
<td></td>
<td></td>
</tr>
<tr>
<td>170.</td>
<td>Grant utilization and resource authority. See Chapter 11, &quot;Implementing Resource Utilization&quot;.</td>
<td>Required Required Required</td>
<td></td>
<td></td>
</tr>
<tr>
<td>171.</td>
<td>Set the profile options for utilization:</td>
<td>Required Required Required</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ PA: Utilization Records Per Set</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ PA: Utilization Manager Default Period Type</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ PA: Utilization Manager Default Calculation Method</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ PA: Resource Utilization Period Type</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ PA: Resource Utilization Calculation Method</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ PA: Utilization Calculation Begin Date</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>See: Chapter 11, &quot;Implementing Resource Utilization&quot;.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>172.</td>
<td>Associate application users with predefined responsibilities. See Chapter 5, &quot;Configuring Your Organization Security&quot;.</td>
<td>Required Required Required</td>
<td></td>
<td></td>
</tr>
<tr>
<td>173.</td>
<td>Run the concurrent report set PRC: Generate Utilization. See Chapter 13, &quot;Maintaining Your Data&quot;.</td>
<td>Required Required Required</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Financial Forecasting**

<table>
<thead>
<tr>
<th>Step</th>
<th>Task Description</th>
<th>Required Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>174.</td>
<td>Define forecasting options. See: Chapter 10, &quot;Implementing Financial Forecasting&quot;.</td>
<td>Conditional Conditional Optional</td>
</tr>
<tr>
<td></td>
<td>Required to use financial forecasting.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Optional if you have already defined expenditure categories.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Required to use financial forecasting.</td>
<td></td>
</tr>
</tbody>
</table>
### Oracle Projects Implementation Checklist

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>177.</td>
<td><strong>Define expenditure types.</strong> See: Expenditure Types <em>(Oracle Projects User Guide)</em>. Required to use financial forecasting.</td>
<td>Conditional</td>
<td>Conditional</td>
</tr>
<tr>
<td>180.</td>
<td><strong>Implement labor costing extension.</strong> See: Labor Costing Extensions <em>(Oracle Projects User Guide)</em>.</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>181.</td>
<td><strong>Define cost bases and cost base types.</strong> See: Cost Bases and Cost Base Amount Types <em>(Oracle Projects User Guide)</em>.</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>182.</td>
<td><strong>Define burden cost codes.</strong> See: Burden Cost Codes <em>(Oracle Projects User Guide)</em>.</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>183.</td>
<td><strong>Define burden structures.</strong> See: Burden Structures <em>(Oracle Projects User Guide)</em>.</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>184.</td>
<td><strong>Define burden schedules.</strong> See: Burden Schedules <em>(Oracle Projects User Guide)</em>.</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>185.</td>
<td><strong>Define rate schedules.</strong> See: Bill Rate Schedules <em>(Oracle Projects User Guide)</em>. Required to use financial forecasting.</td>
<td>Conditional</td>
<td>Conditional</td>
</tr>
</tbody>
</table>

### Project Status Inquiry Setup

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>186.</td>
<td><strong>Define derived columns.</strong> See: Derived Columns for Project Status Inquiry <em>(Oracle Projects User Guide)</em>.</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>187.</td>
<td><strong>Define displayed columns.</strong> See: Non-Default Configuration for Project Status Inquiry <em>(Oracle Projects User Guide)</em>.</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>188.</td>
<td><strong>Implement commitments from external systems.</strong> See Implementing Commitments from External Systems <em>(Oracle Projects User Guide)</em>.</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>189.</td>
<td><strong>Implement custom reporting strategy.</strong> See Custom Reporting Using Project Summary Accounts <em>(Oracle Projects User Guide)</em>.</td>
<td>Optional</td>
<td>Optional</td>
</tr>
</tbody>
</table>
### Oracle Projects Implementation Checklist

#### Implementation Steps Checklist

<table>
<thead>
<tr>
<th>Step</th>
<th>Task Description</th>
<th>Optional</th>
<th>Conditional</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>190.</td>
<td>Implement the commitment changes extension. See Commitment Changes Extension</td>
<td>Optional</td>
<td>Optional</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>(Oracle Projects User Guide).</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>191.</td>
<td>Implement the project status inquiry extension. See Project Status Inquiry Extension</td>
<td>Optional</td>
<td>Optional</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>(Oracle Projects User Guide).</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Capital Projects Extensions

<table>
<thead>
<tr>
<th>Step</th>
<th>Task Description</th>
<th>Optional</th>
<th>Conditional</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>192.</td>
<td>Implement the Asset Assignment Extension. See: Asset Assignment Extension</td>
<td>Optional</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>(Oracle Projects User Guide).</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>193.</td>
<td>Implement the CIP Grouping Extension. See: CIP Grouping Extension</td>
<td>Optional</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>(Oracle Projects User Guide).</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Additional Setup

<table>
<thead>
<tr>
<th>Step</th>
<th>Task Description</th>
<th>Optional</th>
<th>Conditional</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>194.</td>
<td>Define descriptive flexfields. See: Descriptive Flexfields (Oracle Projects User</td>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td></td>
<td>Guide).</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>195.</td>
<td>Define request groups for report and process security. See: Oracle Applications</td>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td></td>
<td>System Administrator’s Guide.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>196.</td>
<td>Define additional users. See: Oracle Applications System Administrator’s Guide.</td>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>197.</td>
<td>Define responsibilities for functional users. See: Security Profiles</td>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td></td>
<td>(Oracle Projects User Guide).</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>198.</td>
<td>Assign Self-Service HR responsibility to users and roles. See: Chapter 4,</td>
<td>Optional</td>
<td>Optional</td>
<td>Required</td>
</tr>
<tr>
<td></td>
<td>“Defining Your People”.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>199.</td>
<td>Define frequently-used folders. See: Customizing the Presentation of Data (Oracle</td>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td></td>
<td>Applications User’s Guide) and Administering Folders (Oracle Applications</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>System Administrator’s Guide). To see which windows are folder-enabled, see</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### AutoAccounting for Costs

**ATTENTION:** If you have a multiple organization installation, you must repeat these steps for each operating unit.

<table>
<thead>
<tr>
<th>Step</th>
<th>Task Description</th>
<th>Optional</th>
<th>Conditional</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>200.</td>
<td>Set up accounting for labor costs. See: Accounting for Labor Costs</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>(Oracle Projects User Guide).</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Oracle Projects Implementation Checklist

<table>
<thead>
<tr>
<th></th>
<th>Set up accounting for expense report costs. See: Accounting for Expense Report Costs (Oracle Projects User Guide).</th>
<th>Conditional</th>
<th>Conditional</th>
<th>n/a</th>
</tr>
</thead>
<tbody>
<tr>
<td>201</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>202</td>
<td>Set up accounting for usage costs. See: Accounting for Usage Costs (Oracle Projects User Guide).</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>203</td>
<td>Set up accounting for miscellaneous costs. See: Expenditure Type Classes (Oracle Projects User Guide).</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>204</td>
<td>Set up accounting for burden transactions. See: Expenditure Type Classes (Oracle Projects User Guide).</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>205</td>
<td>Set up accounting for WIP and Inventory costs, if you are using these expenditure type classes for costs other than those originating in Oracle Manufacturing and Oracle Inventory. See: Expenditure Type Classes (Oracle Projects User Guide).</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>206</td>
<td>Set up accounting for supplier invoice adjustment costs. See: Accounting for Supplier Invoice Adjustment Costs (Oracle Projects User Guide).</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>207</td>
<td>Set up accounting for total burdened costs. See: Accounting for Burdened Costs (Oracle Projects User Guide).</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td><strong>AutoAccounting for Revenue and Billing</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>ATTENTION:</strong> If you have a multiple organization installation, you must repeat these steps for each operating unit.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>208</td>
<td>Define AutoAccounting for cross charge transactions processed for intercompany billing. See: Defining AutoAccounting for Cross Charge Transactions Processed for Intercompany Billing (Oracle Projects User Guide).</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>209</td>
<td>Define AutoAccounting for provider cost reclassifications. See: Define AutoAccounting for Provider Cost Reclassifications (Oracle Projects User Guide).</td>
<td>n/a</td>
<td>Optional</td>
<td>n/a</td>
</tr>
<tr>
<td>210</td>
<td>Define AutoAccounting for borrowed and lent transactions. See: Defining AutoAccounting for Borrowed and Lent Transactions (Oracle Projects User Guide).</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>Step</td>
<td>Task Description</td>
<td>See:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>------------------</td>
<td>------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>211.</td>
<td>Set up accounting for labor revenue.</td>
<td>Accounting for Labor Revenue (Oracle Projects User Guide).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>216.</td>
<td>Set up accounting for inventory revenue.</td>
<td>Expenditure Type Classes (Oracle Projects User Guide).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>217.</td>
<td>Set up accounting for work in process revenue.</td>
<td>Expenditure Type Classes (Oracle Projects User Guide).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>218.</td>
<td>Set up accounting for supplier invoice revenue.</td>
<td>Accounting for Revenue and Invoices (Oracle Projects User Guide).</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Opportunity to Project Integration</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>--------------------------------------</td>
<td>---</td>
<td></td>
<td></td>
</tr>
<tr>
<td>223.</td>
<td><strong>Map organization roles.</strong> See: Mapping Organization Roles (Oracle Projects Documentation Update Notes, Family Pack J (11i.PJ_PF.J)).</td>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>224.</td>
<td><strong>Map person roles.</strong> See: Mapping Person Roles (Oracle Projects Documentation Update Notes, Family Pack J (11i.PJ_PF.J)).</td>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>225.</td>
<td><strong>Map probability values.</strong> See: Mapping Probability Values (Oracle Projects Documentation Update Notes, Family Pack J (11i.PJ_PF.J)).</td>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>226.</td>
<td><strong>Set up opportunity classifications.</strong> See: Setting up Opportunity Classifications (Oracle Projects Documentation Update Notes, Family Pack J (11i.PJ_PF.J)).</td>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>227.</td>
<td><strong>Drill from Projects to Sales Online.</strong> See: Drilling from Projects to Sales Online (Oracle Projects Documentation Update Notes, Family Pack J (11i.PJ_PF.J)).</td>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
</tr>
</tbody>
</table>
**Oracle Applications Implementation Checklist for Oracle Projects Integration**

The following checklist includes the setup steps for other Oracle Applications that affect the integration of Oracle Projects with those applications. You should understand the implications of integration with Oracle Projects as you perform these setup steps for other Oracle Applications.

Refer to the Setup chapter in each product’s User Guide for comprehensive implementation information for the product. You only need to complete the steps for the applications that you are implementing with Oracle Projects.

The following table provides the Oracle Projects integration checklist:

<table>
<thead>
<tr>
<th>Step Number</th>
<th>Step Description</th>
<th>Project Costing</th>
<th>Project Billing</th>
<th>Project Resource Management</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Payables</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.</td>
<td>Install and implement Oracle Payables. See: Oracle Payables User Guide</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>2.</td>
<td>Define your Payables Options for expense reports. See: Payables Options (Oracle Projects User Guide).</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>3.</td>
<td>Specify profile options for project-related invoice entry. See: Updating Profile Options for Integration with Other Products (Oracle Projects User Guide).</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>4.</td>
<td>Set up the Account Generator to generate the supplier invoice account. See: The Account Generator in Oracle Projects (Oracle Projects User Guide).</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>5.</td>
<td>Define project-related distribution sets. See: Project Related Distribution Sets (Oracle Projects User Guide).</td>
<td>Optional</td>
<td>Optional</td>
<td>n/a</td>
</tr>
<tr>
<td>6.</td>
<td>Implement the descriptive flexfield mapping extension. See: Descriptive Flexfield Mapping (Oracle Projects User Guide).</td>
<td>Optional</td>
<td>Optional</td>
<td>n/a</td>
</tr>
<tr>
<td>Oracle Purchasing</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7.</td>
<td>Install and implement Oracle Purchasing. See: Oracle Purchasing User Guide</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>Specify profile options for project-related document entry. See: Updating Profile Options for Integration with Other Products (Oracle Projects User Guide).</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>9.</td>
<td>Set up the Account Generator to generate the project-related accounts in Oracle Purchasing. See: The Account Generator in Oracle Projects (Oracle Projects User Guide).</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
</tbody>
</table>

**Oracle Receivables**

<table>
<thead>
<tr>
<th></th>
<th>Install and implement Oracle Receivables. See: Oracle Receivables User Guide.</th>
<th>Conditional</th>
<th>Conditional</th>
<th>n/a</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.</td>
<td>Specify system options for project invoice processing. See: Specifying System Options (Oracle Projects User Guide).</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>11.</td>
<td>Define transaction types. See: Transaction Types for Invoice Processing (Oracle Projects User Guide).</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>12.</td>
<td>Specify profile options for project invoices. See: Updating Profile Options for Integration with Other Products (Oracle Projects User Guide).</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>14.</td>
<td>Define salespersons for sales credit. See: Salespersons and Credit Types (Oracle Projects User Guide).</td>
<td>n/a</td>
<td>Optional</td>
<td>n/a</td>
</tr>
<tr>
<td>15.</td>
<td>Set up tax codes for project invoices. See: Applying Tax to Project Invoices (Oracle Projects User Guide).</td>
<td>n/a</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
<tr>
<td>16.</td>
<td>Implement the Receivables installation override extension. See: Receivables Installation Override (Oracle Projects User Guide).</td>
<td>n/a</td>
<td>Optional</td>
<td>n/a</td>
</tr>
</tbody>
</table>

**Oracle Inventory**

<table>
<thead>
<tr>
<th></th>
<th>Install and implement Oracle Inventory. See: Oracle Inventory User Guide.</th>
<th>Conditional</th>
<th>Conditional</th>
<th>n/a</th>
</tr>
</thead>
<tbody>
<tr>
<td>17.</td>
<td>Define project-related transaction types in Oracle Inventory. See: Oracle Inventory User’s Guide.</td>
<td>Conditional</td>
<td>Conditional</td>
<td>n/a</td>
</tr>
</tbody>
</table>

**Oracle Project Manufacturing**
<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>20.</td>
<td><strong>Install and implement Oracle Project Manufacturing.</strong> See: <em>Oracle Project Manufacturing User’s Guide.</em></td>
<td>Conditional</td>
<td>Conditional</td>
</tr>
</tbody>
</table>

**Oracle Workflow**

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>23.</td>
<td><strong>Implement Budget Workflow.</strong> See: Implementing Budget Workflow (<em>Oracle Projects User Guide</em>).</td>
<td>Conditional</td>
<td>Conditional</td>
</tr>
<tr>
<td>24.</td>
<td><strong>Implement Project Assignment Workflow.</strong> See: <em>Oracle Workflow Guide.</em></td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>25.</td>
<td><strong>Implement project workflow extension.</strong> See: Project Workflow Extension (<em>Oracle Projects User Guide</em>).</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>26.</td>
<td><strong>Implement budget workflow extension.</strong> See: Budget Workflow Extension (<em>Oracle Projects User Guide</em>).</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>27.</td>
<td><strong>Implement Project Assignment Workflow extension.</strong> See: Chapter 14, &quot;Overview of the Predefined Workflows&quot;.</td>
<td>n/a</td>
<td>n/a</td>
</tr>
<tr>
<td>28.</td>
<td><strong>Implement Candidate Notification Workflow extension.</strong> See: Chapter 14, &quot;Overview of the Predefined Workflows&quot;.</td>
<td>n/a</td>
<td>n/a</td>
</tr>
</tbody>
</table>

**Oracle Activity Management Gateway**

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>29.</td>
<td><strong>Specify profile option for product licensing.</strong> See: Updating Profile Options for Integration with Other Products (<em>Oracle Projects User Guide</em>).</td>
<td>Conditional</td>
<td>Conditional</td>
</tr>
<tr>
<td>30.</td>
<td><strong>Set up controls over imported data.</strong> See: Control Actions Window (<em>Oracle Projects User Guide</em>).</td>
<td>Conditional</td>
<td>Conditional</td>
</tr>
<tr>
<td>31.</td>
<td><strong>Set up source products.</strong> See: Source Products Window (<em>Oracle Projects User Guide</em>).</td>
<td>Conditional</td>
<td>Conditional</td>
</tr>
</tbody>
</table>

**Oracle Internet Time**

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>32.</td>
<td><strong>Install and implement Oracle Internet Time.</strong> See: <em>Oracle Self-Service Time Implementation Guide.</em></td>
<td>Conditional</td>
<td>Conditional</td>
</tr>
<tr>
<td></td>
<td><strong>Oracle Applications Implementation Checklist for Oracle Projects Integration</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>--------------------------------------------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>33.</td>
<td><strong>Implement the pre-import and post-import extensions for Internet Time.</strong> See: Pre-Import Client Extension for Internet Time and Post-Import Client Extension for Internet Time (<em>Oracle Projects User Guide</em>).</td>
<td>Optional</td>
<td>Optional</td>
</tr>
</tbody>
</table>
| 34. | **Oracle Cash Management**  
**Install and implement Oracle Cash Management.** See: *Oracle Cash Management User Guide*. | Conditional | Conditional | n/a |
| 35. | **Implement Oracle Projects integration with Oracle Cash Forecasting.** See: Integrating with Cash Management (*Oracle Projects User Guide*). | Conditional | Conditional | n/a |
**administrative assignment**
Activity on an administrative project such as personal holiday, sick day, or jury duty. Administrative assignments can also represent administrative work such as duties on an internal project. Such assignments are charged to the administrative project which is determined by the administration flag on the project type.

**Analysis Workbook**
A display of enterprise information in a graphical and tabular format. The Analysis Workbook uses Discoverer to allow the user to modify the selection criteria, drill into dimension hierarchies or link to other data elements.

**assignment forecast item**
The assignment forecast item is the smallest unit of forecasting information for the assignment. In this entity, the smallest time unit is a day. Forecast items are created for each day of every provisional and confirmed assignment for every billable resource.

**availability**
The percentage of the availability of a resource to work on an assignment based on the calendar of the resource, as well as any scheduled assignments for that resource.

**billable resource**
A resource that has a current billable job assignment. Billable jobs are defined in the job definition screen where the Job Billability Flag is equal to Y.
Business View
Component of the application database that sorts underlying applications data into an understandable and consolidated set of information. By masking the complexity of the database tables, Business Views provide a standard set of interfaces to any tool or application that retrieves and presents data to the user.

calendar
Working capacity defined by work patterns and calendar exceptions.

capacity
Capacity is based on a amount of schedulable hours from the calendar of a resource. In the case of Labor, capacity is defined in work hours. The capacity of an Organization is the sum total of the capacity of assigned resources.

competence
A technical skill or personal ability such as JAVA programming, ability to speak another language, and project billing.

competence match
A numerical comparison of the competence of a resource to the mandatory and optional competencies of a requirement

Cross Business Group Access (CBGA)
The ability to view data in operating units that are not associated with the current operating unit’s business group.

Cross Business Group Access mode (CBGA mode)
An installation that has selected CBGA in the profile options is operating in CBGA mode.

delivery assignment
Filled work position on a project.

dimension
Dimensions are used to calculate and monitor performance measures. Some of the dimensions are organization and time.
Discoverer
An Oracle Tool that allows users to retrieve data from a database. Discoverer provides a user friendly method for creating database queries and displaying information.

duration
The total number of days between the start date and end date of a team role.

effort
The total number of hours of a team role.

End User Layer
Component of Discoverer that translates business view column names into industry standard terminology and provides links between related data tables. Discoverer accesses information through the End User Layer (EUL).

global hierarchy
An organization hierarchy that includes one or more business groups. A global hierarchy can be used by installations that are in CBGA mode.

global security profile
An HR security profile that is not associated with a business group. A global security profile can secure organizations and people throughout a global (cross business group) organization hierarchy.

HR job
In HRMS, the HR job for a resource (person) is the job linked to the primary assignment of the person.

job group
A collection of jobs defined for a specific purpose. Jobs in a job group have the same key flexfield structure.

Logical Data Model
A representation of the End User Layer. Available in a readable format, the Logical Data Model gives the relationship between folders, allowing a Discoverer user to determine the data elements needed for a specific analysis.
**master job group**
The job group that is used as an intermediate mapping group between other job groups.

**master job**
A job in a master job group.

**non-capacity work type**
Work types assigned to forecast assignment items or actual expenditure items reduce the total capacity of a given resource for the specified time period.

**requirement**
Unfilled work position on a project.

**responsibility**
A security feature of Oracle applications that groups forms and procedures under the user application.

**schedule**
The working hours defined by the calendar and schedule exceptions.

**Single Business Group Access mode (SBGA mode)**
An installation that has selected No for the profile option HR: Cross Business Group is operating in SBGA mode.

**team role**
Specific position on a project representing either requirements or assignments as appropriate for the context in which it is used within the application.

**utilization**
A measure of how effectively a resource was used or is projected to be used.

**utilization method**
*Capacity Utilization Method* compares the actual (productive) work performed and forecasted (productive) work to be performed by the resource to the capacity of a resource.

*Worked Hours Utilization Method* compares the actual (productive) work performed and forecasted (productive) work to be performed by the resource to the total number of hours recorded (actuals) or assigned (forecasted) of a resource.
utilization category
An implementation-defined category used for utilization reporting. This reporting grouping combines one or more work types for organization and resource utilization views.

utilization view
Utilization views enables you to measure a resource or organization utilization percentage based on different groupings of work types.

work type
Work types are an implementation-defined classification of work performed. Work types are used to classify both actual and forecast amounts. They differ from expenditure types which are a classification of cost expended. Work types are also grouped together by Utilization Categories.

worksheet
A specific grouping of information within an Analysis Workbook. A workbook is composed of one or more worksheets, each with its own set of data and graphs. Conceptually this is similar to the “sheets” and “workbook” concept within a spreadsheet application.

unassigned time
The net amount of hours for a given period for which a resource does not have any scheduled assignments (capacity hours minus scheduled hours.)
A
administrative assignment
creating an, 2-6
administrative assignments
ownership, 2-2
administrative processes, 13-2
application
process flows
administrative assignment, creating an, 2-6
assignment, adding an, 2-6
requirement, creating a, 2-5
requirement, filling a, 2-5
resource searching, 2-5
assigning
competencies, 4-9
organizational authority, 5-22
project calendars, 8-5
resource calendars, 8-5
shifts and exceptions to calendars, 8-4
assignment
adding an, 2-6
administrative
creating an, 2-6
changes requiring approval, 14-4
primary, for employee, 4-6
assignment approval
notification messages, 14-6
workflow process, 14-4
assignment approval statuses, 7-17
assignment schedule statuses, 14-7
assignments
administrative
ownership, 2-2
attributes
calendar, 8-2
project, 9-2
authority
forecast, granting, 10-13
organization, 5-3
organizational level, 5-21
utilization, 11-17
AutoAccounting feature, A-3
availability, 8-7
Available Resource Hours (PAAVLRES) workbook, 12-58
B
bill rate schedule
job-based, 10-7
billable status, 13-4
business group
definition, 3-2
business views, list of, 12-42
C
calendar
assigning a project, 8-5
assigning a resource, 8-5
assigning shifts and exceptions, 8-4
attributes, 8-2
availability, 8-7
changing, 13-6
creating a, 8-4
defaults, 8-5
definition of, 8-2
delivery team, 2-2
deployment method
centralized, 1-5
combination, 1-5
decentralized, 1-5
diagram
project team, 2-2
security check process flow, 5-24
task flows, 2-3
distribution rule
cost-based, 10-4
event-based, 10-5
work-based, 10-4
calculating revenue, 10-3
cost-based distribution rule, 10-4
event-based distribution rule, 10-5
implementations steps, 10-6
maintaining, 13-9
protected, 10-2
profile option, 10-7
security, 10-13
unassigned time, 10-8
work-based distribution rule, 10-4
financial forecast functionality, description of, 10-1
Financial Organization Rollup Groups
folder, 12-32
Fiscal Quarter Numbers folder, 12-16, 12-33
Fiscal Years folder, 12-16, 12-33
to
Calendar Months, 12-17
Calendar Years, 12-16
Financial Organization Rollup Groups, 12-32
Fiscal Quarter Numbers, 12-16, 12-33
Fiscal Years, 12-16
Lookup for Class Categories, 12-36
Project Managers, 12-33
Project Managers folder, 12-32
Required Project Hours by GL Period, 12-17
Required Project Hours by GL Period: Team Role
detail, 12-18
Required Project Hours by Global Week, 12-20
Required Project Hours by Global Week: Team
Role detail, 12-20
Required Project Hours by PA Period, 12-19
Required Project Hours by PA Period: Team Role
detail, 12-19
Resource Capacity by GL Period, 12-21, 12-22
Resource Managers, 12-16
Resource Schedule by GL Period, 12-23
Resource Schedule by GL Period: Team Role
detail, 12-24
Resource Schedule by Global Week, 12-27
Resource Schedule by Global Week: Team Role
detail, 12-28
Resource Schedule by PA Period, 12-25
Resource Schedule by PA Period: Team Role
detail, 12-26

e
employee
home address, 4-6
required information, 4-5

tative structure
business groups in the, 3-2
determining, 3-1
organizations in the, 3-3
error causes
missing or invalid setup information, 13-2
event-based distribution rule, 10-5
example
competence levels, 4-7
example of implementation, A-3
Expenditure/Event classification, 3-3
extended team, 2-2
example

F
file
PARAAFCB.pls, 14-8
PARAAFCSP.sls, 14-9
PARAWFCS.pls, 14-9
PARAWFCS.pls, 14-9
PARCWFCB.pls, 14-14
PARCWFCS.pls, 14-14
filling
requirements, 2-5
financial business area, 12-14
financial forecast
Sales Pipeline by GL Period, 12-33
Sales Pipeline by PA Period, 12-35
Staffing Organization Rollup Groups, 12-15
forecast authority
menu, 5-19
forecast authority, granting, 10-13
forecast exceptions, correcting, 13-10
forecast exceptions, list of, 13-9
forecast implementation options, 10-9
functions
access by responsibility, 5-10

H
hierarchy
organizational, 3-4
HR
Cross Business Group profile option, 4-7
HR organization, 3-3

I
implementation
checklist for Oracle Projects, A-4
deployment method, 1-5
planning, 1-4
implementation checklist, integration with Oracle
Projects, A-27
implementation checklist, Oracle Projects, A-5
implementation example, A-3
implementation wizard, A-2
installation base, 1-3
invalid setup information, 13-2
item type
PA: Project Assignments, 14-5

J
job
groups, 3-5
primary assignment, 3-5
job competencies, 4-9
job levels, changing, 13-3
job mapping, 3-5
job structure
creating a, 3-5
job-based bill rate schedule, 10-7
job-based cost rate schedule, defining, 10-6
jobs, 3-5
billable status, 13-4
including in utilization calculations, 11-12

K
key features, application, 1-2

L
levels of role-based security, 5-5
list
forecast exceptions, 13-9
locations, defining employee, 4-6
Lookup for Class Categories folder, 12-36

M
maintaining resources, 13-5
managing
data security, A-3
resource pool, 4-1
master calendar changes, 13-6
menus
forecast authority, 5-19
project authority, 5-18
project manager, 5-15
resource, 5-17
resource authority, 5-19
resource pool, 5-18
utilization authority, 5-19
menus, seeded, 5-14
missing setup information, 13-2

O
operating unit
default, 3-3
resource, 3-3
Oracle Discoverer
tasks checklist, 12-3
Oracle Discoverer, install and setup tasks, 12-3
PA: Availability Calculation Period, 8-8, 8-10
PA: Availability Duration, 8-10
PA: Cross-Project User - Update, 5-4
PA: Cross-Project User - View, 5-3
PA: Default Calendar, 8-5
PA: Default Cancelled Assignment Status, 7-18
PA: Default Cancelled Requirement Status, 7-4
PA: Default Filled Requirement Status, 7-4
PA: Default Starting Candidate Status, 7-6
PA: Forecasting Period Type, 10-7
PA: Global Week Start Day, 11-19
PA: Organization Utilization Default Calculation Method, 11-20
PA: Percentage of Resource Capacity, 8-8, 8-10
PA: Resource Utilization Calculation Method, 11-20
PA: Resource Utilization Period Type, 11-20
PA: Starting Assignment Status, 7-18
PA: Starting Requirement Status, 7-3
PA: Utilization Calculation Begin Date, 11-20
PA: Utilization Manager Default Period Type, 11-19
self-service environment options, 9-5
profile options
utilization, 11-19
project
attributes, 9-2
project authority
menu, 5-18
project environment, 9-1
project manager, 5-7
menu, 5-15
project manager responsibility, seeded functions, 5-10
project manager role, 2-4
Project Managers folder, 12-32
Project Resource Management super user responsibility, seeded functions, 5-13
project roles, defining, 6-1
project security structure, 5-1
project statuses, 9-3
project team
defining a, 2-2
delivery, 2-2
diagram, 2-2
extended, 2-2
Projects Billing Super User, A-2
Projects Costing Super User, A-2

R
reference sources, iv-xviii
reporting
Available Resource Hours (PAAVLRES) workbook, 12-58
business views, 12-42
Calendar Months folder, 12-17
Calendar Years folder, 12-16
financial business area, 12-14
Financial Organization Rollup Groups folder, 12-32
Fiscal Quarter Numbers folder, 12-16, 12-33
Fiscal Years folder, 12-16
Lookup for Class Categories folder, 12-36
Overcommitted Resource Hours (PAOVCRE) workbook, 12-65
Project Managers folder, 12-32, 12-33
Required Project Hours (PAREQPR) workbook, 12-45
Required Project Hours by GL Period folder, 12-17
Required Project Hours by GL Period: Team Role Detail folder, 12-18
Required Project Hours by Global Week folder, 12-20
Required Project Hours by Global Week: Team Role Detail folder, 12-20
Required Project Hours by PA Period folder, 12-18
Required Project Hours by PA Period: Team Role Detail folder, 12-19
Resource Capacity by GL Period folder, 12-21,
12-22
Resource Managers folder, 12-16
Resource Schedule by GL Period folder, 12-23
Resource Schedule by GL Period: Team Role Detail folder, 12-24
Resource Schedule by Global Week
folder, 12-27
Resource Schedule by Global Week: Team Role Detail folder, 12-28
Resource Schedule by PA Period folder, 12-25
Resource Schedule by PA Period: Team Role Detail folder, 12-26
Sales Pipeline by GL Period folder, 12-33
Sales Pipeline by PA Period folder, 12-35
Sales Pipeline Workbook (PASALPIP) workbook, 12-72
Scheduled Resource Hours (PASCHRES) workbook, 12-51
security, 12-44
staffing business area, 12-12
Staffing Organization Rollup Groups folder, 12-15
reporting solution, 12-1
reporting time period, 11-16
Required Project Hours (PAREQPRJ) workbook, 12-45
Required Project Hours by GL Period folder, 12-17
Required Project Hours by GL Period: Team Role Detail folder, 12-18
Required Project Hours by Global Week folder, 12-20
Required Project Hours by Global Week: Team Role Detail folder, 12-20
Required Project Hours by PA Period folder, 12-18
Required Project Hours by PA Period: Team Role Detail folder, 12-19
requirement creating a, 2-5
filling a, 2-5
requirement statuses, seeded, 7-3
requirements competencies, 4-10
resource availability, 8-7
changing primary assignment, 13-5
contractor setup, 4-5
default functions, 5-8
home address, 4-6
menu, 5-17
missing information, 4-6
organization assignment, 4-5
required information, 4-5
searching, 2-5
utilization view, 11-3
resource authority menu, 5-19
Resource Capacity by GL Period folder, 12-21
Resource Capacity by Global Week folder, 12-22
Resource Capacity by PA Period folder, 12-22
resource manager, 5-7
resource manager responsibility, seeded functions, 5-11
resource manager role, 2-4
Resource Managers folder, 12-16
resource operating unit, 3-3
resource pool benefits of, 4-2
managing, 4-1
menu, 5-18
Resource Schedule by GL Period folder, 12-23
Resource Schedule by GL Period: Team Role Detail folder, 12-24
Resource Schedule by Global Week folder, 12-27
Resource Schedule by Global Week: Team Role Detail folder, 12-28
Resource Schedule by PA Period folder, 12-25
Resource Schedule by PA Period: Team Role Detail folder, 12-26
resource search job level-based, 3-6
resources maintaining, 13-5
responsibilities Oracle Applications, A-2
organization manager seeded functions, 5-10
project manager, 5-7
seeded functions, 5-10
Project Resource Management super user, 5-8
seeded functions, 5-13
resource, 5-8
resource manager, 5-7
seeded functions, 5-11
seeded, 5-6
seeded function and menu access, 5-8
staffing manager, 5-8
seeded functions, 5-12
  team member
  seeded functions, 5-12
responsibility function access, 5-10
responsibility-based security, 5-3
role
  controls, 6-3
  defining a, 6-5
  lists, 6-4
  project manager, 2-4
  resource manager, 2-4
  staffing manager, 2-4
  team member, 2-4
role competencies, 4-9
role-based security, 5-5
  levels, 5-5
roles
  enterprise, 5-5
  seeded, 5-5

S
Sales Pipeline by GL Period folder, 12-33
Sales Pipeline by PA Period folder, 12-35
Sales Pipeline Workbook (PASALPIP) workbook, 12-72
Scheduled Resource Hours (PASCHRES) workbook, 12-51
searching
  competence match, 4-11
  job level-based, 3-6
  resource, 2-5
security
  diagram of, check process flow, 5-24
  financial forecast, 10-13
  model comparison, 5-2
  process, check, 5-23
  project role-based, 5-1
  reporting, 12-44
  responsibility-based, 5-1, 5-3
  role-based levels, 5-5
  strategy, 5-2
  structure, 5-2
seeded
  assignment approval statuses, 7-17
candidate statuses, 7-5
menu and function access, 5-8
menus, 5-14
organization manager responsibility functions, 5-10
project manager responsibility functions, 5-10
Project Resource Management super user responsibility functions, 5-13
requirement statuses, 7-3
resource manager responsibility functions, 5-11
responsibilities, 5-6
responsibility function access, 5-10
roles, 5-5
staffing manager responsibility functions, 5-12
super user responsibility, A-2
team member responsibility functions, 5-12
self-service environment, defining, 9-5
shared data, implementation, A-4
shift patterns, defining, 8-3
shifts and exceptions, assigning to calendars, 8-4
shifts, defining, 8-3
site default calendar, 8-5
sources
  of reference, iv-xviii
staffing business area, 12-12
staffing manager, 5-8
staffing manager responsibility, seeded functions, 5-12
staffing manager role, 2-4
Staffing Organization Rollup Groups folder, 12-15
standalone mode
  utilization results, 11-1
status controls, 7-2
statuses
  assignment approval, 7-17
  assignment schedule, 14-7
  candidate, 7-5
Change Project Probability status, 9-4
profile options for, 7-3, 7-6, 7-18
requirement, 7-3
seeded project, 9-3
statuses, definition of, 7-2
structure
  competence, 4-7
  enterprise, 3-1
job, 3-5
of implementation guide, iv-xvii
super user responsibility, seeded, A-2
system administration, A-2

T
tables
Oracle HRMS, 1-4
Oracle Projects, 1-4
task flow diagram, 2-3
team member responsibility, seeded functions, 5-12
team member role, 2-4
technology stack, 1-3
time periods, defining, 10-8
timeline, updating, 13-7
transactional reporting, 12-1

U
unassigned time, tracking, 10-8, 11-16
updating schedules with calendar changes, 13-6
user role
project manager, 2-4
resource manager, 2-4
staffing manager, 2-4
team member, 2-4
utilization
Capacity Method, 11-2
categories, 11-13
changing job, 13-4
defining strategy, 11-2
forecast functionality, 11-16
functionality description, 11-1
generating, 13-8
granting, authority, 11-17
method, 11-4
organization view, 11-3
profile options, 11-19
reporting, 11-5
reporting time period, 11-16
resource view, 11-3
specifying, jobs, 11-12
time periods, 11-3
Total Worked Hours, 11-2
unassigned time tracking, 11-16
work types, 11-14
utilization authority
menu, 5-19

V
version
Self-Service Framework, 1-3

W
weighting percentage, 11-2
work-based distribution rule, 10-4
workbook
Available Resource Hours (PAAVLRES), 12-58
Overcommitted Resource Hours (PAOVCRE), 12-65
Required Project Hours (PAREQPR), 12-45
Sales Pipeline Workbook (PASALPIP), 12-72
Scheduled Resource Hours (PASCHRES), 12-51
workflow process
assignment approval notification messages, 14-6
assignment approval, seeded processes, 14-5
candidate declined, 14-13
candidate notification processes, 14-13
Generate_Assignment_Approvers procedure, 14-10
Generate_NF_Recipients procedure, 14-11, 14-14
new candidate, 14-13
seeded assignment approval, 14-4
Set_Timeout_And_Reminders procedure, 14-12
workflow processes, default, 14-1
workflow processes, deferred, 14-2